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No.   G  Parts E  Componentes P  Componentes
1 GSM Antenna Antena GSM Antena GSM
2 Magnetic base Base magnética Base magnética
3 Antenna cable Cable de antena Cabo da antena

4 Connector SMA for
GSM Antenna

Conector SMA para
antena GSM

Conector SMA para
antena GSM

5 Status LEDs LED de control LEDs de controlo
6 SIM holder Tarjeta SIM Alojamento cartão SIM

7 P.C.B. fixing holes Orificios de fijación de
la tarjeta

Furos de fixação da
placa

8 SIM CARD Tarjeta SIM Cartão SIM

9 Cable connector for
programming via PC

Conector de cable para
la programación vía PC

Conector do cabo para a
programação com o PC

10 Terminal Blocks Regleta de terminales
para las conexiones

Bloco de terminais
para as ligações

11 Antenna cable feed
opening

Abertura para paso de
cab el de la antena

Abertura para
passagem de cabos

12 Metal bracket fixing
holes

Orificios de fijación de
estribo metálica

Furos de fixação do
suporte metálico

13 Metal bracket Estribo metálico Suporte metálico

14 Adesive plastic
support

Soporte plástico
adhesivo

Suporte de plástico
adesivo

15 Tamper switch
(optional)

Desviador antisabotaje
(opcional)

Desviador anti-
sabotagem (opcional)

16 P.C.B. support Soporte tarjeta Suporte placa
17 Metal base Base metálica Fundo metálico
18 Cover Tapa Tampa

19 Base fixing holes Orificios de fijación de
la base

Furos de fixação do
fundo

20 Tamper switch fixing
pins

Pernos de fijación del
Desviador Antisabotaje

Pinos de fixação do
desviador anti-
sabotagem

21 Tamper switch fixing
nuts

Tuercas para la
fijación del Desviador
Antisabotaje

Porcas para a fixação
do desviador anti-
sabotagem

22 Cable feed opening on
the base

Abertura en la base para
el paso de los cables

Abertura, no fundo, para
a passagem dos cabos

23 Antenna wire feed
opening on the base

Abertura en la base
para el paso cable
antena

Abertura, no fundo,
para a passagem do
cabo da antena

24 Cover fixing holes Orificios de fijación de
la tapa

Furos de fixação da
tampa

25 Cover fixing screws Tornillos para fijar la
tapa

Parafusos de fixação
da tampa

26 Cable clamp tab Lengüeta sujeta cable Lingueta de fixação do
cabo

27 Holes for the insertion
of P.C.B. supports

Orificios para la
introducción de los
soportes tarjeta

Furos para a introdução
dos suportes da placa
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BGSM-100KCA/120KCA BGSM-100KEA/120KEA

BGSM-100BA/120BA

Fig. 1 - Parts - Identificación de los componentes - Identificação dos componentes
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To program this device use the software BGSM-120/BGSM-100 Console ver. 3.0 or higher.

Recycling information
BENTEL SECURITY recommends that customers dispose of their used equipments (panels, detectors, sirens, and other devices) in an

environmentally sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.
For specific information see http://www.bentelsecurity.com/index.php?o=environmental.

Waste Electrical and Electronic Equipment (WEEE) Directive
 In the European Union, this label indicates that this product should NOT be disposed of with household waste. It should be deposited at an

appropriate facility to enable recovery and recycling.
For specific information see http://www.bentelsecurity.com/index.php?o=environmental
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Installation of  these systems must be carried out strictly in accordance with the instructions described in this manual, and in compliance with the
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quality and performance. The manufacturer recommends that the installed system should be completely tested at least once a month.
BENTEL SECURITY srl shall not be responsible for damage arising from improper installation or maintenance by unauthorized personnel.

BENTEL SECURITY srl reserves the right to change the technical specifications of this product without prior notice.

Credit balance check .............................................................. 16
PROGRAMMING VIA PC .......................................... 17

Viewing the Device Settings ........................................................... 17
Downloading the Device Settings .................................................. 17
Preliminary operations ..................................................................... 17

Phonebook ............................................................................. 18
Options .................................................................................. 19

Dial options ...................................................................................... 19
Event priority (BGSM-120 series only) ............................................. 19
Codes (BGSM-120 series only) ....................................................... 19
Generic ............................................................................................ 19
System (BGSM-120 series only) ...................................................... 20
Pay As You Go (BGSM-120 series only) ......................................... 20
Outputs(BGSM-100 series only) ..................................................... 20
Primary Path ..................................................................................... 20

GPRS ..................................................................................... 20
Access Point Name 1 and Access Point Name 2 .......................... 20
Main Receiver, Local Port 1 and Alarm Port 1 IP address ............ 20
Backup Receiver, Local Port 2 and Alarm Port 2 IP address ....... 20
APN1 Username and Password, APN2 Username and Password ..... 21
Telephone numbers to decode ..................................................... 21
DNIS ................................................................................................ 21
Account code .................................................................................. 21
Enable Supervision ......................................................................... 21
Supervision time (sec) ...................................................................... 21
Remote programming (BGSM-120 series only) .............................. 21

Status ..................................................................................... 21
Status section .................................................................................. 21

PTM ....................................................................................... 22
I/O (BGSM-120 series only) .................................................... 22
Voice Dialer (BGSM-120 series only) ...................................... 23

Periodic voice ................................................................................... 24
Local Service Mode ......................................................................... 24

SMS dialer (BGSM-120 series only) ........................................ 24
Periodic SMS .................................................................................... 24

Voice Message (BGSM-120 series only) ................................. 24
Local Voice Message Recording .................................................... 25
Local Voice Message Replaying .................................................... 25

Optional Tamper Programming ................................................ 25



BGSM-100/120 5

GGGGG

INTRODUCTION
Devices in the BGSM-100 and BGSM-120 series are GSM communicators which, in the absence of a PSTN line, transmit
vocal and digital alarms to System III or System II receivers, via GPRS. There are three models available for each series:
— The BGSM-100KCA and BGSM-120KCA kits including GSM/GPRS communicator electronic card and antenna with 25 cm cable;
— The BGSM-100KEA and BGSM-120KEA kits including GSM/GPRS communicator electronic card, antenna with 2 mt

cable and metal bracket;
— The BGSM-100BA and BGSM-120BA, including GSM/GPRS communicator electronic card, antenna with 25 cm cable and casing.
All information relating to a specific model shall be attested to by reference to the the corresponding code. The word
“Communicator” is being used to describe functions which are common to the various models. This manual provides
programming and operation of the GSM/GPRS alarm Communicator. If there are any special installation requirements, the
remote ANT-EU outdoor antenna and the magnetic BGSM-100CA or antenna with 25 cm cable may be used.
 This Communicator is fixed and shall be installed by Service Persons only (service person is defined as a

person having the appropriate technical training and experience necessary to be aware of hazards to which that
person may be exposed in performing a task and of measures to minimize the risks to that person or other
persons). It shall be installed and used within an environment that provides the pollution degree max 2, over
voltages category II, in non-hazardous, indoor locations only. This manual shall be used with the Installation
Manual of the alarm control panel. All instructions specified within that manual must be observed.

Features

Technical Specifications
The input voltage to this can be drawn from the Control Panel or provided by the ADP1512 power supply (not supplied).

 Simulates land line
 Switches automatically to GSM Network in the event of

land line trouble (line down)
 Manages and signals Incoming/Outgoing calls
 GSM signal indicator
 3 programmable terminals as Open Collector Outputs or

Input Lines (BGSM-120 series only)
 Land line overvoltage protection
 GSM Quad-Band
 Antenna with magnetic base
 SMS dialer (BGSM-120 series only)
 Voice dialer (BGSM-120 series only)
 Supports Contact ID communication format from a connected

control panel for communication over the GPRS network
 GPRS/Internet communication with receivers Sur-Gard

System III / II

 PC-programmable options
 11 SMS messages, each with a maximum length of

100 characters (2 for each Input Line plus 4 for Status
Indications and 1 Periodic), BGSM-120 series only

 8 telephone numbers (max. 16 digits) programmable
for the SMS dialer (BGSM-120 series only)

 4 phone numbers programmable for Contact ID Dialer
on GPRS

 Up to 100 telephone numbers (max.16 digits) pro-
grammable for the remote activation of the OC output

 Remote activation of the outputs through caller identi-
fication and/or SMS transmission (SMS transmission
for the BGSM-120 series only)

 Credit balance check for pre-paid SIM CARDS (BGSM-
120 series only)

 (PTM) monitoring of communication with the control unit

Models BGSM-100KCA, BGSM-100KEA,
BGSM-120KCA, BGSM-120KEA

BGSM-100BA,
BGSM-120BA

Input Voltage between 10 and 27.6 V_
Standby current 100 mA maximum (not including the outputs) at 13.8 Vdc
Maximum alarm (Transmitting) current 250 mA average (not including the outputs) at 13.8 Vdc
Outputs 3 open collector, 100 mA
Operating frequency 900/1800 MHz or 850/1900 MHz
Maximum loop resistance of line between
the device connected in series on LI 1 Kohm
Maximum number of parallel devices
connected on LI 1

Operating Temperature 5 to 40 °C  /  41 to 104 °F

Dimensions (WxHxD) 60.5x142x15.3 mm
(PCB only)

90x190x75 mm
(without antenna)

Weight 66 g 348 g
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Description
This Communicator manages SMS and Central Station transmissions (SMS transmission for the BGSM-120 series only) and can
simulate the land line in the event of trouble (land line down) or even substitute the land line completely in areas where the GSM
service is provided and where the land line is not available. It has capability of communicating alarm signals via the GPRS data
network. This capability enables a fast reliable path to central stations equipped with a Sur-Gard System III or System II receiver.
The performance of this Communicator depends greatly on GSM Network coverage, therefore, it should not be mounted without
first performing placement tests of the antenna to determine the best location for reception (at least 1 green LED should remain lit).
The BGSM-100 Communicators series have 3 Outputs, one of which may be activated/deactivated remotely, while the
other 2 may be used to indicate: problems on the PSTN telephone line; problems on the GSM network.
The BGSM-120 Communicators series, on the other hand, have 3 terminals which can be programmed as follows:
– Outputs (default setting) which can be activated/deactivated remotely, or used to provide status indications (problems
on the PSTN telephone line; problems on the GSM network; Supervision Message Missing; Fail To Comunicate).
– Input lines for speech dialer and SMS dialer activation; these functions can also be used to transmit status indications.
Due to the characteristics of GSM Networks, this Communicator can activate only as intended and cannot be used as a
modem for fax/data transmissions or for teleservice operations.

IDENTIFICATION OF PARTS
The numbers in square brackets [  ] in this manual refer to the main parts of this Communicator (see Fig. 1) described in this section.

INSTALLING THE DEVICE
 Do not route any wiring over circuit boards.
 This Communicator shall be installed by qualified SERVICE PERSONS only, in the shelter of a safe and dry

site, away from radio-transmitting equipment.
 Test the GSM Network reception before mounting this Communicator in the proposed placement.

BGSM-100KCA, BGSM-100KEA or BGSM-120KCA,
BGSM-120KEA
 This Communicator consists of a board intended to be placed inside the intrusion panel, preferably having a metal

box, and of an antenna that is connected to the board by a coaxial cable. During normal working, those elements
(board, antenna and cable) could generate radiated electromagnetic fields and, if there are any electronic devices not
sufficiently immune to such fields nearby, there might occur certain unwanted interactions. For this reason it is
advised to place the board as far away as possible from such susceptible devices and to put the antenna on the
external surface of the metal box or far away from it by means of the bracket. It is advised to keep inside of the panel
metal box the minimum coaxial cable part and to place any extra length on the outside of the metal box.

1. Loosen the screws and remove the control panel cover.
2. Establish an area inside the metal casing which can be used to hold the board, including the wiring.
3. Position the 4 adhesive plastic supports [14] on the base of the metal casing, then fit the holes [7] on the Electronic board

into the adhesive plastic supports, as illustrated in Figure 2.
4. Fit the antenna [1] to the outside of the casing.
4a. Fix the antenna with the 25 cm cable or the antenna with the 2 mt cable [1] above the metal casing (Fig.2) in such manner that

the magnetic base [2] will be conjoint with the surface. Feed the antenna cable through the cable feed opening in the metal casing.
For models BGSM-100KEA or BGSM-120KEA it is possible to use the metal support [13] could be used, see Fig.2a.
Fix the metal support [13] by using the holes [12] on an adequate prop. Fix the antenna with the 25 cm cable or the
antenna with the 2 mt cable [1] above the metal support [13] (Fig.2a), in such manner that the magnetic base [2] will be
conjoint with the surface. Pass the antenna lead through the hole [11] in the metal support [13].

5. Connect the cable [3] to the GSM antenna connector [4].
6. Complete the connections on the terminal blocks [10].
7. Following the arrow, insert the SIM-CARD [8] face down in the SIM holder [6] (see Figure 1).
!!!!! The SIM-CARD PIN must be disabled before the card is inserted into the Communicator.
!!!!! It is recommended that you disable call forwarding on your SIM card.

8. Make sure that all the green LEDs flash when the product is switched on; this means the Communicator is in its initialisation phase.
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9. Checking Signal Strenght :
– make sure that at least one of the green LEDs remains lit; all green LEDs lit indicates optimal coverage;
– if the green LEDs are not illuminated, the signal strength is TOO WEAK; change the position of the antenna until you
find a position which offers acceptable signal strength, at least one LED illuminated.

10. Close the control panel cover.
 Connect power circuit only after the cabinet has been secured to the building or structure and has been

connected to the protective earth ground of the building.
!!!!!     Before inserting or removing the SIM card, please ensure the unit is powered down.

ANT-EU Remote antenna
For details of how to fit the remote ANT-EU outdoor antenna, please refer to the instructions supplied with the product. The
ANT-EU is used to provide the Communicator a excellent GSM signal strength.

BGSM-100BA or BGSM-120BA
See figure 1.
1. Mark the position of the holes [19] required to fix the metal base [17] to the wall.
2. Drill holes in the wall as marked.
3. Insert the 4 P.C.B. supports [16] into the holes on the metal base [27].
4. Feed the connection cables through the opening on the base [22].
5. Fix the metal base to the wall using wall anchors (not supplied).
!!!!! Make sure you do not damage wiring or pipes in the chase.

6. Position the electronic P.C.B. on the supports [16] and push it down until it clicks into position, as illustrated in Figure 1.
7. Connect the antenna cable [3] to the connector on the electronic P.C.B. [4].
8. Feed the antenna cable [3] the cable clamp tab [26], then through the opening [23].
9. Position the antenna [1] on the upper edge of the base so that the magnetic base [2] adheres to the surface.
 The antenna may be positioned

on the top edge of the base, at the
point most suited to receiving the
GSM signal.

10. If necessary, fit the MAXIASNC anti-
tamper switch [15] (opzional) to the
pins as illustrated in Figure 1.

 The switch lever must be directed
as illustrated in Figure 1,
otherwise the device will not work
correctly.

11. Perform the terminal block connections
[10] as described in par. "Connecting
the device" and, if necessary, connect
the anti-tamper switch (for connecting
the tamper switch see the"Connecting
the device->Auxiliary connections"
section).

51

96

a)

Fig. 2 - Mounting of electronic
card inside the control panel.
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12. Following the arrow, insert the SIM-CARD [8] face down in the SIM holder [6] (see Figure 1).
!!!!! The SIM-CARD PIN must be disabled before the card is inserted into the Communicator.
!!!!! It is recommended that you disable call forwarding on your SIM card.

13. Make sure that all the green LEDs flash when the product is switched on; this means the Communicator is in its initialisation phase.
14. Checking Signal Strenght :

– make sure that at least one of the green LEDs remains lit; all green LEDs lit indicates optimal coverage;
– if the green LEDs are not illuminated, the signal strength is TOO WEAK; for the signal to be of an acceptable level,
at least one green LED must be lit.

15. Close the communicator: fasten the lower side of the cover [18] to the base [17] then press the upper edge of the base
to close the cover; fix the cover in place using screws [25].

 Connect power circuit and the telephone line only after the cabinet has been secured to the building or
structure and has been connected to the protective earth ground of the building.

!!!!! Before inserting or removing the SIM card, please ensure the unit is powered down.

CONNECTING THE DEVICE
This section describes the terminals and auxiliary connections. Figure 3 shows a typical wiring diagram.

!!!!! The Open Collector current may not exceed 100 mA. If necessary, commutate greater loads using switches
or our switch boards BRM04/12 (12V dc) and BRM04/24 (24V dc).

Auxiliary connections
The auxiliary connections are not necessary for the Communicator operation, but they maximize the versatility of this
device. These connections are described in the following paragraph.
Tamper - The connection of the MAXIASNC tamper switch (optional) allows you to detect the Communicator cover opens.
The tamper switch wires can be connected as follow.
— To the panel tamper line or a different 24h zone. Read the panel instructions for more information.
— To terminals [ T3 ] and [M] of the BGSM-120, to send a SMS and/or Voice message, to one or more telephone numbers,

when the Communicator cover is removed.
The second solution requires to program the Communicator by the BGSM-120/BGSM-100 Console, as indicated in the
Programming the device->Optional Tamper Programming section). After connecting the MAXIASNC tamper
switch and programming the Communicator, close the cover and power up. After the initialization of the Communicator,
open the cover and check that the SMS and/or Voice message has been sent to the programmed telephone numbers.

No. Terminals
Model

BGSM-100KCA, BGSM-100KEA, BGSM-100BA BGSM-120KCA, BGSM-120KEA, BGSM-120BA

1 +V

Power supplied by the control unit or by the ADP1512 external power supply (optional), at a level between 10 and
27.6V dc, make sure that this is protected and operating at a limited current; Limited Power Source (LPS) in
conformity with EN 60950-1:2006 standard.

!  To connect the supply use wires with a maximum 2 mt length and 0.75mm² cross-section. For shorter wires
use suitable cross-sections.

2 M Negative: Power supply and shared teminal for the Open Collector outputs.

3 T1
Open Collector outputs: These outputs are activated by
breakdown events on the PSTN line (T1) or on the GSM
network (T2).

Programmable terminals: These terminals can be
programmed as;
– Open collector outputs (default setting): These outputs
may be activated either by programmed events (automatic
activation), or by a command sent via SMS, or through
caller recognition (remote activation); please refer to the
“Output activation” section for further information. The
maximum current available at each OC output is 100 mA.
– Input lines: When these inputs receive alarm signals,
they can activate the SMS and telephone dialer functions
(please refer to the “SMS dialer” and “Voice dialer”
sections).

4 T2

5 T3

Programmable Open Collector output: This output may
be activated by a caller identification event. The maximum
current sink of each OC Output must not exceed 100 mA.

6 -
Earth Ground: This terminal must be connected to the Mains Earth, in order to comply with the Telecommunications
Network Safety Standards (Overvoltage Protection Requirements).

7
LE External telephone line: These terminals can be connected to the land line.8

9
LI Internal telephone line: These terminals must be connected to the control panel or an alternative communication terminal.10
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Fig. 3 - BGSM-100 and BGSM-120 wiring diagram.

Optional 
Connection

of the Output

Open Collector Outputs

RJ-11

RJ-11

WARNING
Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are correct before applying
power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm) separation. A minimum 1/4” (6.4 mm) separation
must be maintained at all points between Power Limited wiring and all other Non-Power Limited wiring.
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STATUS LEDS
There are 5 LEDs on the PCB (see Figure 4): three green LEDs (L1, L2 and L3), one yellow LED (L4) and one red LED (L5). These indicate
the connection, transmission, malfunction conditions and, for the BGSM-120 series only, the Communicator status (see table 2).
 During initialisation and the programming phase, the LEDs flash.

RED — This LED is normally OFF. It indicates malfunctioning
by flashing in the event of trouble. On power-up, this
Device will check for certain trouble conditions to be met
shown in the opposite table. The most significant
malfunctioning status will be indicated, with the
corresponding number of flashes of the RED LED (L5),
(see the opposite table for number of flashes and
malfunctioning indication priority).

YELLOW — This LED will switch ON when the interface
switches to the GSM Network (due to land line trouble
or the lack of this line). If it flashes slowly, it indicates
that a call is taking place on the GSM network (both
incoming and outgoing).
If lit steadily along with the red LED, this indicates that
the default manufacturer data is loading.

GREEN  — The three green LEDs  (L1, L2 e L3) indicate
the GSM signal strength and status (Table 2), as illustrated in Figure 4:
The first LED (L1) near the fixing hole. If this LED is OFF, the GSM Network service is unavailable (NO SERVICE). If
only this LED is ON, the GSM Network recepetion is weak but sufficient to manage all telephone communications.
The second LED (L2). When this LED is ON, the reception is good. This LED will switch ON only when the first GREEN LED is ON.
The third LED (L3). When this LED is ON, indicates excellent GSM signal strength; it only illuminates when the first and
second LEDs are already ON.

OPERATING PRINCIPLES
This Communicator offers the option of selecting the “Primary Path” for communication purposes. Will provide the line ring
voltage for incoming calls and will decode DTMF dialling. The Simulated land line provides the alarm control panel or an
alternative communication terminal, with a backup line in the event of PSTN line trouble. Commutation between PSTN and
GSM, does NOT occur during ongoing calls. The Operating priority (selected during programming) determines how this
Communicator manages communication (SMS and voice for the BGSM-120 only series), as well as calls from telephone
devices connected to the LI terminals (such as a burglar alarm control panel).
 This Communicator is unable to decode Pulse dialling.
 To prevent any unwanted use of a simulated line via GSM, the equipment gives out a signal in the form of a double beep

during vocal calls. The first double beep is produced after 5 minutes and the following ones at 30 second intervals each.

Fig. 4 - Operation
indicator LEDs.

Indication
priority Type of malfunction Red LED

flashes

1 (HIGH)
Firmware problem (incorrect

firmware) 1

2 Power supply problem 2

3
GSM module problem

SIM problem during operation 3

4 SIM problem during initialization 4
5 GSM reception problem 5
6 GPRS problem 6
7 Receiver not available 7

8 (LOW)
Monitoring receiver not

detected (receiver 1) 8

— No Troubles Off

Green LED
flashes Meaning of indication

L1 Voice message transmission in progress.

L3
Remote Session; will flash until you exit
the GPRS remote session.

L1+L2
Service mode; flashing continues until
the device exits this mode.

L2+L3
Incoming SMS message; will flash for 5
seconds.

L1+L2+L3
The Communicator is initialising; flashing
continues until a GSM signal is found.

Table 2 - BGSM-120 Communicator
status indications provided by the
flashing of the green LEDs (L1, L2, L3).

GSM reception level symbol
Operation indicator LEDs

LEDs Indicating GSM reception

LED numbering
(numbering not present on
 the electronic board). This

numbering has only been
provided in order to make

identifying each LED easier
within the document.

1 2 3 4 5
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Restore default programming
To restore the default programming of the transmitter, proceed as follows:
1. Disconnect the transmitter from the power supply.
2. Keep terminals 1 and 4 on connector [9] (fig. 5, page 17) short-circuited, using clamps for example, and restore the power supply.
3. The 5 LEDs (L1, L2, L3, L4 and L5) will light up briefly (less than 1 second).
4. As soon as the short circuit is detected, the 3 green LEDs (L1, L2, L3) switch off, while the yellow and red LEDs (L4, L5)

remain illuminated (for a few seconds) to indicate that default programming is being restored.
5. When the yellow and red LEDs (L4, L5) light up, remove the short circuit between terminals 1 and 4 on connector [9] (fig. 5, page 17).
6. Once this procedure is complete, the 3 green LEDs flash to indicate that the transmitter is initialising.
 Recorded voice messages are NOT deleted when the default settings are restored.

PSTN pre-set channel
If the voltage on the land line terminals (LE) drops below 3V dc for a period of between 10 to 3600 seconds ( programmable
value ), this Device will switch the connected telephone device (connected to the LI terminals) to the GSM Network. When
the PSTN telephone line is restored, it commutates once again, after a programmed period of time, to the PSTN telephone line.
 You can force the commutation

on the GSM/GPRS channel, even
when there is the land line by
entering the prefix “9999” in front
of the telephone number dialed
by the Control Panel (for further
details see the table on the right
and the paragraph “GPRS-
>Telephone numbers to decode”).

 The telephone numbers for the
PTM function (see “PTM-
>Telephone Numbers”) and
those to be decoded (see
“GPRS->Telephone numbers to
decode”) must be entered
WITHOUT the prefix “9999”.

 If, for any reason, the device is on the GSM simulated line, the prefix "9999", if present, will be removed
from the dialed number.

GSM pre-set channel
This provides the devices connected to the LI terminals with a simulated line if GSM reception is detected. If there is no GSM
reception, it commutates to the PSTN telephone line.

Contact ID transmission sequence on GPRS
The Communicator, if telephone numbers have been entered on the page GPRS->Telephone numbers to decode for
decoding using the BGSM-120/BGSM-100 Console software, directs calls to these numbers over the GPRS line.
 When an event is triggered, the Alarm Panel goes off-hook.
 The dial tone is simulated.
 Control Panel dials the number of the central station. Ensure the alarm panel inserts a minimum 1-second pause, or has

dial tone search enabled before dialing the number.
 The Communicator will send the required Contact ID dual tone handshake.
 After receiving the handshake, panel transmits alarm message in DTMF format.
 The Communicator decodes and transforms DTMF digits into the packet and sends it to the Central Station Receiver over

the GPRS network.
 The receiver acknowledges the event and sends the command to this Communicator, which generates the correspond-

ing kiss-off signal (at a frequency of 1400 Hz) and sends it to the control panel.
 After the Communicator generates kiss-off, the panel goes on-hook if no more alarms need to be sent, or it can send the

next alarm.

Number dialed by
the Panel

Telephone
Line

Number in the
"Telephone numbers

to decode" list

Effect

0123456789 PSTN None
Voice call on PSTN of the
number 0123456789.

99990123456789 PSTN 0123456789
Contact ID communication
on GPRS.

99990123456789 PSTN None
Voice and/or Contact ID call
on GSM of the number
0123456789.

99990123456789
Simulated
on GSM

0123456789
Contact ID communication
on GPRS.

99990123456789
Simulated
on GSM

None
Voice and/or Contact ID call
on GSM of the number
0123456789.
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SMS dialer (BGSM-120 series only)
In SMS dialer operating mode, one or more telephone numbers (the first 8 entries in the phonebook) are sent SMS messages
(as programmed previously) corresponding to the following events (see table below):

 Alarm indications which may occur on one or more of the 3 programmable input lines. Bear in mind that 2 SMS messages
can be programmed for each of the 3 input lines on the device, one for Activation and one for Resetting.

 PSTN line test. 2 SMS messages may be programmed: one for PSTN line absence and one for Resetting.
 Power supply voltage test. 2 SMS messages may be programmed: one indicating Power supply voltage problems and

one for Resetting.
 Periodic SMS message, with a programmable time period between 1 hour and 1 year.
 An SMS message is transmitted when one of the above events occurs, for which an SMS message and at least

one telephone number has been programmed.

Voice dialer (BGSM-120 series only)
During operation in Voice dialer mode, one or more telephone numbers (the first 8 entries in the phonebook) are sent a pre-
recorded voice message. Up to 8 messages may be recorded, each with a maximum duration of 16 seconds. Each
message is recorded onto a solid state memory, thereby eliminating all problems linked to the use of magnetic tape, such as
the deterioration of message quality over time; the jamming of mechanical systems after extended periods of inactivity, etc…
The messages are linked to the following events (see table below):

No. Event description
Programmed telephone numbers
(first 8 entries in the phonebook) SMS message
1 2 3 4 5 6 7 8

1 Input 1 Event         *SMS string
2 Input 1 Restore         *SMS string
3 Input 2 Event         *SMS string
4 Input 2 Restore         *SMS string
5 Input 3 Event         *SMS string
6 Input 3 Restore         *SMS string
7 PSTN Fault Event        

8 PSTN Fault Restore         *SMS string
9 Mains Fault Event        

10 Mains Fault Restore         *SMS string
11 Periodic SMS         *SMS string
  Event disabled on telephone number
  Event enabled on telephone number
  *   The SMS string may be up to 100 characters long

No. Event description
Programmed telephone numbers
(first 8 entries in the phonebook)) Mess. #1 Mess. #2 Mess. #3
1 2 3 4 5 6 7 8

1 Input 1 Event        

2 Input 1 Restore        
Voice

Message 1
Voice

Message 2
3 Input 2 Event        

4 Input 2 Restore        
Voice

Message 2
5 Input 3 Event        

6 Input 3 Restore        

7 PSTN Fault Event        

8 PSTN Fault Restore        

9 Mains Fault Event        

10 Mains Fault Restore        

11 Periodic Call        
  Event disabled on telephone number
  Event enabled on telephone number
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 Alarm indications which may occur on one or more of the 3 programmable input lines. Bear in mind that 2 voice
messages can be recorded for each of the 3 input lines on the device, one for Activation and one for Resetting.

 PSTN line test. 2 voice messages may be recorded: one for PSTN line absence and one for Resetting.
 Power supply voltage test. 2 voice messages may be programmed: one indicating Power supply voltage problems and

one for Resetting.
 Periodic voice message, with a programmable time period between 1 hour and 1 year.
A voice call takes place when an event occurs on a channel for which a voice message and at least one telephone number
has been programmed.
In this case, the Communicator performs the following steps:
1. The Communicator selects a telephone number and forwards the call over the GSM telephone line.
2. The Communicator makes sure that the number is not busy and that there are no problems on the GSM network, so that

it can proceed with the next step, otherwise the call will end and step 1 will be attempted again, up to a maximum of 8 times
(depending on the programmed value). After 8 attempts the call cycle will be considered complete. If the alarm channel
has been programmed to call several telephone numbers, they will be called in a set sequence. By doing this, for
example, the possibility of calling a busy number several times in the space of a few seconds can be avoided.

3. The Communicator waits for a response from the number called for a period of up to 60 seconds.  If the outcome is positive,
the Communicator moves on to step 4; otherwise the call will end and step 1 will be attempted again, up to a maximum
of 8 times (depending on the programmed value). After 8 attempts the call cycle will be considered complete.

4. The Communicator plays the message corresponding to the channel where the alarm is taking place, the call is considered
completed only once the message has been received, or when the   key is pressed (if "Call Confirmation" has been
selected, see the Voice dialer->Call Confirmation section) on the phone receiving the message. In any case, the call is
considered successful after the message has been repeated up to a maximum of 8 times (depending on the programmed value).
If, at the selection stage, several events occurred causing several different messages to be sent to the same telephone number,
these messages are reproduced (each for a maximum of 8 times, depending on the programmed value) in sequence during the
same telephone communication, thus avoiding calls being made to the same number several times. If at the end of the call cycle,
the line which caused the Communicator to be activated is still in alarm mode, the procedure described above will not be repeated
again.  In fact, the line that caused a call cycle must return to standby mode before a new cycle is activated.

Priority management (BGSM-120 series only)
The Communicator can be used to transmit alarm events and SMS or voice messages; several priorities may be programmed
using the BGSM-120/BGSM-100 Console software (please refer to the section corresponding to programming procedures using
the BGSM-120/BGSM-100 Console software). The table below lists the default priority management settings.

Simulated telephone line priority
When the device connected to the LI terminals requests the line, any other call made at that moment in Voice dialer mode
will be terminated. The calls requested by the device connected to the LI terminals (a burglar alarm control unit, for example)
take place in this manner. When the device connected to the LI terminals frees the line, the voice dialer will resume the
suspended calls and begin sending voice messages again.

SMS dialer priority
If a piece of equipment connected to the LI terminals is making a call over the GSM network through this dialer and an SMS
dialer action needs to be performed, the call from the interface will not be terminated and the SMS message will still be sent.

Dialer event priority
The SMS messages have a lower priority than Voice messages but they can not be interrupted while they are transmitted:
in this case, the queued Voice message will be sent at the end of the SMS message sending.

Priority management table
Event

priority Event description Default settings Can be programmed
using software

1 (HIGH) Request LI line (release)  Yes
2 Voice dialer (voice messages)  Yes

*3 (LOW) GPRS supervision  No
* The GPRS supervision event has the lowest priority and cannot be programmed using software
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Pay As You Go Balance (BGSM-120 series only)
If the BGSM-120/BGSM-100 Console software has been used to program the device (see Options->Pay As You Go), it will
be possible to check how much credit is left on the pre-paid SIM CARD. If the credit balance check feature is enabled, an SMS
providing credit balance information (supplied by the operator) is sent to the first number in the phonebook at regular
intervals. For all operators which support credit balance requests via a network command, it will be possible to enter a
request for information using the BGSM-120/BGSM-100 Console software.
 PLEASE NOTE - The pre-paid SIM CARD credit management service may be suspended at any time, at the

discretion of each individual GSM network operator.

(PTM) monitoring of communication with the control unit
The constant monitoring of communication with the control unit (PTM function) allows the Communicator to transmit calls via
the GSM network if communication between the alarm control unit and the surveillance control unit does not take place
successfully over the PSTN telephone line. If programmed (using the BGSM-120/BGSM-100 Console software PTM page),
this feature only works when the PSTN line is connected to the LE terminals.
The PTM function correlates to the following Communicator alarm transmission modes:
1. Alarm on GPRS (IP communication - receiver).
2. Alarm on GSM (voice mode).
 The PSTN Fault event occurs when the PTM function activates.

ACTIVATING THE OUTPUTS
The BGSM-100 series has the Open-Collector Outputs (the T1, T2 and T3 terminals). The BGSM-120 series has 3 terminals (the
T1, T2 and T3 terminals) that can be programmable as Inputs or/and Output: this terminals are programmed as Outputs by
default. The Open-Collector Outputs can be activated automatically (when certain pre-programmed events occur) or remotely,
through SMS trasmission (for the BGSM-120 series only) or caller identification from a number programmed previously.

Activating/Deactivating Automatic Outputs
The T1,T2 and T3 Open Collector outputs can be activated automatically by the following events:
 Land line trouble (line down), (T1, BGSM-100 series).
 GSM Network trouble (Limited/No Service), (T2, BGSM-100 series).
 Supervision message missing (BGSM-120 series only).
 Internal event communication failed (FTC), (BGSM-120 series only).
 Once an OC output has been automatically activated, it will only return to standby mode when all the causes

of activation have been cleared, except if there is a Failure To Communicate an internal event (FTC), in which
case it returns to standby mode after the ON Time has expired.

Remote Activation and Deactivation of the Outputs
 CAUTION - The GSM connection must be established before the outputs can be activated/deactivated remotely.

We recommend the device is programmed with the Black list enabled (Options->Dial Options) and White list
disabled (Phonebook->White list) for the numbers you wish to use for this function.
The number used to activate the outputs via Caller Identification must be visible.

BGSM-100
The T1 and T2 Open Collector outputs as BISTABLE, while the T3 output is MONOSTABLE (Once a Monostable output
has been activated, it will not deactive until On Time expires).
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BGSM-120
The Open Collector outputs can be set as Bistable (activation and deactivation takes place by means of 2 separate
commands) or Monostable (the output remains active for the ON time and returns to standby mode when this period
has elapsed or when it is deactivated by means the specific SMS). Moreover, every output can be programmed to
provide a confirmation signal (an SMS programmed previously if output activation/deactivation is performed via SMS,
or a confirmation ring if output activation/deactivation is performed via caller identification).
 For further information on the terms “Control string” and “User code” used in the following sections,

please refer to the “I/O” and “Options->Codes” sections of the “PROGRAMMING VIA PC” chapter.

Bistable outputs (BGSM-120 only)
Open collector outputs set as bistable can be activated in 2 ways:
1. By sending an SMS consisting of the User code between two # characters, the Control string (Control String can not

have initial blank spaces) and the characters “=ON#”, as follows:

#User code#String=ON#   (example: #9876#HOUSELIGHT=ON#)

2. Through caller identification: in this case the output is activated at “cost-free” as the Communicator, after identifying the
caller, rejects the call and activates the output.

 A bistable OC output can ONLY be deactivated by sending an SMS message consisting of the User code
between two # characters, the Control string and the characters “=OFF#”, as follows:

#User code#String=OFF#   (example: #9876#HOUSELIGHT=OFF#)

 The default User code is ‘0001’; if you wish to change it, please refer to the section “Remote programming by SMS
message->Changing the User code”.

Monostable Outputs
OC outputs set as Monostable may be activated in 2 ways, through Caller Identification and via SMS (BGSM-120 only).

SMS (BGSM-120 only)
Send an SMS consisting of the User code between the # characters, the Control string (Control String can not have
initial blank spaces) and the characters “=ON#”,“=ON#TonU#” or “=OFF#”,as follows:

#User code#String=ON#
#User code#String=ON#TonU#

#User code#String=OFF#

The “=ON#tonU#” option is  parameter allows  to set the ON Time from 1 to 86400 seconds, with 1 second steps. The ON
Time can be set by means of the Communicator's Console software. “Ton” is the required value and “U” is the unit in hours
(H), minutes (M) and seconds (S), as shown in the following example:

 Remove the “TonU” parameter, leaving the “##” characters, to activate the output by SMS as programmed.

(example: #9876#HOUSELIGHT=ON##)

SMS Output operating mode

#9876#HOUSELIGHT=ON# Bistable Activation

#9876#HOUSELIGHT=ON#3600S# Active for 3600 seconds

#9876#HOUSELIGHT=ON#50M# Active for 50 minutes

#9876#HOUSELIGHT=ON#3600#
Active as per software programming,

the set ON time does not apply
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Caller Identification
Through caller identification: in this case the output is activated at “cost-free” as the Communicator, after identifying the
caller, rejects the call and activates the output.
 Monostable OC outputs deactivate (switch OFF) automatically when the programmed ON Time expires.
 Only the T3 output of the BGSM-100 can be activated through Caller Identification.
The ON time may be set to a period of time between 1 and 86400 seconds, in steps of 1 second.
 The default User code is ‘0001’; if you wish to change it, please refer to the section “Remote programming by SMS

message->Changing the User code”.

REMOTE PROGRAMMING BY SMS MESSAGE
(BGSM-120 series only)

In addition to the processes described in the section Remote activation and deactivation of the outputs, it is also
possible to carry out other remote procedures through the transmission of various SMS messages.

Changing the user code
The default user code is ‘0001’; to change it, send an SMS message consisting of the characters “#CUC” followed by the
old User code and the new User code between * characters, in accordance with the following formula:

#CUC*User code*New User code*
You will receive an SMS confirmation if the User Code has been changed.
 The User code may only consist of numbers from 0 to 9 (maximum 4 digits).

Enabling or disabling remote programming
Remote programming makes it possible to use the functionalities of the BGSM-120/BGSM-100 Console software via a
network. In order to remotely manage the parameters of the Alarm Communicator, remote programming must be enabled.
This can be done using the BGSM-120/BGSM-100 Console software (see the Programming via PC->GPRS->Remote
Programming section), or by sending an SMS message consisting of the characters “#UWS” followed by the User code
and “ON” between * characters, in accordance with the following formula:

#UWS*User code*ON*
To disable the Remote Programming, send the following SMS message:

#UWS*User code*OFF*
A text message will confirm whether the command was successful.

Changing the Installer code
The Installer Code (maximum 4 digits) is used for accessing the remote programming interface (see the Programming via PC-
>Codes->Installer Code section). The default installer code is ‘0002’; to change it, send an SMS message consisting of the characters
“#CIC” followed by the old Installer code and the new Installer code between * characters, in accordance with the following formula:

#CIC*Installer code*New installer code*
You will receive an SMS confirmation if the Installer Code has been changed.
 The Installer code may only consist of numbers from 0 to 9 (maximum 4 digits).

Credit balance check
To find out the credit balance via SMS, you can either use the BGSM-120/BGSM-100 Console software (see section
Programming via PC->Options->Pay As You Go), or you can find out remotely by sending an SMS message consisting
of the characters “#CCC” followed by the * character, in accordance with the following formula:

 #CCC*
 The balance SMS will be sent to the Telephone Number #1 of the Phonebook.

The pre-paid SIM CARD credit management service may be suspended at any time, at the discretion of each
individual GSM network operator.
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PROGRAMMING VIA PC
 For proper function of this Communicator, use a 32 K SIM CARD (or higher).
For programming, the PC-Link cable (not supplied) must be connected to the Connector [9] of the Communicator and a COM
port on the PC (see Fig. 5); the BGSM-120/BGSM-100 Console application is also required. The PC-Link cable shown in Figure
5a, or the PC-Link cable shown in Figure 5b, can be used for the connection. Make sure you insert the PC-Link cable connector
in the right way. Once the PC-Link cable has been connected, set the computer COM port through the the Options->Serial
ports. Check the serial link and the serial port settings in case of communication problem, or use a different USB-RS232 adapter.
 To install and run the BGSM-120/BGSM-100 Console application, you will need to log on to the PC as the Administrator;

we also recommend to verify the firewall’s options if problems arise while the application is being installed.

Viewing the Device Settings
To view the Communicator settings on the screen, use the Upload from board icon.

Downloading the Device Settings
Once programming has been completed (or an uploaded file containing existing data has been modified), download the data
into the Device, using the Download to board icon.

Preliminary operations
When the application starts, you will be presented with the Main window: if you use the mouse to click the menu option Untitled
#1 in the top left-hand part, two sections appear.
 The following sections may be found within the general parameters section:

Customer informations: this section can be used to set the Communicator series (BGSM-100 or BGSM-120),
or to recall and update the configuration corresponding to a particular client as follows:
1. Left-click on the application.
2. Enter or update the information relating to the customer and the system. Click to confirm.

Upload from board: If this icon is selected, the data programmed on the board is loaded onto the PC.

Download to board: If this icon is selected, the programmed data is sent to the board. Sending all of the device settings or
some "GPRS", "I/O" (BGSM-120 only) and "Options" (BGSM-100 only) pages to the device will reset the Alarm Communicator.

Factory defaults: Select this icon to restore the default settings. It should be noted that restoring the default settings
does not delete any voice messages recorded.

Board reset: If this icon is selected, the Communicator is reset.

RS-232

a b

Make sure you insert the PC-Link
cable connector in the right way

Make sure you insert the PC-Link
cable connector in the right way

1 4

RS-232

1 4

5

2

Solder
Side

3

Fig. 5 - Diagram of the PC-Link connection cable.
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  The section shared by the BGSM-100 and BGSM-120 series includes the following pages.

Phonebook: Telephone contact list page.

Options: Options page.

GPRS: GPRS parameters page.

Status: Page used to check the status of the Communicator.

PTM: PTM function setup page.

The following pages only apply to the BGSM-120 Communicator series.

I/O: Communicator output/input parameter programming page.

Voice Dialer: Page used to set all parameters relating to the voice dialer.

SMS Dialer: Page is used to program all SMS dialer options.

Voice Message: Page used to manage voice messages.

To start the configuration of a new Customer, click on File->New.
To display the list of customers stored in the archive, select the menu command File->Open. This section will allow you
to delete or retrieve configuration data, as follows:

1. Using the right button on the mouse, click on the Customer’s name.

2. Click Load upload the respective data from the Hard-Disk, or Delete selected customer to delete the data configuration.
You can load the configuration data by double clicking the respective name field.
You can list Customers in alphabetical or code order by clicking the heading of the column concerned.

The configuration data are grouped in the following pages. The (Status) page is for “Supervisory and Control” purposes. All
the pages are described in detail in this section.

Phonebook
The Telephone Page phonebook holds 100 telephone numbers.
 The remaining balance on the pre-paid SIM card is sent via SMS to phone number #1.
 Description: Enter an alphanumeric string of up to 16 characters.
 Telephone number: Enter a phone number including the country code in the format "+xxx" (e.g.: +39 for Italy). A

maximum of 16 digits is allowed (the plus sign "+" counts as a digit).
 Activates Output: select the telephone numbers which can activate the outputs T1 (OC1), T2 (OC2) and T3 (OC3) when

the Communicator receives a call from them. This function does not depend on the White List or Black List options
(Options page->Dial options). The Calling Line Identifier service must be enabled before the output can be activated.
 In the BGSM-100 series, it is possible to only activate the T3 output (OC3).
 To activate the output in the BGSM-120 series, programme the T1 (OC1), T2 (OC2) and T3 (OC3) terminals as
"Output" and enable "Reserved Output" (see pages referring to I/O->Type and I/O->Reserved Output).

 Ouput Activation Confirmation: this option is only available for the BGSM-120 series; tick this box to receive a
confirmation ring once the output has been activated.

 CAUTION:
— the ring will be received 1 minute after the output has been activated;
— if the transmitter is already in operation (for example: the GSM channel is busy with a voice communication),
the confirmation ring will not take place;
— the option “Ouput Activation Confirmation” cancels the incoming call after approximately 5 s, even if the
"Black list" option is not enabled.

 White List: Enable or disable   the White List area would allow the Communicator to accept or refuse incoming
calls. The Communicator accepts incoming calls, forwarding them to the telephone devices connected to LI terminals
(such as a burglar alarm control panel); this is possible only if LI is active as a simulated line via GSM. The functioning
mode of the White List option is linked to the  selection or non-selection of the Black List, area which is present
on the inside of the Options page->Dial options, as seen in the following table:
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This page is used to set the options relating to the Communicator board.

Dial options
This part is used to enter some of the characteristics relating to the telephone numbers used.
 Prefix: This Device will prefix the digits entered in this field to all the telephone numbers dialled through the GSM Interface

function. If necessary enter a Prefix (maximum 8 digits) in this field. If no Prefix is required, leave this field empty.
 Digits to Remove: If this Communicator is connected downstream to a switchboard, the telephone numbers (pro-

grammed on the Control panel) must be preceded by the switchboard number (normally one digit). As the switchboard
number is not required when calls are sent over the GSM Network, it must be removed from the digits which form the
telephone number. Enter the number of digits that form the switchboard number (e.g. if switchboard number is 01, enter
2 in the “Digits to remove” field, as 2 numbers form the switchboard number).

 The telephone number should at least have two digits more that the number in the “Digits to remove” area,
otherwise the engaged tone will be come through, e.g.:
– the dialled telephone number is 0123, with 2 digits to be removed = correct, the remaining number to be inserted is 23.
– the dialled telephone number is 123, with 2 digits to be removed = engaged tone, the remaining number to be inserted is 3.

 Enable Black List: Check this box if you do not wish to receive calls from telephone numbers, authorising only the
numbers selected previously using the White List function (Phonebook page->White List).

 Only the “Black List” option cancels the call immediately.
 When the “Black List” and “Activates Output” options are enabled, there is a delay (some seconds) before

the call is cancelled;
When the Ring is selected for the “Activates Output” option, there is a delay (some seconds) before the call is cancelled;
If the output cannot be activated, BGSM-120/BGSM-100 cancels the call immediately.

Event priority (BGSM-120 series only)
This page may be used to program several Communicator priorities, for the transmission of alarm events (see Priority management section).
 Off-Hook: This box can be used to establish the priority of telephone devices connected to the LI terminals (such as a

burglar alarm control panel). It is enabled  by default; to disable it remove the tick  .
  Voice Dialer: This box can be used to establish Voice dialer (voice message) priority. It is disabled  by default; to

enable it, mark it with a tick .

Codes (BGSM-120 series only)
 User Code: Enter the account code in this box (maximum 4 numeric characters) to activate outputs remotely. For further information, please

refer to the section “Activating the Outputs->Remote Activation and Deactivation of the Outputs”.The default code is set to ‘0001’.
 Installer Code: The Installer code can be entered in this field (maximum 4 numerical characters). This code allows

access to the “Remote Programming” interface when required. The default code is set to ‘0002’.

Generic
This section may be used to set the audio levels of the loudspeaker and microphone fitted to the GSM Communicator.
 Speaker volume: The volume of the loudspeaker may be adjusted by shifting the cursor.
 Microphone volume: The volume of the microphone may be adjusted by shifting the cursor.
 CAUTION: if the volume on the microphone is too high, it may corrupt the DTMF tones from devices

connected to the LI terminals, making them unrecognizable.
 Tones...: Select the name of Communicator's country of installation; the selected country will establish a series of

parameters for the proper working of the simulated telephone call.
 LE failure timeout: Enter the time in seconds (between 10 and 3600 seconds) for the Line down on the LE terminals,

before the PSTN Fault event occurs.
 The time may increase up to 60 seconds if some telephone devices are connected to the terminals LI.
 LE restore timeout: Enter the time in seconds (from 30 to 3600) that the telephone line must be connected to the LE

terminals before the PSTN Fault event is reset.

White List Black List Functioning mode
  Accept incoming calls from any number
  Refuse any incoming call

 
Accept incoming calls only from numbers having an enabled
White List option, refuse call coming from all other numbers
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System (BGSM-120 series only)
This section refers to the System.
  SIM Phone Number: Enter the telephone number of the Communicator’s SIM CARD (maximum 16 digits).
 Auto Clock Adjusting: Checking this option the device will update the system date and time by sending an SMS itself.
 SMS Service Center Address: This is a read-only option. It shows the number of the SMS services centre on the SIM CARD.

Pay As You Go (BGSM-120 series only)
 The pre-paid SIM CARD credit management service may be suspended at any time, at the discretion of each

individual GSM network operator.
This section can be used to send an SMS providing credit balance information (supplied by the operator) to the first number in the phonebook
at regular intervals. Program the following options for a correct credit balance check request, in accordance with the type of operator used:
 Enquiry Type: selection of enquiry type (SMS, Call, Service Command).
 Enquiry Number: telephone number to call or to which an SMS message should be sent in order to request credit balance information.
 Balance Message: string used to send SMS messages and to make requests via service commands.

 Interval: Enter the interval (HH-DD) at which you wish to send a perodic SMS containing credit balance information (if
supported by your telephone operator). The interval consists of the following values:
— (HH) next message time - Select the time at which you wish to send the next periodic SMS. The interval for these
values may be set between 0 and 23.
—- (DD) next message day - Select the day on which you wish to send the next periodic SMS. The interval for these
values may be set between 0 and 365.

Outputs(BGSM-100 series only)
This section may be used to set the operating modes of the outputs.
 Output 1, Output 2, Output 3: Check the box for output operation normally closed or normally open.
 Output 3 ON Time: The ON time in seconds may be entered in this field (between 0 and 86400 seconds).

Primary Path
The user can program the primary communication line.
 Primary Path: Select the primary GSM or PSTN line using this field.

GPRS
This page outlines the GPRS configuration options.
 Bearing in mind the delays which may occur in transmission via GPRS, which are caused by the activities of the

network manager, we recommend you program as many call attempts to the burglar alarm control panel as
possible, and that you also provide a backup telephone number which transmits alarms via GSM as well as via GPRS.

Access Point Name 1 and Access Point Name 2
Enter the Access Point Name of the GPRS service provider being used. Enter the name of the IP address service provider
in this box. Access Point Name 2 is considered a backup parameter.
 WARNING: make sure to enter the correct APN for WAP/GPRS access - otherwise some functions may be

limited (for more information, please contact your customer support).

Main Receiver, Local Port 1 and Alarm Port 1 IP address
Enter the primary receiver IP addresses and port numbers. For Sur-Gard SYSTEM III and SYSTEM II enter the IP address
and the port listed in the Alarm Port section.

Backup Receiver, Local Port 2 and Alarm Port 2 IP address
This check box is used to enter the second IP address for the receiver and the port number, with the difference that these
parameters are considered as a backup receiver. The Communicator only recognises this box if the parameters corresponding

Example for Italian operators
Options Vodafone Wind TIM

Enquiry Type Call Service Command SMS
Enquiry Number 404 40916
Balance Message *123# PRE CRE SIN
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to the Main Receiver, Local Port 1 and Alarm Port 1 address have been entered. Furthermore, the Enable supervision
and Supervision time boxes refer only to the main receiver.

APN1 Username and Password, APN2 Username and Password
Some providers may require a user name and password to validate communication. If needed, enter this information here.
APN2 Username and Password are considered to be backup data.

Telephone numbers to decode
This communicator permits to communicates the events in the Contact ID format, via the GPRS network, also to the control
panels that do not support this communication method.
To do this, you must setup a telephone number (the phone numbers can be "virtual" or "real") on the control panel for event
communication in Contact ID format (e.g. you can setup 0123), then you must enter the same telephone number in one of this
fields (you can program up to four telephone numbers for this function).
When the Communicator recognises a call from one of these numbers, automatically transcodes the event in digital format
and forwards it on the GPRS network to the set receiver (refer to the “Main Receiver” and “Backup Receiver” options).
 The telephone number must be of at least 2 digits.

The options “Prefix” and “Digits to Remove” have no effect on the “Telephone numbers to decode”.
The “Telephone numbers to decode” must exactly match with the telephone numbers set for the control panel.
Leave this fields empty if you don’t use this function.
For this feature to work correctly, the "Main Receiver" (and, where necessary the "Backup Receiver") option
must be selected.

DNIS
If required, enter the Dialled Number Identification Service number.

Account code
The account code for communication with SYSTEM III or SYSTEM II receivers must be entered in this box.

Enable Supervision
To enable supervision, select this option. The supervision option is ONLY available to the main receiver. The supervision
messages are not sent when the device is performing a voice call (on GSM).

Supervision time (sec)
Set the Supervision time for the monitored receivers. It is possible to set a Supervision time between a minimum of 5 second
and a maximum of 65535 seconds, with steps of 1 second.

Remote programming (BGSM-120 series only)
This interface makes it possible to use the functionalities of the BGSM-120/BGSM-100 Console software via a network. The transmitter
parameters can be managed remotely using this interface. To use this function, visit the web address http://www.bentelreachme.com.
 Enabled: To enable the Remote Programming, click this check box to enter a tick (this setting is enable by default).
 Encryption key: The encryption key can be set so that the Remote Programming cannot be accessed by unauthorised persons.

The encryption key may include between 1 and 32 hexadecimal characters. The default setting is 0 (encryption key not enabled).

Status
This page will allow you to monitor and control in real-time all the Communicator functions.
 ATTENTION: This page is updated every 5 seconds.

Status section
This section lists the most important data relating to the GSM module. The virtual display shows, in addition to the name of
the GSM network manager, the GSM signal strength (this is displayed through a special indicator).
The Device status indicator may be ON or OFF .The Device status indicator light when it is GREEN: proper function. When
it is RED, this indicates that there is no communication between the software and the device; if it is ORANGE it means that
there is a communication in course. For GPRS Main Receiver and GPRS Backup Receiver this indicator is ORANGE when
the Receiver is initialized but NOT currently connected OR connected but NOT yet initialized.
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PTM
This page refers to the “PTM (Panel Transmission Monitoring) function”, which allows the device to transmit calls over
the GSM network in the event of failed communication between the control unit and the receiver on the PSTN telephone line.
 The Communicator restores to normal mode after 5 minutes on the GSM channel.
The PTM function considers communication to have failed when:
– It does not detect number dialling, if the “Check Dialling” option has been enabled (this option checks that telephone
numbers have been dialled correctly).
– It does not detect a kiss-off (the signal transmitted by the receiver when successful event communication has ended).
 The kiss-off signal frequency is 1400 Hz.
All numbers are checked if the “Telephone Numbers” list is empty; otherwise only the numbers on the list will be checked.
Calls are transmitted over the GSM network when the programmed “Maximum Failure Number” has been reached.
 Telephone Number: Enter the telephone numbers (up to a maximum of 4) to be called using the PTM function. These fields

are empty by default. If this fields are blank, the “PTM function” will check all the telephone numbers dialed by the control panel.
 Check Dialling: Disabled at factory default, if enabled, the missed dialing (i. e. when the PTM does not detect the

number dialed by the control panel on the PSTN line) will be count as failure by the “PTM function”.
 Max Failures: In this box, enter the total number of errors detected by the Communicator above which the PTM function is

activated. The PTM function is disabled by default (the default setting is 0); set a value from 1 to 4 to enable the PTM function.

I/O (BGSM-120 series only)
This page is used to program input or output modes, output activation events, polarity (N.C. or N.O.), reserved outputs and
remote activation SMS strings for reserved outputs.
 Type: This column can be used to program terminals T1, T2 and T3 for the following modes:

– Input: Select this mode to enable the corresponding terminal as the input line. If this mode is selected, the Service
column is activated (see below).
– Output: Select this mode to enable the corresponding terminal as an open collector output.
 CAUTION - These settings also automatically update the parameters on the “SMS dialer”, “Voice dialer”
and “Phonebook” pages.

 Polarity: This box is used to program the output/input standby status:
– Normally Closed  with the output/input in standby, the corresponding terminal is negative.
– Normally Open  with the output/input in standby, the corresponding terminal is floating.
Click the box corresponding to the ‘Polarity’ column to invert the parameter currently displayed.

 Activation events: Click the column corresponding to the event to be programmed, in line with the relevant output. The tick
 indicates that when this event occurs, the relevant output will be activated. Click the boxes to enter/remove the tick .
 CAUTION - Programming the events linked to an output causes some of the boxes corresponding to that output
to be disabled. Before you can begin programming, you will need to remove the ticks   from various boxes.
– PSTN Fault: If selected, the output will be activated in the event that the telephone line is not detected.
– GSM Fault: If selected, the output will be activated if the GSM network is not detected.
– HB Fail: If selected, the output will be activated in the event that the supervision message is not detected.
– FTC Signal: if selected, the output will be activated if communication is not successful.
 The selection of the FTC Signal event enables the Monostable option and allow you to set the Monostable
Time (ON Time).

 Reserved Output: When this option is selected, all other events selected to activate the corresponding output are
ignored. Click the box corresponding to the output to be activated through caller recognition or via an SMS command. To
activate the output using caller identification, program the telephone number on the “Phonebook” screen and enable the
option “Activates output” (see page Phonebook->Activates output).

  Service: A tick  in this column indicates that the Communicator is in its SERVICE status, i.e. when lines 1 and 2 become unbalanced,
instead of making a call, the Communicator will take a specific action independently. An action may be specified for each line, in accordance
with the table below. In any case, if these actions are selected, SMS messages are never sent in reference to inputs 1 and 2.
Input line

no.
Selection Associated Service function

1 A Forced switching on GSM network

2 B Delete telephone queue
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 CAUTION - These settings also automatically update the parameters on the “SMS dialer”, “Voice dialer”
and “Phonebook” pages.

 Control String: In this column, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish
to activate/deactivate the corresponding remote output. This feature will operate even if caller identification is not enabled.

 Activation Confirmation: Use this column to select the type of confirmation you want when the output is activated. There
are 3 different options to choose from: None, Ring or SMS (the latter option is not available if the Control string box has
been left empty). The output activation confirmation is forwarded by means of a SMS when the output is activated by SMS.

 Monostable: Normally the outputs, when activated, remain so until a deactivation command is received, at which point
the output will revert to its standby status. If you want the output to revert to its standby status automatically after a set
amount of time, select this option and set the activation time using the adjacent Monostable Time (sec) box.

 Monostable Time (sec): In this box, enter the value in seconds (from 1 to 86400 in steps of 1 second) indicating the time
period for which the output, if set as Monostable, will remain active before reverting to its standby status (ON Time).

Voice Dialer (BGSM-120 series only)
This section is used to program all parameters relating to the voice dialer, namely: the telephone numbers to call (the first 8
numbers in the phonebook), the number of repetitions for each message (minimum 1, maximum 8), the duration and number
of the messages in accordance with the following specifications:
 Description: This column lists the events for which a voice message may be programmed.
 To select voice messages for the 3 programmable input lines, set the corresponding terminal as an
input (see I/O->Type).

 Telephone numbers: Click the ‘12345678’ columns in accordance with the desired event. The tick  indicates that a
particular telephone number will be called when an event occurs. Click the boxes to enter/remove the tick .
 The telephone numbers are the first 8 entries on the “Phonebook” page.

 Voice Message: Triple-click the ‘Message’ column corresponding to the desired event, then click the button to scroll
through the list of messages (up to 8 messages can be selected, each with a maximum duration of 16 seconds) and
select one. Up to 3 voice messages can be selected for each event (Message#1, Message#2, Message#3).

 Repeat Call: This field is used to enter the number of attempts to be performed (up to a maximum of 8) if the call is not successful.
 Repeat Message: This field is used to enter the number of times a message is repeated (up to a maximum of 8) when

the call is answered.
 Call All Numbers: Select this option  to call all telephone numbers programmed for an individual event and play the voice message

assigned to it. If this option is not selected , the dialer will end the voice calls as soon as one of them has been completed successfully.
 Call Confirmation: Select this option if you want the dialer to wait for confirmation from the remote user that the voice

message has been received, otherwise the dialer will attempt to deliver the voice message again: the remote user can
send confirmation by pressing the  button on his/her telephone (only applies to touch-tone keypads).
 CAUTION - By pressing the   button on your own telephone when listening to a voice message, both
the current telephone call and any others in progress may be blocked.
 In some cases the dialer may misinterpret the answer from answering machines, ringback tones, GSM
operator courtesy messages, etc. Users are advised to enable the “Call Confirmation” function.

Table: Programming Effects on Activation Output
PROGRAMMING EFFECTS

Black List White List Activation
Confirmation

Call Forwarded
(only if the Communicator is

switched to the GSM network)

Confirmation
Ring

  None YES NO
  Ring NO YES
  None YES NO
  Ring NO YES
  None NO NO
  Ring NO YES
  None YES NO
  Ring NO YES

Enabled
Disabled
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Periodic voice
This section is used to program periodic voice message options.
 You MUST enter the “SIM Phone Number” and enable the “Auto Clock Adjusting” in the “Options” page to

setup the Periodic Voice’s options.
 Date of first send: Select the date on which the first periodic voice message is to be sent.
 Time of first send: Select the time at which the first periodic voice message is to be sent.
 Interval: Enter the interval (HH-DD) at which subsequent periodic voice messages are to be sent. The interval consists

of the following values:
– (HH) next message time - Select the hour value for the next periodic voice message. The interval for these values may
be set between 0 and 23.
– (DD) next message day - Select the day value for the next periodic voice message. The interval for these values may
be set between 0 and 365.

 Update time: Select this icon to get local date and time from the PC.

Local Service Mode
By selecting the Local service mode button, you can enable the voice messages playing/recording by a touchtone telephone
connected to the [LI] terminals of the device (refer to “Local Voice Message Recording” and “Local Voice Message Replaying”).
When this mode is enabled, the green LEDs L1 and L2  flash (see Status Leds->table 2). The LEDs only stop flashing when
the recording or replaying procedure is complete, or after 60 seconds have elapsed without any of the buttons being pressed.
 You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Service Mode.

SMS dialer (BGSM-120 series only)
This page is to setup the SMS dialer’options, as indicated following.
 Event type: The ‘Event type’ column has 11 separate lines listing the events for which two SMS messages are sent,

if programmed: one for activation and one for resetting (the "Periodic SMS" event only sends an activation SMS).
 To select SMS messages for the 3 programmable input lines, set the corresponding terminal as an input
(see I/O->Type).

 Telephone numbers: Click the ‘12345678’ columns in accordance with the desired input. A tick  indicates that the
SMS message will be sent to a particular telephone number when the corresponding event occurs.
 The telephone numbers are the first 8 entries on the “Phonebook” page.

 SMS String: In the ‘SMS String’ column, click the box corresponding to the message to be programmed and enter the
message you wish to send when the relevant event occurs (maximum 100 characters).

Periodic SMS
This section is used to program periodic SMS message options.
 You MUST enter the “SIM Phone Number” and enable the “Auto Clock Adjusting” in the “Options” page to

setup the Periodic SMS’s options.
 Date of First Send: Select the date on which the first periodic SMS message is to be sent.
 Time of First Send: Select the time at which the first periodic SMS message is to be sent.
 Interval: Enter the interval (HH-DD) at which subsequent periodic SMS messages are to be sent. The interval consists

of the following values:
– (HH) next message time - Select the time at which you wish to send the next periodic SMS. The interval for these
values may be set between 0 and 23.
– (DD) next message day - Select the day on which you wish to send the next periodic SMS. The interval for these
values may be set between 0 and 365.

 Update time: Select this icon to get local date and time from the PC.

Voice Message (BGSM-120 series only)
This page can be used to record and replay the voice messages: refer to the “Voice Dialer” page for massage association
to the events. To open the voice message archive, click the icon to the left of the RECORD button, on the right-hand side
of the field “WAV File#1”.
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 The Communicator only supports WAVE audio files (.WAV), with a maximum duration of 16 seconds and
with the following specifications: PCM, 8000 Hz, 8 bit, Mono, non-compressed. Prerecorded files fulfilling

the abovementioned requirements may  be used.

PLAY button - Press to listen to the voice message again.

RECORD button - Press to start recording a new voice message.

STOP button - Press to stop replaying or recording a voice message.

GET button - Press to load the recorded voice message.

SET button - Press to send the recorded voice message to the Communicator.

ERASE button - Press this button to erase the voice message on the Alarm Communicator.

When recording a message, a progress bar indicates (in real time) the time elapsed.

Local Voice Message Recording
 You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Voice Message Recording.
To record a voice message from a touchtone telephone connected to the [LI] terminals, enable the Local Service Mode in
the Voice Dialer section and proceed as follows:
1. Press the  button;
2. Press the  buttons in sequence to enter record mode;
3. Enter the number of the message you wish to record (between  and );
4. After the beep, record your voice message (the maximum duration of the message is 16 seconds).
5. Press the  button to confirm message recording (or press the  button again if you wish to stop recording the message

before the full amount of time has elapsed); you will hear a boop tone.
At this moment, any previous recordings for this message will be DELETED;

6. If you need to record any other messages, repeat the procedure described in step 1.

Local Voice Message Replaying
 You can connect ONLY ONE telephone to the [LI] terminals for proper working of the Local Voice Message Replaying.
To replay a voice message from a touchtone telephone connected to the [LI] terminals, enable the Local Service Mode in
the Voice Dialer section and proceed as follows:
1. Press the  button ;
2. Press the  buttons in sequence to enter replay mode;
3. Enter the number of the message you wish to replay (between  and );
4. After the beep, the message will be replayed, followed by a confirmation boop tone (press the key   to stop the

message playing);
5. If you need to replay any other messages, repeat the procedure described in step 1.

Optional Tamper Programming
Through the connection (see section Connecting the device->Auxiliary connections) of MAXIASNC tamper switch (optional)
you can detect the Communicator cover opens. To send a SMS and/or voice message to one or more telephone numbers when
the Communicator cover is removed, perform the following setup, by means of the BGSM-120/BGSM-100 Console.
1) In the Phonebook page, enter the telephone numbers for the tamper message.
2) In the I/O page, set the T3 terminal as Input (Type column) with NO (Normally Open) standby status (Polarity column):

the standby status of the tamper switch is Normally Closed.
3) In the SMS dialer and/or Voice dialer page set, for the Input 3 Event, the SMS and/or the Voice message, and the

required telephone numbers.
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Para programar este dispositivo, utilizar el software BGSM-120/BGSM-100 Console Versión 3.0 ó superior.

Bentel Security declara que la serie
BGSM-100 y BGSM-120

es conforme con las condiciones esenciales y con las otras disposiciones establecidas por la Directiva 1999/5/CE.
La Declaración de Conformidad completa puede obtenerse en la dirección: www.bentelsecurity.com/dc.html.

Los siguientes modelos han sido certificados por Telefication para su conformidad con EN 50136-1-1 y EN 50136-2-1 para prestaciones del Sistema de
Transmisión Alarmas ATS 2 (D2, M2, T2, S0, I0): BGSM-100KCA, BGSM-120KCA, BGSM-100KEA, BGSM-120KEA, BGSM-100BA y BGSM-120BA.

 La instalacion de los dispositivos debe efectuarse de modo adecuado, de acuerdo con las normas vigentes. Estos aparatos se han desarrollado según los
criterios de calidad, fiabilidad y prestaciones adoptadas por Bentel Security srl. Se recomienda verificar el buen funcionamiento del sistema al menos
una vez al mes. Los procedimientos para la revisión dependen de la configuración del sistema. Pedir al instalador de los sistemas los procedimientos a
seguir. Bentel Security srl declina toda responsabilidad en caso de manipulación de los aparatos por las personas no autorizadas. El contenido de este

Manual puede estar sujeto a modificaciones sin aviso previo y no representa compromiso alguno por parte de BENTEL SECURITY srl.

Información sobre reciclado
BENTEL SECURITY recomienda a los clientes que desechen el hardware antiguo (centrales, detectores, Sirenas y otros dispositivos) ateniendo a

las normas de protección del ambiente.  Métodos a seguir incluyen el volver a utilizar las partes o productos enteros y el reciclado de componentes
y materiales. Si desea obtener información específica, visite la página http://www.bentelsecurity.com/index.php?o=environmental.

Directiva sobre el deshecho de material eléctrico y electrónico (WEEE)
 En la Unión Europea, esta etiqueta indica que la eliminación de este producto no se puede hacer junto con el deshecho doméstico. Se debe

depositar en una instalación apropiada que facilite la recuperación y el reciclado.

Para obtener más información, visite la página http://www.bentelsecurity.com/index.php?o=environmental
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INTRODUCCIÓN
Los dispositivos de la serie BGSM-100 y BGSM-120 son comunicadores GSM que ante la falta de línea PSTN envían alarmas
vocales o digitales, mediante GPRS, a los receptores System III o System II. Para cada serie se dispone de tres versiones:
— BGSM-100KCA y BGSM-120KCA kit con tarjeta comunicador GSM/GPRS, antena con cable de 25 cm;
— BGSM-100KEA y BGSM-120KEA kit con tarjeta comunicador GSM/GPRS, antena con cable de 2 metros y estribo metálico;
— BGSM-100BA y BGSM-120BA kit con tarjeta comunicador GSM/GPRS y antena con cable de 25 cm y contenedor.
Las informaciones que se refieren a una versión específica se pondrán en evidencia con una referencia al código
correspondiente. El término “Comunicador” se utilizará para describir las funciones comunes a las diferentes versiones.
Este manual proporciona las instrucciones para la programación y la utilización del Comunicador.
Para exigencias especiales de instalación se encuentran disponibles la antena remota de exterior ANT-EU y la antena
magnética con cable de 25 cm BGSM-100CA.
 Este Comunicador debe instalarse únicamente por las personas cualificadas (una Persona Cualificada tiene la

preparación técnica adecuada y la experiencia necesaria para ser consciente de los peligros a los que podría
exponerse durante el desarrollo de un trabajo, y de las medidas para minimizar los riesgos para sí misma y
para las demás personas). Este Comunicador debe instalarse y utilizarse únicamente en un entorno que tenga
un grado 2 de contaminación máxima, categoría de sobretensión II, en los lugares cerrados y no peligrosos.
Estas instrucciones se deben utilizar con el manual de la central y se deben respetar todas las instrucciones.

Características Generales
 Proporciona una línea PSTN simulada.
 Detección de ausencia de línea PSTN y conmutación

automática sobre Red GSM.
 Gestión y señalización de las llamadas entrantes y salientes.
 Indicador de intensidad de campo GSM.
 3 Bornes programables como Salidas Open-Collector o

como Líneas de Entrada (sólo para la serie BGSM-120).
 Protección de las sobretensiónes sobre la línea telefónica.
 GSM Quad-Band.
 Antena con base magnética.
 Avisador SMS (sólo para la serie BGSM-120).
 Avisador Vocal (sólo para la serie BGSM-120).
 Descodificación del Protocolo Contact ID y envío de los

datos vía GPRS.
 Comunicación GPRS/Internet con receptores Sur-Gard

System III / II.
 Opciones programables desde el PC.

 11 Mensajes SMS, cada uno con un máximo de 100
caracteres (2 por cada línea de entrada más 4 para la
señalización de Estado 1 Periódico), sólo para la serie
BGSM-120.

 (máx. 8 números telefónicos programables 16 cifras)
programables para el Avisador SMS (sólo para la serie
BGSM-120).

 Cuatro números de teléfono programables para el
avisador Contact ID sobre GPRS.

 Hasta 100 números telefónicos (máx.16 cifras) programables
para la activación en remoto de la salida OC.

 Activación de las salidas de remoto mediante
reconocimiento de llamadas y/o de SMS (envío de
SMS solamente para la serie BGSM-120).

 Control crédito residual de las SIM-CARD de prepago
(sólo para la serie BGSM-120).

 (PTM) monitoreo de las comunicaciones con la central.

Características Técnicas
La tensión de alimentación para este Comunicador la proporcionar la Central, o bien por un alimentador estabilizado ADP1512 (no suministrado).

Versiones BGSM-100KCA, BGSM-100KEA,
BGSM-120KCA, BGSM-120KEA,

BGSM-100BA,
BGSM-120BA

Tensión de alimentación de 10 a 27,6 V_
Corriente en reposo 100 mA máximo (sin las salidas) a 13,8 Vcc
Corriente alarma máxima (transmisión) 250 mA promedio (sin las salidas) a 13,8 Vcc
Salidas OC 3 open collector, de 100 mA
Frequência de funcionamiento 900/1800 MHz ó bien  850/1900 MHz
Resistencia máxima en serie por línea de los
dispositivos conectados a los bornes LI 1 Kohm

Nombre máximo de dispositivos conectables
en paralelo a los bornes LI 1

Temperatura de funcionamiento 5 ÷ 40 °C

Dimensiones (An x Al x P) 60,5 x 142 x 15,3 mm
(sólo de la tarjeta)

90 x 190 x 75 mm
(sin la antena)

Peso 66 g 348 g
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Descripción general
El Comunicador puede comunicar con las Centrales de Vigilancia y, solamente para la serie BGSM-120, puede enviar
mensajes SMS y vocales; puede simular la línea telefónica PSTN en caso de avería (corte de la línea telefónica) o reemplazar
completamente a la misma en las zonas servidas por el servicio GSM y en las que la línea telefónica PSTN no está disponible.
Es capaz de comunicar eventos de alarma mediante la red GPRS, favoreciendo así una comunicación fiable y rápida con las
centrales de video vigilancia dotadas de un receptor Sur-Gard System III ó System II. Las prestaciones de este Comunicador
dependen mucho de la cobertura de la red GSM, por lo que no debería instalarse antes de haber ejecutado un ensayo de
posicionamiento de la antena para determinar el mejor lugar de recepción (al menos debe estar encendido  un LED verde).
Los Comunicadores de la serie BGSM-100 están dotados de 3 salidas, das quais 1 pode ser activada/desactivada com comando
remoto enquanto as outras 2 são usadas para sinalizações de: problema na linha telefónica PSTN; problema na rede GSM.
Los Comunicadores de la serie BGSM-120 están dotados de 3 bornes programables como:
— Salidas (programación de fábrica) que pueden activarse/desactivarse de remoto o ser utilizadas para las señalizaciones de
estado: problema en línea telefónica PSTN; problema en la red GSM; pérdida mensaje de supervisión; fallo en la comunicación.
— Líneas de entrada para la activación del Avisador Vocal y del Avisador  SMS que pueden ser empleados también para
enviar las señalizaciones de estado.
Por las características de la red GSM, este Comunicador se debe utilizar exclusivamente para sus fines previstos y NO se
puede utilizar como modem para la transmisión de fax y datos o para las operaciones de Teleasistencia.

IDENTIFICACION DE LOS COMPONENTES
Las cifras entre paréntesis cercadas [ ] en este Manual se refieren a los principales componentes de este Comunicador ilustrados en la Figura 1.

INSTALACION
 NO pasar ningún hilo por encima del circuito electrónico.
 Este Comunicador se debe instalar únicamente por PERSONAS CUALIFICADAS, en un lugar cerrado,

seguro y seco, lejos de los aparatos radiotransmisores.
 Comprobar la recepción de la Red GSM antes de instalar este Comunicador en el lugar elegido.

BGSM-100KCA, BGSM-100KEA ó BGSM-120KCA, BGSM-120KEA
 Este Comunicador se compone de una tarjeta destinada a colocarse dentro de una central antirrobo,

preferiblemente con contenedor metálico y una antena que se conecta a la tarjeta por medio de cable
coaxial. Durante el funcionamiento normal estos elementos (tarjeta, antena y cable) pueden ser una fuente
de campos electromagnéticos irradiados, por lo tanto, si en las cercanías hay dispositivos electrónicos no
suficientemente inmunes a dichos campos, pueden producirse interacciones indeseadas. Por tal motivo se
aconseja posicionar la tarjeta lo más cerca posible de dichos dispositivos electrónicos susceptibles y la
antena sobre la superficie externa del contenedor metálico o alejada del mismo utilizando el estribo
específico. Para el cable coaxial de conexión se aconseja dejar dentro del contenedor metálico de la central
el largo mínimo necesario y disponer la parte sobrante fuera del contenedor metálico.

1.  Soltar los tornillos y retirar la cubierta  de la central.
2.  Dentro de la caja metálica de la central, encontrar una  zona para recibir el circuito, incluido el cableado.
3.  Colocar los cuatro puertos plásticos adhesivos [14] sobre el fondo de la caja metálica, y luego insertar en los orificios

[7] presentes sobre el circuito electrónico, los puertos adhesivos, tal como indica la Figura 2.
4.  Montar la antena [1] en el exterior de la caja.
4a. Colocar la antena con el cable de 25 cm o la antena con el cable de 2 metros [1] sobre la caja metálica (Fig.2) de modo que

la base magnética [2] se adhiera a la superficie. Pasar el cordón de la antena por una abertura para el paso de los cables.
Para la versión BGSM-100KEA o BGSM-120KEA si es necesario, se puede utilizar el estribo metálico [13], Ver  Fig.2a.
Fijar el estribo metálico [13] utilizando los orificios [12] en un soporte adecuado. Colocar la antena con el  cable de 25
cm o la antena con el cable de 2 metros [1] sobre el estribo metálico [13] (Fig.2a), de modo que base magnética [2] se
adhiera a  la superficie. Pasar el cordón de la antena por el orificio [11] del estribo metálico [13].

5.  Conectar el cordón [3] al transmisor para antena GSM [4].
6.  Efectuar las conexiones sobre los bornes [10].
7.  Insertar la tarjeta SIM [8] en el puerto SIM [6] tal como indica la flecha, con los contactos hacia abajo (Ver Figura 1).
!!!!! El PIN de la tarjeta SIM debe desactivarse antes de ser insertado en el Comunicador.
!!!!! Se aconseja deshabilitar en la propia SIM-CARD la transferencia de llamada.
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8. Controlar durante el encendido que todos los LED verdes parpadeen, en este estado el dispositivo se encuentra en la fase de
inicialización.

9.  Controlar la intensidad de la señal:
– asegurarse que por lo menos un LED verde se encienda; todos los LED verdes encendidos indican una cobertura óptima.
– si los LED verdes están apagados, la intensidad de la señal NO es suficiente, cambiar la posición de la antena hasta
que se consiga una intensidad aceptable, por lo menos un LED verde encendido.

10.  Cerrar la cubierta de la central.
 Conectar la alimentación y los circuitos telefónicos únicamente después que el Comunicador haya sido

fijado y conectado al circuito de tierra del edificio.
!!!!!  Antes de insertar o retirar la tarjeta SIM, asegurarse que el Comunicador está fuera de tensión.

 ANT-EU Antena remota de exterior
Para el montaje de la antena remota de exterior ANT-EU, consultar las instrucciones suministradas con el producto.
La ANT-EU es útil para suministrar al Comunicador un campo GSM de mayor intensidad.

BGSM-100BA ó BGSM-120BA
Véase figura 1.
1. Marcar la posición de los orificios [19] para la fijación a la pared de la base metálica [17].
2. Realizar los orificios marcados en la pared.
3. Introducir los 4 soportes de la tarjeta [16] en los orificios de la base metálica [27].
4. Pasar los cables para las conexiones a través de la abertura en la base [22].
5. Fijar la base metálica a la pared utilizando los tacos (no en dotación).
!!!!! Tener cuidado de no dañar los cables o tuberías empotradas en la pared.
6. Situar la tarjeta electrónica sobre los soportes [16] y empujarla hacia la base hasta fijarla en su posición, como se muestra en la Figura 1.
7. Conectar el cable de la antena [3] al conector de la tarjeta electrónica [4].
8. Pasar el cable de la antena [3] por

debajo de la lengüeta sujeta cable
[26], y a través de la abertura [23].

9. Situar la antena [1] sobre el lado superior
de la base de modo que la base
magnética [2] se adhiera a la superficie.

 La antena se puede situar sobre el
lado superior de la base, en el pun-
to más adecuado para recibir la
señal GSM.

10. Si es necesario, montar el Desviador
Antisabotaje MAXIASNC [15]
(opcional) sobre los pernos como se
muestra en la Figura 1.

 La palanca del desviador debe
orientarse como se muestra en la
Figura 1, de lo contrario el disposi-
tivo no funciona de forma correcta.

11. Realizar las conexiones a la bornera [10]
como se describe en el párr.
"Conexiones" y, si es necesario, la
conexión del Desviador Antisabotaje (Para
conectar el Desviador Antisabotaje, lea el
párrafo “CONEXIONES->Conexiones
auxiliares”).

Fig. 2 -  Montaje de la tarjeta en
el interior de la central

51

96

a)
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12. Insertar la tarjeta SIM [8] en el puerto SIM [6] tal como indica la flecha, con los contactos hacia abajo (Ver Figura 1).
!!!!! El PIN de la tarjeta SIM debe desactivarse antes de ser insertado en el Comunicador.
13. Controlar durante el encendido que todos los LED verdes parpadeen,en este estado el dispositivo se encuentra en la fase de inicialización.
14. Controlar la intensidad de la señal:

– asegurarse que por lo menos  un LED verde se encienda; todos los LED verdes encendidos indican una cobertura óptima.
– si los LED verdes están apagados, la intensidad de la señal NO es suficiente; para una intensidad adecuada, por lo
menos un LED verde debe estar encendido.

15. Cerrar el Comunicador: enganchar el lado inferior de la Tapa [18] a la Base [17] presionar sobre el lado superior de la
Base para cerrar la Tapa; fijar la tapa empleando los tornillos [25].

 Conectar la alimentación y los circuitos telefónicos únicamente después que el Comunicador haya sido
fijado y conectado al circuito de tierra del edificio.

!!!!! Antes de insertar o retirar la tarjeta SIM, asegurarse que el Comunicador está fuera de tensión.

CONEXIONES
En este capítulo se describen los bornes del Comunicador y las conexiones auxiliares. En la Figura 3 se muestra un ejemplo de conexión.

N. Bornes Versiones
BGSM-100KCA, BGSM-100KEA, BGSM-100BA BGSM-120KCA, BGSM-120KEA, BGSM-120BA

1 +V

Alimentación suministrada por la central o por el alimentador externo, ADP1512 (opcional), de 10 a  27,6 Vcc
asegurarse de que esté protegido y limitado en corriente: fuente con potencia limitada (LPS) según la normativa
EN 60950-1:2006.

!  Para conectar la alimentación utilizar cables con una longitud máxima de 2 metros y de 0,75 mm² de sección.
Para cables de longitud inferior utilizar secciones adecuada.

2 M Masa: menos alimentación y borne común para las salidas Open Collector.

3 T1
Salidas Open-Collector: estas salidas se activan par los
eventos de averías sobre la línea PSTN (T1) o sobre la
red GSM (T2).

Bornes Programables, estos bornes pueden programarse
como:
– Salidas Open-Collector (programación de fábrica):
estas salidas pueden activarse desde los eventos
programados (Activación Automática), o bien mediante mando
tanto en mensaje SMS como por medio de reconocimiento de
quien llama (Activación de Remoto); leer el párrafo “Activación
de las Salidas ” para mayor información. La corriente máxima
de cada Salida OC es 100 mA.
– Líneas de entrada: estas entradas cuando reciben
Señales de Alarma pueden activar las funciones  de
Avisador SMS y de Avisador Telefónico (leer los párrafos
“Avisador SMS” y “Avisador Vocal”).

4 T2

5 T3

Salida Open-Collector programable: esta salida puede
activarse por el evento de reconocimiento del abonado.
La  corriente máxima que se puede obtener por cada
salida OC es de 100mA.

6 -
Tierra: este borne debe conectarse a la toma de tierra de la instalación eléctrica para proteger el dispositivo de las
sobretensiones sobre la línea telefónica y para satisfacer las condiciones de seguridad.

7 LE Línea telefónica externa: estos bornes se pueden conectar a la línea telefónica PSTN.8
9 LI Línea telefónica interna: estos bornes se deben conectar a  la central o a otro terminal de comunicación.10

!!!!! La corriente de los colectores abiertos (Open Collector) no puede superar 100 mA. En caso de que fuese necesario
conmutar cargas más importantes, utilice relés o nuestras fichas de relé BRM04/12 (12 Vcc) y BRM04/24 (24 Vcc).

Conexiones auxiliares
Las conexiones auxiliares no son indispensables para el funcionamiento del Comunicador, pero permiten aprovechar al
máximo la versatilidad de este dispositivo. Estas conexiones se describen en el siguiente párrafo.
Antisabotaje - La conexión del Desviador Antisabotaje MAXIASNC (opcional) permite detectar posibles intentos de
forzamiento de la tapa del Comunicador. El Desviador Antisabotaje está provisto de un cable pre-soldado y puede
conectarse de los siguientes modos:
— A la línea antisabotaje o a un zona apropiada de la central. Leer las instrucciones de la central para mayor información.
— Entre el borne [ T3 ] y [ M ] del BGSM120, de modo que al quitar la tapa del Comunicador se envíe un mensaje SMS
y/o vocal a uno o más números telefónicos. En este caso es necesario  por medio del software BGSM-120/BGSM-100
Console programar el Comunicador (ver el párrafo Programación de PC->Programación opcional Antisabotaje).
Realizadas las conexiones y la programación cerrar la tapa y conectar el Comunicador. Al finalizar la fase de inicialización
del Comunicador GSM, abrir la tapa y comprobar que el mensaje SMS y/o vocal sea enviado a los números programados.
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Fig. 3 - Ejemplo de conexión para la serie BGSM-100 y BGSM-120
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LED DE CONTROL
Hay 5 LED sobre la PCB (ver Figura 4); tres verdes (L1, L2 y L3), un LED amarillo (L4) y un LED rojo (L5), que señalan la conexión,
la transmisión, las condiciones de mal funcionamiento y, sólo para la serie BGSM-120 (ver tabla 2), el estado del Comunicador.
 Durante el arranque y la fase de programación, los LED parpadean.
ROJO — LED normalmente apagado. Señala una

condición de mal funcionamiento, parpadeante
en caso de avería. Este Comunicador controla
la presencia de ciertas averías en el orden
mostrado en la tabla de al lado. El estado de mal
funcionamiento más importante será indicado
por el número de parpadeos del LED ROJO
(L5), como se muestra en la tabla de al lado.

AMARILLO — Encendido, indica que la interfase
ha conmutado por la red GSM a causa de
anomalías sobre la línea telefónica PSTN o de
ausencia de ésta. Si parpadea lentamente,
indica llamada en curso en la red GSM (tanto
en entrada como en salida). Si está encendido
fijo junto con el LED rojo indica que se están
cargando los datos de fábrica en curso.

VERDE — Los tres LED verdes (L1, L2 y L3) señalan la intensidad de campo GSM y el estado (tabla 2), como se ve en la Figura 4:
El primer LED (L1, al lado del orificio de fijación) indica, cuando está apagado, que la Red GSM no está disponible. Si
sólo este LED está encendido, el nivel de la señal GSM es bajo pero suficiente para efectuar las llamadas vocales.
El segundo LED (L2), indica, cuando está encendido, una buena intensidad de campo GSM: este LED se enciende
únicamente cuando el primer LED verde está encendido;
El tercer LED (L3) indica, cuando está encendido, una excelente intensidad de campo GSM: se enciende únicamente
cuando el primer y el segundo LED están encendidos.

PRINCIPIOS  DE

FUNCIONAMIENTO
Este Comunicador ofrece la posibilidad de elegir un “Canal predefinido” de comunicación. Proporciona la tensión de línea y de
timbre para las llamadas entrantes y de código de la selección multifrecuencia (DTMF). La simulación de la línea telefónica PSTN
proporciona a la central antirrobo u otro terminal de comunicación, una línea de reserva en caso de avería sobre la PSTN. La
conmutación entre PSTN y GSM, y viceversa, NO tiene lugar, durante llamadas en marcha. La Prioridad de Funcionamiento
(para seleccionar durante la fase de programación) determina el modo en que este Comunicador gestiona las comunicaciones
(SMS y vocales) y las llamadas de los dispositivos telefónicos conectados a los bornes LI (por ejemplo una central antirrobo).
 Este comunicador no puede decodificar llamadas por pulsos.
 Para prevenir el uso indeseado de la línea simulada vía GSM, durante las llamadas de voz el dispositivo

genera un beep doble de señalización. El primer doble beep se genera pasados 5 minutos, los siguientes
se emiten a intervalos de 30 segundos.

Fig. 4 - LED de
control

Símbolo de nivel de señal GSM
LED de control

LED Indicadores de campo GSM

Numeración LED
(referencias ausentes en el 

circuito electrónico).
 Esta numeración ha sido 

insertada únicamente para una 
 mejor identificación deñ LED 

en el seno del documento.

1 2 3 4 5

Prioridad de
señalización Tipo de mal funcionamiento Parpadeos

LED ROJO

1 (ALTA)
Problema Firmware (firmware

incorrecto) 1

2 Problema de alimentación 2

3
Problema módulo GSM

Problema SIM durante la inicialización 3

4 Problema SIM durante el funcionamiento 4
5 Problema de recepción GSM 5
6 Problema GPRS 6
7 Receptor  no disponible 7

8 (BAJA)
Receptor de supervisión ausente

(receptor 1) 8

— Ninguna avería Apagado

Parpadeos
LED Verdes Significado de la señalización

L1 Transmisión mensaje vocal en curso.

L3
Sección Remota; parpadea hasta
salir de la sección remota GPRS.

L1+L2
Modalidad de servicio; parpadean
hasta salir del modo.

L2+L3
Mensaje SMS entrada; parpadean
durante 5 segundos.

L1+L2+L3
El Comunicador está en fase de
inicialización; parpadean hasta la
recepción de una señal GSM.

Tabla 2 - Avisos sobre el Estado del
Comunicador para la serie BGSM-120
por medio del parpadeo de los LED
Verdes (L1,L2,L3).
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Restablecimiento Programación de Fábrica
Para restablecer la programación de fábrica del Comunicador, efectuar los siguientes pasos:
1. Desconectar la alimentación del Comunicador.
2. Manteniendo en cortocircuito, por ejemplo con las pinzas, los pies 1 y 4 del conector [9] (fig. 5 de la pág. 39), restablecer la alimentación.
3. Los 5 LED (L1, L2, L3, L4 y L5) se encienden unos instantes (menos de 1 segundo).
4. Una vez que el corto es detectado por los 3 LED verdes (L1, L2, L3) se apagan mientras los LED amarillo  y rojo (L4, L5)

permanecen encendido (algunos segundos) indicando que está en curso el restablecimiento de las programaciones de fábrica.
5. Al encenderse los LED amarillo y rojo (L4, L5) quitar el cortocircuito de los pies 1 y 4 del conector [9] (fig. 5 de la pág. 39).
6. Al finalizar el procedimiento, los 3 LED verdes parpadean indicando que el Comunicador está en fase de inicialización.
 Los mensajes vocales registrados NO son borrados cuando se restablece la programación de fábrica.

Canal predefinido PSTN
Si la tensión sobre las bornes de la línea telefónica PSTN (LE) disminuye a menos de 3 Vcc declarando un tiempo
comprendido entre 10 y 3600 segundos (valor programable), los dispositivos telefónicos conectados a los bornes LI se
conmutan sobre la red GSM. Al restablecerse la línea telefónica PSTN, se conmuta de nuevo después de un tiempo
programable a la línea telefónica PSTN.
 Se puede forzar la comunicación

en el canal GSM/GPRS, incluso
cuando está presente  la Línea
Telefónica PSTN introduciendo
el prefijo “9999” delante del
número telefónico compuesto
por la Central (para mayores
aclaraciones consultar la tabla
de al lado y el párrafo “GPRS-
>Números de Teléfono a
descodificar”).

 Los números de teléfono para la
función PTM (ver "PTM->Números
de Teléfono") y aquellos a
descodificar (ver "GPRS->Números
de Teléfono a decodificar") deben introducirse SIN el prefijo "9999".

 En el caso, que por cualquier motivo, el dispositivo se encuentre en la línea simulada GSM del número
compuesto se eliminará el prefijo "9999", si está presente.

Canal predefinido GSM
Proporciona a los dispositivos conectados a los bornes LI la línea simulada si la cobertura GSM está presente. En caso de
ausencia de campo GSM, conmuta sobre la línea telefónica PSTN.

Secuencia de transmisión Contact ID sobre GPRS
El Comunicador, en caso de que los números de teléfono hayan sido insertados en la página GPRS->Telephone numbers
to decode vía el software BGSM-120/BGSM-100 Console, derige las llamadas a estos números sobre la línea GPRS.
 Cuando se produce un evento, la central antirrobo ocupa la línea telefónica.
 Se simula el tono de llamada.
 La central antirrobo marca el número de la central receptora. Asegúrese que la central antirrobo inserta una pausa de,

al menos, un segundo, o bien verifica la presencia de la tonalidad antes de componer el número.
 Este dispositivo envía la invitación a transmitir requerida en formato Contact ID.
 Después de haber recibido la invitación, la central antirrobo transmite los eventos de alarma al formato DTMF.
 El comunicador transforma los dígitos DTMF en el paquete y lo envía a la CRA mediante la red GPRS.
 El receptor reconoce el evento y envía el mando a este Comunicador que genera la correspondiente señal kiss-off (la

frecuencia de la señal kiss-off es de 1400Hz) a la central.
 Después que el Comunicador ha emitido la recepción, la central cuelga si ninguna otra alarma necesita ser enviada.

Número
compuesto de la

Central

Línea
telefónica

Número en la lista de
Números de teléfono

a decodificar

Efecto

0123456789 PSTN Ninguno
Llamada vocal en PSTN
del número 0123456789.

99990123456789 PSTN 0123456789
Comunicación Contact
ID en GPRS.

99990123456789 PSTN Ninguno
Llamada Vocal y/o
Contact ID en GSM del
número 0123456789.

99990123456789
Simulada

GSM
0123456789

Comunicación Contact
ID en GPRS.

99990123456789
Simulada

GSM
Ninguno

Llamada Vocal y/o
Contact ID en GSM del
número 0123456789.
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Avisador SMS (sólo para la serie BGSM-120)
En las modalidades de funcionamiento como Avisador SMS se llaman uno o más números telefónicos (los primeros 8 números de
la agenda) a los que se envían los Mensajes SMS programados con anterioridad a los siguientes eventos, (ver la tabla siguiente):

N otnevenóicpircseD
sodamargorponoféletedsoremúN
)adnegaaledsoremún8soremirp( SMSejasneM

1 2 3 4 5 6 7 8
1 1adartnEnóicavitcA         SMSanedaC*
2 1adartnEotneimicelbatseR         SMSanedaC*
3 2adartnEnóicavitcA         SMSanedaC*
4 2adartnEotneimicelbatseR         SMSanedaC*
5 3adartnEnóicavitcA         SMSanedaC*
6 3adartnEotneimicelbatseR         SMSanedaC*
7 NTSPaeníLamelborP         SMSanedaC*
8 NTSPaeníLotneimicelbatseR         SMSanedaC*
9 nóicatnemilaednóisnetamelborP         SMSanedaC*

01 ednóisnetotneimicelbatseR
nóicatnemila         SMSanedaC*

11 ocidóirePSMS         SMSanedaC*
 leneodatilibahseDotnevE oremún onoféleted
 odatilibaHotnevE onoféletedoremúnlene
* seretcarac001edamixámdutignolanurenetedeupSMSledanedacaL

 Señales de Alarma que pudiesen presentarse en una o más de las 3 líneas de entrada Programables. Tener presente que para cada
una de las 3 líneas de entrada del dispositivo se pueden programar  2 Mensajes SMS: el de Activación y el de Restablecimiento.

 Test Línea PSTN. Es posible programar 2 SMS: el de Falta de Línea PSTN y el de Restablecimiento.
 Test tensión de Alimentación Es posible programar 2 SMS: Uno que señala problemas en la tensión de Alimentación y

uno de Restablecimiento.
 Envío SMS Periódico con un período programable de 1 hora a 1 año.
 El envío de un Mensaje SMS se produce cuando se presenta uno de los eventos apenas descriptos para el

cual se ha programado un mensaje SMS y por lo menos un número telefónico.

Avisador Vocal (sólo para la serie BGSM-120)
En la modalidad de funcionamiento como Avisador Vocal se llaman uno o más números de teléfono (los primeros 8 números de teléfono
de la agenda) a los cuales enviar un mensaje vocal grabado. Se pueden grabar hasta 8 mensajes de una duración máxima de 16
segundos cada uno. Cada mensaje se graba en las memorias en estado sólido, eliminando de este modo todos los problemas
relacionados con el uso de la cinta magnética tales como: Deterioro de la calidad del mensaje con el paso del tiempo; bloqueo de la
mecánica después de períodos prolongados de inactividad, etc. Los mensajes se asocian a los siguientes eventos (ver tabla siguiente):

N Descripción evento
Números de teléfono programados
(primeros 8 números de la agenda) Men. #1 Men. #2 Men. #3
1 2 3 4 5 6 7 8

1  Activación Entrada 1        

2 Restablecimiento Entrada 1        
Mensaje
vocal 1

Mensaje
vocal 2

3 Activación Entrada 2        

4 Restablecimiento Entrada 2        
Mensaje
vocal 2

5 Activación Entrada 3        

6 Restablecimiento Entrada 3        

7 Problema Línea PSTN        

8 Restablecimiento Línea PSTN        

9 Problema tensión de alimentación        

10 Restablecimiento tensión de
alimentación        

11 Llamada Periódica        
  Evento Deshabilitado en el número de teléfono
  Evento habilitado en el número de teléfono
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  Señales de Alarma que pudiesen presentarse en una más de las 3 líneas de entrada Programables. Tener presente que para cada
una de las 3 líneas de entrada del dispositivo se pueden grabar 2 Mensajes Vocales: el de Activación y el de Restablecimiento.

 Test Línea PSTN. Es posible grabar 2 Mensajes Vocales: el de Falta de Línea PSTN y el de Restablecimiento.
 Test tensión de Alimentación. Es posible programar 2 Mensajes Vocales: Uno que señala problemas en la tensión de

Alimentación y uno de Restablecimiento.
 Envío Mensaje Vocal Periódico con un período programable de 1 hora a 1 año.
La llamada vocal se produce cuando se presenta un evento en un canal para el cual se haya programado un mensaje vocal
con por lo menos un número de teléfono.
En dicho caso el comunicador ejecuta las fases descriptas a continuación:
1. El comunicador selecciona el número de teléfono y envía la llamada a la línea telefónica GSM.
2. El Comunicador comprueba que el número no esté ocupado o que no haya problemas en la red GSM para que se pueda

continuar con la siguiente fase, de lo contrario finaliza la llamada y se vuelve a intentar de nuevo desde la Fase 1 un máximo
de 8 veces (según el valor programado) superado el cual el ciclo de llamadas se considera finalizado. Si el Canal de Alarma
ha sido programado para llamar varios números telefónicos, éstos serán llamados en secuencia. De este modo se evita, por
ejemplo, la posibilidad de llamar varias veces o en el arco de pocos segundos, un número ocupado.

3. El comunicador espera hasta 60 segundos la respuesta del número llamado. En caso de resultado positivo, se pasa a
la Fase 4, de lo contrario se termina la llamada y se vuelve a intentar la Fase 1 un máximo de 8 veces (según el valor
programado) pasadas las cuales el ciclo de llamadas se considera finalizado.

4. El Comunicador reproduce el mensaje relativo al canal que ha entrado en alarma, la llamada se considera terminada sólo
después de la recepción del mensaje o bien después de presionar el botón   (si antes se ha programado la Call
Confirmation, ver el párrafo  Voice Dialer->Call Confirmation) en el teléfono que ha recibido el mensaje. Si en el momento
de la selección se han producido varios eventos que generan el envío de varios mensajes al mismo número de teléfono, dichos
mensajes son reproducidos (cada uno siempre por un máximo de 8 veces, según el valor programado) en secuencia durante
la misma llamada evitando llamar varias veces al mismo número. Al finalizar el ciclo de llamadas, la línea que ha generado la
activación del Comunicador está aún en alarma, el procedimiento apenas descripto no será realizado de nuevo. Es necesario
que la línea que ha generado un ciclo de llamada vuelva a reposo antes que activar uno nuevo.

Gestión de Prioridades (sólo para la serie BGSM-120)
El Comunicador es capaz de transmitir los eventos de alarma y los mensajes  (SMS o vocales), algunas prioridades se
pueden programar mediante el software BGSM-120/BGSM-100 Console (ver la parte relativa a la programación mediante
el software BGSM-120/BGSM-100 Console), a continuación se representa la tabla de gestión de prioridades con las
programaciones del fabricante.

sedadiroirpednóitsegedalbaT
dadiroirP

otnevE otnevenóicpircseD nóicamargorP
acirbáFed

elbamargorP
erawtfosedsed

)ATLA(1 )ehcnagnesed(ILaeníLodideP  iS

2 )selacovsejasnem(lacoVrodasivA  iS

)AJAB(3* SRPGnóisivrepuS  oN

erawtfosleedsedramargorpedeupesonyojabsámleseSRPGnóisivrepuSedotnevelE*

Prioridad a la Línea Telefónica Simulada
Cuando el dispositivo conectado a los bornes LI pide línea, cualquier posible llamada efectuada en ese momento en la
modalidad Avisador Vocal se finaliza. Se realizan así las llamadas requeridas por el dispositivo conectado a los bornes LI
(por ejemplo, una central antirrobo). Cuando el dispositivo conectado a los bornes LI deja la línea, el Avisador Vocale,
vuelve a realizar las llamadas suspendidas y comienza a enviar los mensajes vocales.

Prioridad Avisador SMS
Si el aparato conectado a los bornes LI está realizando una llamada en GSM mediante este Comunicador y si es necesario
realizar una acción desde el Avisador SMS, la llamada de interfaz no se terminará y el mensaje será enviado.

Prioridad  de los Eventos del Avisador
Los SMS tienen una prioridad inferior a los mensajes de Voz, pero no pueden ser interrumpidos mientras se están
transmitiendo. En este caso, la cola de los mensajes de Voz será enviada al final del envío del mensaje SMS.
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Control crédito residual (sólo para la serie BGSM-120)
Si se programa mediante el software BGSM-120/BGSM-100 Console (ver la página Options->Pay As You Go), se puede
controlar el crédito residual en la SIM CARD de prepago. Al habilitar el control del crédito residual, se envía periódicamente
al primer número en agenda un SMS con información suministrada por el operador respecto al crédito residual. Para
todos los operadores que ofrecen el servicio de solicitud de crédito residual mediante mando de red, es posible introducir la
cadena de interrogación mediante el software BGSM-120/BGSM-100 Console.
 A discreción de cada operador Red GSM, el servicio de gestión del crédito de las SIM CARD de prepago puede suspenderse.

(PTM) control de las comunicaciones con la central
El control constante de las comunicaciones con la Central (función PTM) permite al comunicador enviar las llamadas
mediante red GSM en el caso que la comunicación entre la central de alarma y la central de vigilancia no se produzca de
forma adecuada en la línea telefónica PSTN. Si está programada (mediante el software BGSM-120/BGSM-100 Console
página PTM), esta característica resulta operativa sólo cuando la línea PSTN se conecta a los bornes LE presentes.
La función PTM incluye las siguientes modalidades de transmisión de la alarma al Comunicador:
1. Alarma GPRS (comunicaciones IP receptor).
2. Alarma en GSM (modalidad voz).
 El evento fallo PSTN se presenta cuando está activada la función PTM.

ACTIVACIÓN DE LAS SALIDAS
La serie BGSM-100 tiene 3 Salidas de tipo Open Collector (los bornes T1, T2 y T3). La serie BGSM-120 tiene 3 bornes ( T1, T2 y T3) que
pueden programarse como Entradas y/o Salidas:  estos bornes se programan de fábrica como Salidas. Las Salidas Open Collector
pueden activarse de modo automático (al presentarse ciertos eventos  pre-programados) o de remoto, por medio del envío de un SMS
(envío SMS sólo para la serie BGSM-120) o Reconocimiento del número que llama desde un número programado previamente.

Activación y desactivación de las salidas Automáticas
Les salidas Open Collector T1, T2 y T3 de este dispositivo pueden activarse de modo automático par los eventos siguientes:
 Ausencia de /Problema con la línea PSTN (T1, para la serie BGSM-100).
 Problema en red GSM (T2, para la serie BGSM-100).
 Falta el mensaje de supervisión (sólo para la serie BGSM-120).
 Fallo en la comunicación de un evento interno (FTC) (sólo para la serie BGSM-120).
 Una Salida OC activada en automático, vuelve a reposo cuando se eliminan las causas que han provocado

la activación, excepto el fallo de la comunicación por  un evento interno (FTC), en este caso vuelve a reposo
después de un tiempo programado (Monostable Time).

Activación y desactivación de las salidas distantes
 ATENCIÓN: Debe estar presente la conexión GSM antes que las salidas puedan activarse/desactivarse desde remoto.
 Se aconseja programar el dispositivo con la Black List activada (Options->Dial Options) y White List

desactivada (Phonebook->White list) para aquellos números que se desea utilizar para esta función.
 El número empleado para la activación de las salidas por medio del Reconocimiento del número que llama debe ser visible.

BGSM-100
Las salidas Open Collector T1 y T2 son Biestables mientras que la salida T3 es Monoestable (Una vez se ha activado
una salida monosestable no se desactivara hasta que expire el tiempo establecido, “ON TIME”).

BGSM-120
Las Salidas Open Collector pueden programarse como Bisestables (la activación y la desactivación de produce mediante 2
mandos diferentes) o bien como Monoestables (la Salida permanece activa todo el “ON TIME”, transcurrido el cual vuelve a
reposo, o bien, hasta cuando no se desactive por medio de SMS). Además, cada salida puede programarse para suministrar una
señal de confirmación (un SMS programado antes si la activación/desactivación de la salida es realizada mediante SMS, o bien
un timbre de confirmación si la activación/desactivación se realiza mediante el reconocimiento de quien llama).
 Para mayor información respecto a los términos “Cadena de control” y “Código Usuario” utilizados en los siguientes

párrafos, tomar como referencia el párrafo “I/O” y “Options->Codes” del capítulo “PROGRAMACIÓN VÍA PC”.
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Salidas Biestables (sólo BGSM-120)
Las Salidas Open Collector programadas como Biestables pueden activarse de 2 modos:
1. Enviando un SMS formado por el Código usuario incluido entre los caracteres #, de la Cadena de Control (al

comienzo de la Cadena de Control no debe haber espacios vacíos) y los caracteres “=ON#” según la siguiente sintaxis:

#Código Usuario#Cadena=ON#   (ejemplo: #9876#LUZCASA=ON#)

2. Mediante el reconocimiento de quien llama: En este caso la salida se activa a “costo cero” ya que el dispositivo,
después de reconocer a quien llama, rechaza la llamada y activa la salida.

 La desactivación de una salida OC de tipo Biestable puede realizarse SÓLO enviando un mensaje SMS
formado por el Código Usuario encerrado entre los caracteres #, de la Cadena de control y por lo caracteres
“=OFF#” según la siguiente sintaxis:

#Código Usuario#Cadena=OFF#   (ejemplo: #9876#LUZCASA=OFF#)

 El Código Usuario programado de fábrica es ‘0001’ para reemplazarlo ver el párrafo “Programación por SMS-
>Modificación del Código Usuario”.

Salidas Monoestables
Las Salidas OC programadas como Monoestables pueden activarse de 2 modos por medio del Reconocimiento del
número que llama y mediante SMS (sólo BGSM-120).

SMS (sólo BGSM-120)
Enviar un SMS compuesto por el Código Usuario entre los caracteres #, de la Cadena de Control (al comienzo de la Cadena
de Control no debe haber espacios vacíos) y los caracteres “=ON#”, “=ON#TonU#” o bien “=OFF#” según la siguiente sintaxis:

#Código Usuario#Cadena=ON#
#Código Usuario#Cadena=ON#TonU#

#Código Usuario#Cadena=OFF#

El parámetro “=ON#TonU#” permite programar el tiempo en activo (“ON TIME”) de 1 segundo a 86400 segundos, con pasos de
1 segundo.  El tiempo en activo (“ON TIME”) se puede programar también con el software de programación del Comunicador. La
sintaxis “Ton” representa el valor y “U” la unidad expresada en H (horas) M (minutos) y S (segundos), ver ejemplos siguientes:

SMS Modo de funcionamiento de las
salidas

#9876#LUZCASA=ON# Activación Biestable
#9876#LUZCASA=ON#3600S# Activa por 3600 segundos
#9876#LUZCASA=ON#50M# Activa por 50 minutos

#9876#LUZCASA=ON#3600#
Activa como desde programación

software, el Tiempo en activo
programado no es válido

 Para activar la salida mediante SMS respetando la programación quitar el parámetro “TonU” dejando los
caracteres “##”.

(ejemplo: #9876#LUZCASA=ON##)

Reconocimiento de quien llama
Mediante el reconocimiento de quien llama: En este caso la salida se activa a “costo cero” ya que el dispositivo,
después de reconocer a quien llama, rechaza la llamada y activa la salida.
 Las salidas Monostables se desactivan de forma automática al final de tiempo programado.
 Sólo la Salida T3 del BGSM-100 puede activarse mediante el Reconocimiento del Número que llama.
El tiempo en activo (“ON TIME”)  se puede regular desde un segundo a 86.400 segundos, con intervalos de un segundo.
 El Código Usuario programado de fábrica es ‘0001’; para reemplazarlo ver el párrafo “Programación por SMS-

>Modificación del Código Usuario”.
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PROGRAMACIÓN POR SMS (para la serie BGSM-120)
Además de aquellas descriptas en el párrafo Activación y Desactivación de las Salidas distantes, se pueden realizar
otras operaciones desde remoto enviando los debidos mensajes SMS.

Modificación del Código Usuario
El Código Usuario programado de fábrica es ‘0001’ para cambiarlo enviar un mensaje SMS formado por los caracteres “#CUC”
seguidos por el viejo Código Usuario y por el nuevo Código Usuario encerrados entre los caracteres * según la siguiente sintaxis:

#CUC*Código Usuario*Nuevo Código Usuario*

Recibirá un SMS de confirmación si el Código Usuario ha sido cambiado.
 Para la composición del Código Usuario pueden emplearse sólo los números de 0 a 9 (como máximo 4 cifras).

Habilitar o deshabilitar la programación remota
La programación remota permite utilizar mediante la red, las funciones ofrecidas por la aplicación BGSM-120/BGSM-100
Series Console.  Para gestionar en remoto los parámetros del Comunicador es necesario habilitar la programación remota,
esto se puede hacer mediante el software BGSM-120/BGSM-100 Console (consultar el párrafo PROGRAMACIÓN VÍA PC-
>GPRS->Web Service), o bien enviando un mensaje SMS formado por los caracteres “#UWS” seguidos por el Código
Usuario y por “ON” encerrados entre los caracteres * según la siguientes sintaxis:

#UWS*Código Usuario*ON*

Por el contrario, para deshabilitar la programación remota enviar el siguiente mensaje SMS:
#UWS*Código Usuario*OFF*

Un SMS confirmará si el mando ha sido ejecutado con éxito.

Modificación del Código Instalador
El  Código Instalador (con un máximo de 4 caracteres numéricos) se emplea en caso de necesidad para el acceso a la conexión
interfaz Remote Programming (consultar el párrafo PROGRAMACIÓN VÍA PC->Codes->Installer Code). El Código Instalador
programado de fábrica es ‘0002’, para cambiarlo enviar un mensaje SMS formado por los caracteres “#CIC” seguidos por el viejo
Código Instalador y por el nuevo Código Instalador encerrados entre los caracteres * según la siguiente sintaxis:

#CIC*Código Instalador*Nuevo Código Instalador*

Recibirá un SMS de confirmación si el Código Instalador ha sido cambiado.
 En la composición del Código Instalador pueden utilizarse sólo los números de 0 a 9 (como máximo 4 cifras).

Control del crédito residual
Para conocer el crédito residual por medio de un mensaje SMS se puede proceder utilizando el software BGSM-120/BGSM-
100 Console (consultar el párrafo PROGRAMACIÓN VÍA PC->Options->Pay As You Go), o bien desde remoto enviando
un mensaje SMS formado por los caracteres "#CCC" seguidos por el carácter * con la siguiente sintaxis:

#CCC*

 El crédito residual de SMS será enviado al Número de Teléfono #1 de la agenda telefónica.
A discreción de cada operador Red GSM, el servicio de gestión del crédito de las SIM CARD de prepago puede suspenderse.

PROGRAMACIÓN VÍA PC
 Para el buen funcionamiento de este Comunicador, utilizar una tarjeta SIM de 32 Kb ó más.
Esta programación vía PC necesita el cable PC-Link (no suministrado), conectado entre el Conector [9] del Comunicador
y un puerto COM del PC (Ver Fig. 5) y la aplicación BGSM-120/BGSM-100 Console. Para la conexión es posible utilizar
el cable PC-Link representado en la figura 5a, o bien el cable PC-Link representado en la figura 5b. Tener cuidado con el
sentido de inserción del conector del cable PC-Link usado. Una vez efectuada la conexión, seleccione el puerto COM
utilizado mediante el campo situado en el menu Options->Serial ports. Si existe un problema de comunicación controlar
la conexión y las programaciones de la puerta serial o bien utilizar un convertidor USB-serial diferente.
 Para instalar y ejecutar la aplicación BGSM-120/BGSM-100 Console, es necesario disponer de los derechos

de Administrador del PC; le recomendamos verificar las opciones del firewall si se presentan problemas
durante la instalación de la aplicación.
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Leer la programación
Para leer la programación del Comunicador y ponerla en el PC, seleccione el icono Upload from board .

Enviar la programación
Una vez efectuada la programación para un nuevo cliente (o bien, cuando se ha modificado un archivo cargado desde el comunicador
y que ya contenía datos),hay que enviar la programación al Comunicador utilizando el icono Download to board .

Operaciones preliminares
La ventana principal se visualiza en la ejecución de la aplicación; arriba a la izquierda de ésta, aparecen dos secciones
seleccionando por un clic el campo Untitled #1.
 En la sección de los parámetros generales encontrará usted las siguientes aplicaciones:

Parámetros de dispositivo: en esta sección es posible programar la serie del Comunicador (BGSM-100 o BGSM-120),
además de buscar y actualizar la configuración referida a un cliente con el siguiente procedimiento:
1. Hacer clic con el lado izquierdo del ratón sobre la aplicación.
2. Insertar o poner al día los datos relativos a un cliente y a  la instalación. Confirmar con el mando .
Upload from board: seleccionando este icono, se cargarán los datos programados en la tarjeta sobre el PC.
Download to board: seleccionando este icono se enviarán los datos programados a la tarjeta. El envío de toda la
programación o de las páginas GPRS, I/O (sólo para BGSM-120) y Options (solo per BGSM-100) al dispositivo
volverá a poner funcionamiento el Comunicador.
Factory defaults: seleccionando este icono se ejecuta el restablecimiento de la programación de fábrica. Tener en
cuenta que el restablecimiento de la programación de fábrica no borra los mensajes vocales registrados.
Board reset: la selección de este icono provoca el reinicio del Comunicador.

 Dentro de la sección común con la serie BGSM-100 y BGSM-120 se encuentran las siguientes aplicaciones.

Phonebook: lista de contactos telefónicos.

Options: página de las opciones.

GPRS: página de los parámetros GPRS.

Status: página para el control del Comunicador.

PTM:  página para programar las características de la función PTM.

Fig. 5 - Esquema del cordón de conexión PC-Link
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Sentido de inserción del conector 
del cable PC-Link usado.
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Las siguientes páginas se encuentran disponibles sólo para el Comunicador serie BGSM-120.

I/O: en esta página se programan los parámetros para las salidas/entradas del Comunicador.

Voice Dialer: página donde se programan todos los parámetros relativos al avisador vocal.

SMS Dialer: en esta página se programan todas las opciones del avisador SMS.

Voice Message: página para la gestión de los mensajes vocales.
Si desea usted iniciar la programación para un nuevo cliente, seleccione el campo en el menú File->New.
Para mostrar la lista de los clientes registrados en el archivo, seleccionar el campo dans del menú File->Open. En esta
sección es posible eliminar o recuperar la configuración relativa a un cliente con el siguiente procedimiento:
1. Hacer clic con el lado derecho del ratón sobre el nombre deseado.

2. Seleccionar Load  para cargar los datos del archivo desde el disco duro o bien Delete selected customer  para
eliminar definitivamente el cliente y todos sus datos del archivo.
Para cargar un cliente, es posible igualmente hacer un doble clic sobre su nombre.
Puede usted igualmente clasificar la lista por orden alfabético o por códigos con un clic sobre el título de la columna correspondiente.

Todos los parámetros a  programar se recogen en las páginas siguientes. La página (Status) sirve para el control y la
gestión del Comunicador. En este capítulo se escriben con detalle las páginas presentes en la aplicación.

Phonebook
Puede usted memorizar hasta cien números de teléfono en esta página.
 El crédito residual de la prepagada es enviado, por medio de SMS, al número telefónico #1.
 Description: insertar una secuencia alfanumérica de 16 caracteres, como máximo.
 Telephone number: Insertar un número telefónico precedido por el prefijo internacional en formato "+xxx" (ejemplo: +33

para España). Se admiten 16 cifras (el carácter "+" cuenta como  una cifra).
 Activates Output: seleccionar los números telefónicos que pueden activar las Salidas T1 (OC1), T2 (OC2) y T3 (OC3)

cuando el comunicador recibe la llamada de éstos. Esta función no depende de las opciones de White List o Black List
(página Options->Dial Options). Para activar la salida, es necesario que se habilite el servicio de identificación del
número que llama (Calling Line IDentifier).

 Para la serie BGSM-100 se puede activar sólo la Salida T3 (OC3).
 Para la activación de la salida, en la serie BGSM-120, programar los terminales T1 (OC1), T2 (OC2) y T3 (OC3)

como “Output” y habilitar “Reserved Output” (ver las páginas I/O->Type y I/O->Reserved Output).
   Ouput Activation Confirmation: esta opción se encuentra disponible sólo para la serie BGSM-120, habilitar esta

casilla para recibir el timbre de confirmación de activación de la salida.
 ATENCIÓN:

– El timbre es recibido pasado 1 minuto de la activación de la salida.
– Si el Comunicador está ocupado en una operación (por ejemplo: el canal GSM está ocupado en una
comunicación vocal), el timbre de confirmación no suena.
– La opción “Ouput Activation Confirmation” elimina la llamada entrante después de casi 5 segundos
incluso si la opción “Black List” no está habilitada.

 White List: habilitar o deshabilitar  la casilla White List permite al Comunicador aceptar o rechazar las llamadas
en entrada.  El Comunicador acepta las llamadas en entrada enviándolas a los dispositivos telefónicos conectados a
los bornes LI (por ejemplo una central antirrobo); esto es posible si LI está en funcionamiento como línea simulada vía
GSM. El modo de funcionamiento de la opción White List está vinculado a la selección  o no  de la casilla Black
List, presente en la página Options->Dial Options, come se presenta en la siguiente tabla:

tsiLetihW tsiLkcalB otneimanoicnufedodoM
  oremúnreiuqlaucedsedadartneedsadamallatpecA
  etnartneadamallreiuqlaucazahceR

 
alnocsoremúnsoledsedolóssetnartnesadamallatpecA
sadamallsalazahcer,adatilibahtsiLetihWnóicpo

soremúnsortosoledsetneinevorp
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Options
Esta página se utiliza para establecer las opciones relativas a la tarjeta.

Dial options
Esta parte concierne a la inserción de ciertas características relativas a los números de teléfono utilizados.
 Prefix: el número insertado en este caso se coloca delante de todos los números de teléfono llamados por el Comunicador

en modalidad Interfase GSM. Marcar el prefijo deseado (de 1 a  8 cifras) o bien dejar el espacio vacío si no es utilizado.
 Digits to Remove: si este Comunicador está conectado como aval a una centralita, los números de teléfono

(programados en la central) deben estar precedidos por la extensión de llamada externa (generalmente una cifra). Como
dicha extensión no es necesaria cuando las llamadas se envían por la red GSM, hay que eliminar del número de
teléfono la cifra/s correspondiente/s a esa extensión. Digitar el número de dígitos que componen la extensión (por ej: si
el número a marcar para salida externa por centralita es “01”, anote 2 en el campo Digits to Remove).

 El número de teléfono debe tener por lo menos dos cifras más con respecto al número introducido en el
campo “Digits to Remove”, de lo contrario se produce el tono de ocupado, por ejemplo:
— El número de teléfono digitado es 0123, el número de cifras a suprimir es 2 = correcto, el número
compuesto residual es 23.
— El número de teléfono digitado es 123, el número de cifras a suprimir es 2 = tono de ocupado, el número
compuesto residual es 3.

  Enable Black List: seleccionar esta casilla para autorizar la recepción de llamadas provenientes sólo de los números
de teléfono antes seleccionados por medio de la casilla White List  (página Phonebook->White List).

 Con la función “Black List” se elimina la llamada de forma inmediata.
 La función “Black List” COMBINADA con la función “Activates Output” en reconocimiento de quien llama

provoca la eliminación de la llamada retrasada durante algunos segundos;
El timbre de confirmación asociado a la función “Activates Output” en reconocimiento de quien llama
produce la eliminación de la llamada retrasada durante algunos segundos;
Si la llamada es eliminada inmediatamente la acción de activación salida no ha tenido éxito.

Event priority (sólo para la serie BGSM-120)
En esta página se pueden programar algunas de las prioridades del comunicador para la transmisión de los eventos de
alarma (ver el párrafo Gestión de Prioridades).
 Off-Hook: en esta casilla se puede definir la prioridad de los dispositivos telefónicos conectados a los bornes LI (por

ejemplo una central antirrobo). Se habilita de fábrica , para deshabilitarla se elimina el signo de marcado en .
 Voice Dialer: en esta casilla es posible definir la prioridad del Avisador vocal (mensajes vocales). Está deshabilitada

de fábrica , para habilitarla marcar .

Codes (sólo para la serie BGSM-120)
 User Code: en esta casilla se debe digitar el código usuario (al máximo 4 caracteres numéricos) para la activación de

remoto de las salidas. Para mayor información consultar el párrafo “Activación de las Salidas->Activación y
Desactivación de las salidas distantes”. De fábrica el código programado es ‘0001’.

 Installer Code: en este campo es posible digitar el código instalador (con un máximo de 4 caracteres numéricos). Este código
permite, en caso de necesidad, entrar en la conexión interfaz Remote Programming. De fábrica el código programado es ‘0002’.

Generic
En ests sección, puede usted  regular los niveles de audio del altavoz y del micrófono del Comunicador GSM.
  Speaker volume: el volumen del altavoz se regula desplazando el cursor.
   Microphone volume: el volumen del micrófono se regula desplazando el cursor.
 Un volumen elevado del micrófono podría distorsionar los tonos DTFM, volviéndolos irreconocibles a los

dispositivos conectados a los bornes LI.
  Tones...: seleccionar el nombre del país de instalación del Comunicador: el país seleccionado establece una serie de

parámetros para el funcionamiento correcto de la línea de teléfono simulada.
  LE failure timeout: introducir el tiempo en segundos (de 10 a 3600 segundos) para Line down en los bornes LE,

antes que se presente el evento PSTN Fault.
 En presencia de dispositivos telefónicos conectados a los bornes LI, el tiempo puede aumentar hasta aprox.

unos 60 segundos, como máximo.
 LE restore timeout: introducir el tiempo en segundos (de 30 a 3600 segundos) para el cual la línea telefónica debe estar

presentes en los bornes LE, antes que se restablezca el evento PSTN Fault.
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System (sólo para la serie BGSM-120)
Esta parte se refiere al Sistema.
 SIM Phone Number: introducir el número de teléfono de la SIM CARD del Comunicador (máximo 16 cifras).
 Auto Clock Adjusting: seleccionando esta casilla, el dispositivo actualizará la fecha y la hora del sistema enviándose

automáticamente un SMS.
 SMS Service Center Address: esta es una opción sólo de lectura. Muestra el número del centro de servicios SMS en la SIM CARD.

Pay As You Go (sólo para la serie BGSM-120)
 A discreción de cada operador de Red GSM, el servicio de gestión del crédito de las SIM CARD de prepago

puede suspenderse.
Por medio de esta sección es posible enviar periódicamente al primer número de la agenda un SMS con la información
suministrada por el operador relativa al crédito residual. Programar las siguientes opciones para una solicitud correcta del
crédito residual en función del tipo de operador en uso:
 Enquiry Type: elección del tipo de solicitud (SMS, Call, Service Command).
 Enquiry Number: número de teléfono a llamar o al cual enviar un SMS para solicitar información del crédito residual.
 Balance Message: cadena empleada tanto para el uso de un SMS como para solicitudes mediante mando de red (Service Command).

Ejemplo para operadores italianos
Opciones Vodafone Wind TIM

Enquiry Type Call Service Command SMS
Enquiry Number 404 40916
Balance Message *123# PRE CRE SIN

 Interval: digitar en esta casilla el intervalo (HH-DD) dentro del cual enviar un SMS Periódico con la información sobre
el crédito residual (si es gestionado por el operador telefónico). El intervalo se compone de los siguientes valores:
— (HH) hora próximo envío - Seleccionar el valor para el envío del siguiente SMS Periódico. El intervalo de los valores
admisibles va de 0 a 23.
— (DD) día próximo envío - Seleccionar el valor para el envío del siguiente SMS Periódico. El intervalo de los valores
admisibles va de 0 a 365.

Outputs (sólo para la serie BGSM-100)
En esta sección son regulables las modalidades de funcionamiento de las salidas.
 Output 1, Output 2, Output 3: seleccionar el caso para el funcionamiento de la salida “normalmente cerrada” o

“normalmente abierta”.
 Output 3 ON Time: puede usted insertar en este campo el tiempo ON en segundos (de 0 a 86.400 segundos).

Primary Path
El usuario puede programar la línea primaria de comunicación.
 Primary Path: seleccionar en este campo la línea primaria GSM ó PSTN.

GPRS
Esta página hace referencia a las opciones de configuración del GPRS.
 Considerados los posibles retrasos de transmisión en GPRS, que dependen de las actividades del administrador de

la red, se aconseja programar un número de intentos de llamada en la central antirrobo lo más alto posible y prever,
eventualmente, un número de teléfono de backup que transmita las alarmas mediante GSM además de GPRS.

Access Point Name 1 y Access Point Name 2
Esta información debe generalmente requerirse al operador que proporciona el servicio GPRS. Insertar en este caso el nombre del  proveedor
de servicio que proporciona  la dirección IP. El Access Point Name 2 está considerado como un parámetro de respaldo (backup).
  ATENCIÓN: introducir el correcto APN para servicios WAP/GPRS de lo contrario algunas funciones podrían

verse limitadas (para mayor información consultar con el operador del  centro servicios).

Main Receiver, Local Port 1 y Alarm Port 1 IP address
Insertar en este caso la dirección IP del receptor y el número del puerto. Para los receptores SYSTEM III y SYSTEM II,
insertar la dirección IP y el puerto presentes en la sección Alarm Port.
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Backup Receiver, Local Port 2 y Alarm Port 2 IP address
Este caso concierne a la inserción de la segunda dirección IP del receptor y del número del  puerto, para diferenciar con el
estatuto de los parámetros, que son considerados como receptores de respaldo (backup). El Comunicador reconoce esta
casilla sólo en el caso que se introduzcan los parámetros relativos a Main Receiver, Local Port 1 y Alarm Port 1. Por otro
lado las casillas Enable supervision y Supervision Time se refieren solamente al receptor primario (Main Receiver).

APN1 Username y Password, APN2 Username y Password
Para ciertos operadores es necesario insertar la autentificación de la comunicación. Usted debe, por tanto, insertar en estos campos
el nombre de usuario y la contraseña relativa. El APN2 Username y la Password se consideran como datos de respaldo (backup).

Telephone numbers to decode
Este comunicador permite comunicar los eventos en el formato ID Contact, vía red GPRS, también para los paneles de control que no
utilizan este método de comunicación. Para hacer esto, debe fijar un número de teléfono (los números telefónicos pueden ser "virtuales"
o "reales") en el panel de control para la comunicación del evento en el formato ID Contact (Ej.: puede fijar 0123), luego debe entrar el
mismo número de teléfono en uno de estos campos (se pueden fijar hasta cuatro Números de Teléfonos para esta función). Cuando
el Comunicador reconoce una llamada de unos de estos números, automáticamente tras codifica el evento a un formato digital y lo
reenvía a la red GPRS para programar el receptor (consultar las opciones del “Main Receiver” y el “Backup Receiver”).
 El número de teléfono debe tener por lo menos 2 dígitos.

Las opciones “Prefix” y “Digits to Remove” no tienen efecto en los “Telephone numbers to decode”.
Los “Telephone numbers to decode” deben coincidir exactamente con los números de teléfonos fijados en
el panel de control.
Deje este campo vacío si no utiliza esta función.
Para el  funcionamiento correcto de esta función se deben programar las opciones del "Main Receiver" y eventualmente
del "Backup Receiver".

DNIS
Insertar el código de identificación unívoco (si se solicita).

Account code
En esta casilla se debe digitar el Código de identificación para la comunicación con los receptores SYSTEM III o SYSTEM II.

Enable Supervision
Para habilitar la supervisión seleccionar esta casilla. La opción supervisión se encuentra disponible SÓLO para el receptor primario
(Main Receiver). Los mensajes de supervisión no son enviados durante las llamadas vocales (en GSM).

Supervision time (sec)
Regular los tiempos de supervisión.Es posible regular un tiempo de supervisión de 5 segundos a 65535 segundos,con
intervalos de 1 segundo.

Programación remota (sólo para la serie BGSM-120)
Esta conexión interfaz  permite utilizar pro medio de la red, las funciones ofrecidas por la aplicación BGSM-120/BGSM-100
Console. Mediante esta interfaz se pueden gestionar desde remoto los parámetros del Comunicador Para utilizar esta función
conectarse a la dirección http://www.bentelreachme.com.
 Enabled: para habilitar la programación remota  hacer clic en esta casilla seleccionándola (de fábrica esta programación

ya está habilitada).
 Encryption key: es posible programar la clave criptográfica para que la programación remota esté protegido de

entradas no autorizadas. La clave criptográfica puede componerse de 1 a 32 caracteres hexadecimales. La valor
programado de fábrica es 0 (la clave criptográfica no se utiliza).

Status
Esta página permite controlar el tiempo real de todas las funciones del Comunicador.
 ATENCIÓN - Esta página se actualiza cada cinco segundos.

Status section
Los datos más importantes del modelo del GSM se mencionan en esta sección. Además del nombre del gestor de la Red
GSM, se indica en la pantalla virtual el nivel de la señal GSM (mediante un indicador).
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Los visores del Estado del Comunicador pueden encenderse o apagarse; son de color VERDE: funcionamiento correcto;
cuando son ROJOS indican la presencia de un mal funcionamiento o de una avería ; si en cambio son de color NARANJA, indican
que está en curso una comunicación. Los indicadores piloto de los Receptores GPRS primario (Main) y de reserva (Backup) son
NARANJA  cuando el dispositivo está inicializado pero NO conectad o bien cuando está conectado pero NO está aún inicializado.

PTM
Esta página corresponde a la “función PTM (Panel Transmission Monitoring - Control Transmisión Central)” que permite al dispositivo
transferir las llamadas por medio del canal GSM si la comunicación entre central y receptor falla en la línea telefónica PSTN.
 El Comunicador vuelve al modo normal después de 5 minutos en el canal GSM.
La función PTM considera que una comunicación ha fallado cuando:
– No registra la composición del número, si la opción “Check Dialling” está habilitada (controla que se componga realmente el número).
– No detecta el Kiss-off (la señal que es enviada por el receptor al finalizar una comunicación de eventos efectuada).
 La frecuencia de la señal Kiss-off es de 1400Hz.
El control se realiza a todos los números, si la lista “Telephone Numbers” está vacía, o bien sólo a los números de la lista.
Las llamadas son transferidas al canal GSM cuando se llega al número “Maximum Failure Number” programado.
 Telephone Number: Introducir los números de teléfono (hasta un máximo de 4 números telefónicos) a llamar utilizando

la función PTM. De fábrica estos campos están vacíos. Si estos campos están vacíos, todos los números compuestos
por la central serán controlados por la función PTM (Kiss-off esperado al final de la comunicación).

 Check Dialling: De fábrica está deshabilitado, si se habilita obliga a contar el número de errores debidos a descolgar y
colgar (sin componer ningún número de teléfono) del dispositivo telefónico conectado a los bornes LI como error.

 Max Failures: Introducir en este campo el número total de errores detectados por el Comunicador después del cual se activa la función
PTM. PTM llega deshabilitada de fábrica (la programación de fábrica es 0); fijar un valor de 1 a 4 para habilitar la función PTM .

I/O (sólo para la serie BGSM-120)
En esta página se programan las modalidades entrada o salida, los eventos de activación para las Salidas, su Polaridad en
reposo (N.C. o N.A.), las Salidas Reservadas, las Cadenas SMS de activación desde remoto para las Salidas Reservadas.
 Type: En esta columna se pueden programar los bornes T1, T2 y T3 para las siguientes modalidades:

– Input: Seleccionar esta modalidad para habilitar el borne correspondiente como Línea de entrada. La selección de esta
modalidad activa la columna Service (ver a continuación).
– Output: Seleccionar esta modalidad para habilitar el borne correspondiente como Salida Open Collector.

 Estas programaciones actualizan automáticamente también los parámetros en las páginas “SMS Dialer”,
“Voice Dialer” y “Phonebook”.

 Polarity: En esta casilla se programa el estado de la salida/entrada en reposo:
– Normalmente Cerrado  con la salida/entrada en reposo, el relativo borne está en masa (negativo).
– Normalmente Abierto  con la salida/entrada en reposo, el relativo borne está colgado.
Hacer clic en la casilla en correspondencia con la columna “Polarity” para invertir el parámetro visualizado en ese momento.

 Activation events: Hacer clic en la columna relativa al evento a programar en correspondencia con la salida relativa. La marca 
indicará la presencia de este evento, será activada la Salida relativa. Hacer clic en las casillas para introducir/eliminar la marca .

 ATENCIÓN - La programación de los eventos asociados a una salida implica la deshabilitación de algunas
casillas relativas a la misma salida. Antes de programar es necesario eliminar las marcas   de las casillas.
– PSTN Fault: Si se selecciona, la salida se activará en caso de ausencia de línea telefónica.
– GSM Fault: Si se selecciona, la salida será activada si falta la red GSM.
– HB Fail: Si se selecciona, la salida se activará en caso de ausencia de mensaje de supervisión.
– FTC Signal: Si se selecciona, la salida será activada si la comunicación no se efectúa.

  La selección del evento “FTC Signal” permite seleccionar la opción “Monostable” y permite programar el “Monostable Time”.
 Reserved Output: Cuando se selecciona esta opción, todos los otros eventos seleccionados para activar la Salida

correspondiente son ignorados. Hacer clic en la casilla correspondiente a la Salida a activar con el reconocimiento del llamante
o mediante mando SMS. Para la activación de la salida en reconocimiento del llamante programar el número de teléfono en la
página “Phonebook” y habilitar la opción “Activates output” (véase la página Phonebook->Activates output).

 Service: Una marca  en esta columna indica que el Comunicador está en el Estado de SERVICIO es decir en presencia
de los eventos de desbalanceo en las líneas de entrada 1 y 2, en lugar de realzar una llamada, el Comunicador realizará de
forma autónoma una determinada acción. Por cada línea es posible definir una acción según la siguiente tabla. En cualquier
caso, al seleccionar estas acciones nunca se envían mensajes SMS en correspondencia con las Entradas 1 y 2.
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 Estas programaciones actualizan automáticamente también los parámetros en las páginas “SMS dialer”, “Voice dialer” y “Phonebook”.
 Control String: Digitar en esta columna la cadena (máximo 16 caracteres alfanuméricos) que debe enviarse cuando

se desea activar/desactivar la salida correspondiente desde remoto. Esta función está operativa incluso si el reconocimiento
de quien llama no está habilitado.

 Activation Confirmation: En esta columna se selecciona el
tipo de confirmación que se desea tener cuando la salida sea
activada. La elección se puede realizar para 3 valores diferentes:
None (Ninguna), Timbre (Ring) o SMS (si el campo de Control
string” está vacío, la opción SMS no está disponible). Si la
salida es activada  con el envío de un SMS, la confirmación de
activación de la salida es enviada mediante un SMS.

 Monostable: Normalmente las Salidas, cuando están activadas,
quedan en estado de activación hasta el siguiente mando de
desactivación, cuando llega la Salida volverá al estado de
reposo. Si se desea que la Salida, una vez activada, vuelva
automáticamente al estado de reposo después de un determinado
tiempo, seleccionar esta opción y programar el tiempo de
activación en la casilla “Monostable Time (sec)” adyacente.

 Monostable Time (sec): En esta casilla se digita un valor en segundos (de 1 a 86400 con pasos de 1 segundo) que indica el tiempo
en el cual la salida, si está programada como Monoestable, queda activa antes de volver nuevamente al estado de reposo (ON time).

Voice Dialer (sólo para la serie BGSM-120)
En esta sección se programan todos los parámetros relativos al avisador vocal es decir: Los números telefónicos a llamar
(los primeros 8 números en la agenda telefónica) el número de repeticiones para cada mensaje (mínimo 1 máximo 8), la
duración y el número de mensajes según cuanto especificado a continuación:
 Description: En esta columna se detallan los eventos para los cuales es posible programar un mensaje vocal.
 Para seleccionar los mensajes vocales para las 3 líneas de entrada programables programar el borne

correspondiente como entrada (ver páginaI/O->Type).
 Telephone numbers: Hacer clic en las columnas ‘12345678’ en correspondencia con el evento deseado. La marca  indicará que

el número de teléfono será llamado cuando se produzca un evento. Hacer clic en las casillas para introducir/eliminar la marca .
 Los números telefónicos son los primeros 8 programados en la página “Phonebook”.
 Voice Message: Hacer clic en la columna ‘Message’ en correspondencia con el evento deseado, luego hacer clic en

el pulsador para hacer pasar el listado de los mensajes (es posible seleccionar, si están grabados) hasta 8 mensajes
con una duración máxima de 16 segundos cada uno) y seleccionar uno. Se pueden conectar hasta 3 mensajes vocales
por cada evento (Message #1, Message #2, Message #3).

 Repeat Call: En este campo se puede introducir el número de intentos a realizar (hasta un máximo de 8 veces) si la
llamada no se produce.

 Repeat Message: En este campo es posible introducir el número de repeticiones del mensaje vocal (hasta un máximo
de 8 veces) al responder el número llamado.

 Call All Numbers: Seleccionar esta opción  para llamar a todos los números de teléfono programados para cada
evento y por lo tanto reproducir el mensaje vocal asignado. Si esta opción no se selecciona , el avisador finalizará
las llamadas vocales apenas una de las mismas tenga resultado positivo.

 Call Confirmation: Seleccionar esta opción para que el avisador  espere la confirmación por parte del usuario remoto que
se ha realizado la recepción del mensaje vocal, de lo contrario el avisador intentará nuevamente enviar el mensaje vocal;
El usuario remoto enviará la confirmación presionando la tecla  de su teléfono (válido sólo para teléfonos por tonos).

 Mientras se escucha el mensaje vocal, presionando la tecla * en el teclado del propio teléfono, es posible
bloquear tanto la llamada en curso como todas aquella eventualmente en curso.

 En algunos casos, el avisador puede interpretar de forma incorrecta la respuesta de las secretarías, tonos de llamada,
mensajes de cortesía del operador GSM, etc. por lo tanto, recomendamos que se habilita la "Call Confirmation".

Tabla de Efectos en Activación de la Salida
PROGRAMACIÓN EFECTOS

Black
List

White
List

Activation
Confirmation

Llamada Transferida
(sólo si el Comunicador es
conmutado a la red GSM)

Timbre
Confirmación

  None SI NO
  Ring NO SI
  None SI NO
  Ring NO SI
  None NO NO
  Ring NO SI
  None SI NO
  Ring NO SI

Habilitado
Deshabilitado
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Periodic voice
En esta sección se programan las opciones relativas al envío del Mansaje Vocal Periódico.
 DEBE introducir el “SIM Phone Number” y activar el “Auto Clock Adjusting” en la página “Options” para

fijar las opciones “Periodic Voice”.
 Date of first send: Seleccionar la fecha para el envío del primer Mensaje vocal periódico.
  Time of first send: Seleccionar la hora para el envío del primer Mensaje vocal periódico.
 Intervalo: Digitar en estas casillas el intervalo (HH-DD) dentro del cual enviar los siguientes Mensajes vocales

Periódicos. El intervalo se compone de los siguientes valores:
— (HH) hora próximo envío - Seleccionar el valor para el envío del siguiente Mensaje vocal Periódico. El intervalo de
los valores admisibles va de 0 a 23.
— (DD) día próximo envío - Seleccionar el valor para el envío del siguiente Mensaje Vocal Periódico. El intervalo de los
valores admisibles va de 0 a 365.

 Update time: seleccionando este icono es posible obtener la fecha y la hora del PC.

Local Service Mode
Seleccionando el pulsador Local service mode, puede activar escuchar/grabar mensajes de voz mediante un teléfono de
teclas conectado a los terminales [LI] en el aparato (consultar “Grabación de los Mensajes Vocales en local” y “Reproducción
de los Mensajes Vocales en local”). Cuando se habilita esta modalidad, los LED Verdes L1 y L2 parpadean (ver Led de
control->la tabla 2). El parpadeo de los LED termina solamente al final de procedimiento de grabación o de reproducción
o bien después que han transcurrido 60 segundos sin presionar ninguna tecla.
 Puede conectar SÓLO UN teléfono a los terminales [LI] para el funcionamiento adecuado el “Local service

mode”.

SMS dialer (sólo para la serie BGSM-120)
Esta página es para fijar las opciones marcador como se indica abajo.
 Event Type: En la columna ‘Event Type’ se indican, para cada una de las 11 líneas, los eventos en presencia de los

cuales está previsto, si ha sido programado, el envío de dos SMS: Uno de activación, el otro de restablecimiento (para
el evento ‘Periodic SMS’ está previsto el envío sólo del Mensaje SMS de activación).

 Para seleccionar los mensajes SMS para las 3 líneas de entrada programables programar el borne
correspondiente como entrada (ver párrafo I/O->Type).

 Telephone numbers: Hacer clic en las columnas ‘12345678’ en correspondencia con la entrada deseada. La marca
 indicará que a ese número de teléfono le será enviado el mensaje SMS al presentarse el evento correspondiente.

 Los números telefónicos son los primeros 8 programados en la página “Phonebook”.
 SMS String: en la columna ‘SMS String’, hacer clic en la casilla correspondiente al mensaje a programar y digitar el

mensaje a enviar al presentarse el evento correspondiente (máximo 100 caracteres).

Periodic SMS
En esta sección se programan las opciones relativas al envío del SMS Periódico.
 DEBE introducir el “SIM Phone Number” y activar el “Auto Clock Adjusting” en la página “Options” para

fijar las opciones “Periodic SMS”.
 Date of First Send: seleccionar la fecha para el envío del primer SMS periódico.
 Time of First Send: seleccionar la hora para el envío del primer SMS periódico.
 Interval: digitar en estas casillas el intervalo (HH-DD) dentro del cual enviar los siguientes SMS Periódicos. El intervalo

se compone de los siguientes valores:
— (HH) hora próximo envío - Seleccionar el valor para el envío del siguiente SMS Periódico. El intervalo de los valores
admisibles va de 0 a 23.
— (DD) día próximo envío - Seleccionar el valor para el envío del siguiente SMS Periódico. El intervalo de los valores
admisibles va de 0 a 365.

 Update time: seleccionando este icono es posible obtener la fecha y la hora del PC.
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Voice Message (sólo para la serie BGSM-120)
En esta sección se puede gestionar la grabación y la reproducción de los mensajes vocales. Consultar la página “Voice
Dialer” para asociación de mensajes a los eventos. Para abrir el archivo de los mensajes vocales hacer clic en el icono a
la izquierda del pulsador RECORD, a la derecha del campo “WAV File#1”.
 El comunicador soporta sólo archivos audio WAVE (.WAV), con una duración máxima de 16 segundos, con los

siguientes atributos: PCM, 8000 Hz, 8 bit, Mono, no comprimido. Se pueden emplear archivos pregrabados que
respeten el formato indicado.

Pulsadores PLAY - Presionar este pulsador para volver a escuchar el mensaje vocal.

Pulsador RECORD - Presionar este pulsador para comenzar a grabar un nuevo mensaje vocal.

Pulsador STOP - Presionar este pulsador para parar  la reproducción o la grabación corriente del mensaje vocal.

Pulsadores GET - Presionar este pulsador para cargar el mensaje vocal grabado.

Pulsadores SET - Presionar este pulsador para enviar al comunicador el mensaje vocal grabado.

Pulsadores ERASE - Presionar este pulsador para borrar directamente el mensaje vocal presente en el Comunicador.

Durante la grabación del mensaje, una barra de avance indica, en tiempo real, el tiempo transcurrido.

Grabación de los Mensajes Vocales en local
 Puede conectar SÓLO UN teléfono a los terminales [LI] para el funcionamiento correcto del Grabado Mensaje Voz Local.
Para grabar un mensaje vocal del teléfono de teclas conectar los terminales [LI], habilitar Local Service Mode en la sección
Voice Dialer y continuar como sigue:
1. Presionar la tecla ;
2. Presionar en secuencia las teclas  para entrar en el modo grabación;
3. Digitar el número del mensaje que se desea grabar (de  a );
4. Después del Beep grabar el mensaje vocal (la duración máxima del mensaje vocal es de 16 segundos);
5. Presionar la tecla  para confirmar la grabación del mensaje (o bien presionar siempre la tecla  si se desea interrumpir

antes la grabación del mensaje), se emitirá un tono Boop;
A partir de este momento, cualquier grabación efectuada anteriormente para ese mensaje ES BORRADA;

6 . Si es necesario grabar otros mensajes, repetir el procedimiento desde el punto 1.

Reproducción de los Mensajes Vocales en local
 Puede conectar SÓLO UN teléfono a los terminales [LI] para el funcionamiento correcto de Volver a escuchar Mensaje Voz Local.
Para reproducir un mensaje vocal del teléfono de teclas conectar los terminales [LI], habilitar Local Service Mode en la
sección Voice Dialer y continuar como sigue:
1. Presionar la tecla ;
2. Presionar en secuencia las teclas  para entrar en el modo reproducción;
3. Digitar el número del mensaje que se desea escuchar (de  a );
4. Después del Beep se reproduce el mensaje al finalizar el cual se genera un tono Boop de confirmación (presionar la tecla
 si se desea interrumpir anticipadamente la reproducción del mensaje);

5. Si es necesario escuchar otros mensajes, repetir el procedimiento desde el punto 1.

Programación opcional Antisabotaje
Mediante la conexión (ver el párrafo Conexiones->Conexiones Auxiliares) del Desviador Antisabotaje MAXIASNC
(opcional) es posible detectar posibles intentos de forzamiento de la tapa del Comunicador.. Para enviar un mensaje SMS
y/o vocal a uno o más números telefónicos programados para la remoción de la tapa del Comunicador realizar, por medio
del software BGSM-120/BGSM-100 Console, las siguientes programaciones:
1) En la página Phonebook programar los números de teléfono a los cuales se desea que se envíe el mensaje de alarma.
2) En la página I/O programar el borne T3, en la columna Type,como Input y en la casilla Polarity el estado de la entrada en reposo

como NO (Normalmente Abierto): la configuración en reposo del Desviador Antisabotaje es del tipo Normalmente Cerrado (NC).
3) En la página SMS Dialer y/o Voice Dialer, programar para Input 3 Event tanto el mensaje SMS y/o vocal que los

números de teléfono a los cuales enviar el mensaje.
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Para programar este dispositivo utilize o software BGSM-120/BGSM-100 Console ver. 3.0 ou superior.

ÍNDICE

Com a presente, a Bentel Security declara que a série
BGSM-100 e BGSM-120

está conforme com os requisitos essenciais e com as outras disposições pertinentes estabelecidas pela directiva 1999/5/CE.
As declarações de conformidade completas estão disponíveis no site: www.bentelsecurity.com/dc.html.

Os seguintes modelos foram certificados pela Telefication como estando em conformidade com as normas EN 50136-1-1 e EN 50136-2-1, com desempenhos do Sistema
de Transmissão de Alarme ATS 2 (D2, M2, T2, S0, I0): BGSM-100KCA, BGSM-120KCA, BGSM-100KEA, BGSM-120KEA, BGSM-100BA e BGSM-120BA.

A instalação dos dispositivos tem de ser efectuada de modo profissional, de acordo com as normas em vigor. Este equipamento foi concebido de acordo com
critérios de qualidade, fiabilidade e performance adoptados pela Bentel Security srl. Aconselha-se de verificar o correcto funcionamento do sistema pelo

menos uma vez por mês. Os procedimentos para a inspecção dependem da configuração do sistema. Pergunte ao instalador do sistema os procedimentos a
seguir. A Bentel Security srl declina toda e qualquer responsabilidade no caso do equipamento ser manuseado por pessoal não autorizado. O conteúdo deste

manual pode estar sujeito a alterações sem aviso prévio e não constitui qualquer obrigação por parte da BENTEL SECURITY.

Informação sobre o reciclado
BENTEL SECURITY recomenda que os seus clientes disponham dos seus equipamentos usados (centrais, detectores, sirenes, e outros dispositivos) de

forma respeitosa com o meio ambiente. Os métodos possíveis incluem a reutilização de peças ou de produtos completos e o reciclado de produtos,
componentes e/ou materiais. Para mais informações específicas ver http://www.bentelsecurity.com/index.php?o=environmental.

Directiva WEEE (Waste Electrical and Electronic Equipment)
 Na união europeia este símbolo indica que o produto não deverá ser colocado juntamente com o lixo doméstico. Deverá ser colocado nos

eco pontos para permitir recuperação e reciclagem.

Para mais informações ver http://www.bentelsecurity.com/index.php?o=environmental
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INTRODUÇÃO
Os dispositivos da série BGSM-100 e BGSM-120 são comunicadores GSM que, na falta de uma linha PSTN, enviam alarmes
vocais ou digitais, através de GPRS, aos receptores System III ou System II. Para cada série são disponíveis três versões:
— BGSM-100KCA e BGSM-120KCA kit que inclui placa do comunicador GSM/GPRS e antena com cabo de 25 cm;
— BGSM-100KEA e BGSM-120KEA kit que inclui placa do comunicador GSM/GPRS, antena com cabo de 2 m. e suporte metálico;
— BGSM-100BA e BGSM-120BA kit que inclui placa do comunicador GSM/GPRS, antena com cabo de 25 cm e caixa.
As informações que dizem respeito a uma versão específica estão evidenciadas, fazendo referência ao código
correspondente. O termo “Comunicador” será utilizado para descrever as funções comuns às várias versões. Este
manual fornece as instruções para a programação e o uso do Comunicador. Para exigências de instalação especiais,
estão disponíveis a antena remota de exterior ANT-EU e a antena magnética com cabo de 25 cm BGSM-100CA.
 Este Comunicador só pode ser instalado por Pessoal Qualificado (uma Pessoa Qualificada possui a preparação

técnica adequada e a experiência necessária para ter consciência dos perigos aos quais pode estar exposta
durante o desempenho de um trabalho e das medidas para minimizar os riscos para si mesma e para as outras
pessoas). Este Comunicador só pode ser instalado e usado em ambientes com Grau de Poluição máximo 2,
Categoria de Sobretensões II, em locais não perigosos e fechados. Estas instruções devem ser usadas junto
com o manual de instalação da central. Todas as instruções presentes neste manual têm de ser cumpridas.

Características Gerais
 Fornece uma linha PSTN simulada.
 Detecção de ausência de linha PSTN e comutação

automática para a Rede GSM.
 Gestão e sinalização de telefonemas em entrada e em

saída.
 Indicador de intensidade do campo GSM.
 3 Terminais programáveis como Saídas Open-Collector ou

como Linhas de Entrada (somente para a série BGSM-120).
 Protecção de sobretensões na linha telefónica.
 GSM Quad-Band.
 Antena com base magnética.
 Sinalizador SMS (somente para a série BGSM-120).
 Sinalizador Vocal (somente para a série BGSM-120).
 Descodificação do Protocolo Contact ID e envio de dados

via GPRS.
 Comunicação GPRS/Internet com receptores Sur-Gard

System III / II.

 Opções programáveis com o PC.
 11 Mensagens SMS, cada uma com tamanho máximo

de 100 caracteres (2 para cada Linha de Entrada mais
4 para as Comunicações de Estado e 1 Periódica),
somente para a série BGSM-120.

 8 números telefónicos (máx.16algarismos) programáveis
para o Sinalizador SMS (somente para a série BGSM-120).

 4 números de telefone programáveis para o Transmissor
Contact ID por GPRS.

 Até 100 números telefónicos (máx.16 algarismos)
programáveis para a activação remota da Saída OC.

 Activação remota das saídas mediante reconhecimento
do emissor da chamada e/ou o envio de SMS (envio
de SMS somente para a série BGSM-120).

 Controlo crédito resíduo das  SIM CARD pré-pagas
(somente para a série BGSM-120).

 (PTM) monitorização das comunicações com a central.

Características Técnicas
A tensão de alimentação para este Comunicador é fornecida pela Central ou por uma fonte de alimentação estabilizada
ADP1512 (não fornecida).

Versões
BGSM-100KCA, BGSM-100KEA,
BGSM-120KCA, BGSM-120KEA,

BGSM-100BA,
BGSM-120BA

Tensão de alimentação de 10 a 27,6 V_
Corrente em repouso 100 mA máximo (excluindo as saídas) a 13,8 Vcc
Corrente Máxima em alarme (transmissão) 250 mA média (excluindo as saídas) a 13,8 Vcc
Saídas OC 3 open-collector, de 100 mA
Frequência de funcionamento 900/1800 MHz ou 850/1900 MHz
Resistência máxima em série por linha dos
dispositivos ligados aos terminais L.I.

1 Kohm

Número máximo de dispositivos ligados em
paralelo aos terminais L.I.

1

Temperatura de funcionamento de 5 a 40 °C

Dimensões (L x A x P)
60,5 x 142 x 15,3 mm
(somente da placa)

90 x 190 x 75 mm
(excluindo antena)

Peso 66 g 348 g
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Descrição Geral
O Comunicador pode comunicar com as Centrais de Vigilância e, somente para a série BGSM-120, enviar mensagens tanto
SMS quanto vocais; além disso, pode simular a linha telefónica PSTN no caso de avaria (falta da linha telefónica) ou
substituí-la completamente nas áreas cobertas pelo serviço GSM e nas quais a linha telefónica PSTN não está disponível.
Tem a capacidade de comunicar eventos de alarme através da rede GPRS, consentindo uma comunicação fiável e rápida
com centrais de vigilância dotadas de um receptor Sur-Gard System III ou System II. A performance deste Comunicador
depende fortemente da cobertura da rede GSM, por isso, este não deve ser instalado antes de ter efectuado um teste de
posicionamento da antena para determinar o melhor local de recepção (pelo menos 1 LED verde tem de estar aceso).
Os Comunicadores da série BGSM-100 dispõem de 3 saídas, das quais 1 pode ser activada/desactivada com comando
remoto enquanto as outras 2 são usadas para sinalizações de: problema na linha telefónica PSTN; problema na rede GSM.
Os Comunicadores da série BGSM-120 dispões de 3 terminais programáveis como:
— Saídas (configuração de fábrica) que podem ser activadas/desactivadas desde remoto ou utilizadas para as comunicações
de estado: problema na linha telefónica PSTN; problema na rede GSM; falta mensagem de supervisão; impossível comunicar.
— Linhas de Entrada para a activação do Sinalizador Vocal e do Sinalizador SMS que podem ser utilizados também para
o envio de comunicações de estado.
Devido às características da rede GSM, este Comunicador deve ser usado exclusivamente para os fins previstos, e NÃO
pode ser usado como modem para a transmissão de faxes e dados ou para operações de Teleassistência.

IDENTIFICAÇÃO DOS COMPONENTES
Os números entre parêntesis rectos [ ] neste manual, fazem referência aos componentes principais deste Comunicador, ilustrados na Figura 1.

INSTALAÇÃO
 NÃO passe fio algum por cima da placa electrónica.
 Este Comunicador só pode ser instalado por PESSOAL QUALIFICADO, num local fechado, seguro e seco,

longe de aparelhos radiotransmissores.
 Teste a recepção da Rede GSM antes de instalar este Comunicador no ponto escolhido.

BGSM-100KCA, BGSM-100KEA ou BGSM-120KCA, BGSM-120KEA
 Este Comunicador é composto por uma placa destinada a ser posicionada dentro de uma central anti-furto, de

preferência com um recipientes metálico, e por uma antena que liga-se à placa através de um cabo coaxial.  Durante
o normal funcionamento, estes elementos (placa, antena e cavo) podem ser fonte de campos electromagnéticos
irradiados e, se nas proximidades houver dispositivos electrónicos não suficientemente imunes a tais campos, podem
verificar-se interacções indesejáveis.  A tal fim, aconselha-se posicionar a placa o mais longe possível de tais
dispositivos electrónicos susceptíveis e a antena sobre a superfície externa do recipiente metálico ou longe do mesmo
através do específico suporte.  Para o cabo coaxial de ligação, aconselha-se deixar no interior do recipiente metálico
da central o comprimento mínimo necessário e de posicionar o eventual excesso fora do recipiente metálico.

1. Desaparafuse os parafusos e remova a tampa da central.
2. Identifique dentro da caixa metálica da central uma área com capacidade para hospedar a placa, incluindo a cablagem.
3. Posicione os 4 suportes de plástico adesivos [14] no fundo da caixa metálica, depois insira os furos [7] presentes na

Placa Electrónica nos suportes de plástico adesivos, como ilustrado na Figura 2.
4. Monte a antena [1] no exterior da caixa.
4a. Posicione a antena com o cabo de 25 cm ou a antena com o cabo de 2 m [1] em cima da caixa metálica (Fig. 2) de maneira

que a base magnética [2] adira à superfície. Passe o cabo da antena através de uma abertura para a passagem dos cabos.
Para a versão BGSM-100KEA ou BGSM-120KEA é possível utilizar o suporte metálico [13], ver a Fig. 2a. Fixe o
suporte metálico [13] utilizando os furos [12] numa superfície adequada. Posicione a antena com o cabo de 2 metros [1]
em cima do suporte metálico [13] (Fig. 2a), de maneira que a base magnética [2] adira à superfície. Passe o cabo da
antena através do furo [11] do suporte metálico [13].

5. Ligue o cabo [3] ao conector para antena GSM [4].
6. Faça as ligações nos blocos de terminais [10].
7. Insira o cartão SIM [8] no seu alojamento [6], como indicado pela seta, com os contactos virados para baixo (ver a Figura 1).
!!!!! O PIN do cartão SIM tem de ser desabilitado antes da sua inserção no Comunicador.
!!!!! Recomenda-se a desabilitação da transferência de chamadas no seu cartão SIM.



BGSM-100/120 51

PPPPP

8. Ao ligar o aparelho, verifique que todos os LEDs verdes estejam piscando, neste estado o Comunicador está na fase de inicialização.
9. Verifique a intensidade do sinal:

– certificar-se de que pelo menos um LED verde esteja ligado; todos os LED verdes ligados indicam uma cobertura ideal;
– se os LEDs verdes estiverem apagados, significa que a intensidade do sinal NÃO é suficiente; mude a posição da
antena até quando obter uma intensidade aceitável, indicada por ao menos um LED verde aceso.

10. Feche a tampa da Central.
 Ligue a alimentação e os circuitos telefónicos só após o Comunicador ter sido fixado e ter sido ligado ao

circuito de terra do edifício.
!!!!! Antes de inserir ou remover o cartão SIM, certifique-se de que o Comunicador NÃO está alimentado.

ANT-EU Antena remota
Para a montagem da antena remota de exterior ANT-EU consulte as instruções fornecidas com este produto. O ANT-EU é
útil para fornecer ao Comunicador um campo GSM de maior intensidade.

BGSM-100BA ou BGSM-120BA
Veja a figura 1.
1. Marcar a posição dos furos [19] para a fixação no muro do fundo metálico [17].
2. Realize os furos no muro nas posições marcadas.
3. Introduza os 4 suportes da placa [16] nos furos no fundo metálico [27].
4. Passe os cabos para as ligações através da abertura presente no fundo [22].
5. Fixe o fundo metálico ao muro através das buchas (não fornecidas).
!!!!! Preste atenção para não danificar fios ou tubos encaixados no muro.
6. Posicione a placa electrónica nos suportes [16] e empurre-a para o fundo até bloqueá-la na sua posição, como indicado na Figura 1.
7. Ligue o cabo da antena [3] ao

conector na Placa electrónica [4].
8. Passe o cabo da antena [3] abaixo

da lingueta de fixação do cabo [26],
e depois através da abertura [23].

9. Posicione a antena [1] no lado superior
do fundo de modo que a base magnética
[2] fique aderente à superfície.

 A antena pode ser posicionada
no lado superior do fundo, no
pondo mais adequado a receber
o sinal GSM.

10. Se necessário, monte o Desviador
Anti-sabotagem MAXIASNC [15]
(opcional) sobre os pinos, como
indicado na Figura 1.

 A alavanca do Desviador deve estar
orientada conforme indicado na Fi-
gura 1, caso contrário o dispositi-
vo não irá funcionar correctamente.

11. Efectuar as ligações sobre o bloco de
terminais [10] como descrito no parágrafo
"Ligações" e, se necessário, a ligação
do Desviador anti-sabotagem (para ligar
o Desviador anti-sabotagem, consulte
"LIGAÇÕES-> Ligações auxiliares").

Fig. 2 -  Montagem da placa
dentro da central
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12. Insira o cartão SIM [8] no seu alojamento [6], como indicado pela seta, com os contactos virados para baixo (ver a Figura 1).
!!!!!  O PIN do cartão SIM tem de ser desabilitado antes da sua inserção no Comunicador.
13. Ao ligar o aparelho, verifique que todos os LEDs verdes estejam piscando, neste estado o Comunicador está na fase de inicialização.
14. Verifique a intensidade do sinal:

– certificar-se de que pelo menos um LED verde esteja ligado; todos os LED verdes ligados indicam uma cobertura ideal;
– se os LEDs verdes estiverem apagados, significa que a intensidade do sinal NÃO é suficiente; para uma
intensidade aceitável, ao menos um LED verde deverá estar aceso.

15. Feche o Comunicador: engate o lado inferior da tampa [18] ao fundo [17] e em seguida pressione o lado superior do
fundo para fechar a tampa; bloqueie a tampa com os parafusos [25].

 Ligue a alimentação e os circuitos telefónicos só após o Comunicador ter sido fixado e ter sido ligado ao
circuito de terra do edifício.

!!!!! Antes de inserir ou remover o cartão SIM, certifique-se de que o Comunicador NÃO está alimentado.

LIGAÇÕES
Neste capítulo são descritos os terminais do Comunicador e as ligações auxiliares. Na Figura 3 é ilustrado um exemplo de ligação.

N. Terminais Versões
BGSM-100KCA ,BGSM-100KEA, BGSM-100BA BGSM-120KCA, BGSM-120KEA, BGSM-120BA

1 +V

Alimentação fornecida pela central ou pela fonte de alimentação externa, ADP1512 (opcional), de 10 a 27,6 Vcc,
certifique-se de que está protegida e limitada na corrente: fonte com potência limitada (LPS) de acordo com a
norma EN 60950-1:2006.

!  Para ligar a alimentação utilize cabos com um comprimento máximo de 2 metros e 0,75 mm² de secção. Para
cabos com comprimento inferior utilize secções adequadas.

2 M Massa: negativo da alimentação e terminal comum para as Saídas Open Collector.

3 T1

Saídas Open-Collector: estas saídas são activadas pelos
eventos avaria na linha PSTN (T1) ou na rede GSM (T2).

Terminais Programáveis: estes terminais podem ser
programados como;
– Saídas Open-Collector (configuração de fábrica): estas
saídas podem ser activadas pelos eventos programados
(Activação Automática), ou med iante comando po r
mensagem SMS ou também por reconhecimento do
emissor da chamada (Activação Remota); favor ler o capítulo
"Activação das Saídas" para maiores informações. A
corrente máxima capturável por cada Saída OC é de 100 mA.
– Linhas de entrada: estas entradas, ao receberem
Sinalizações de Alarme, podem activar as funções de
Sinalizador SMS e de Sinalizador Telefónico (favor ler os
capítulos "Sinalizador SMS"  e "Sinalizador Vocal").

4 T2

5 T3
Saída Open-Collector Programável: esta saída pode ser
activada pelo evento reconhecimento do chamador. A
corrente máxima consumida por cada Saída OC é de 100 mA.

6 -
Terra: este terminal tem de ser ligado à Terra da instalação eléctrica para proteger o dispositivo das sobretensões
na linha telefónica e para satisfazer os requisitos de segurança.

7 LE Linha Telefónica Externa: estes terminais podem ser ligados à linha telefónica PSTN.8
9 LI Linha Telefónica Interna: estes terminais têm de ser ligados à central ou a outro terminal de comunicação.10

!!!!! A corrente dos Open Collector não pode exceder os 100 mA. Caso seja necessário comutar cargas
maiores utilize relés ou as nossas placas relé BRM04/12 (12 Vcc) e BRM04/24 (24 Vcc).

Ligações auxiliares
As ligações auxiliares não são indispensáveis para o funcionamento do Comunicador, mas permitem utilizar ao máximo a
versatilidade deste dispositivo. Estas ligações são descritas no parágrafo seguinte.
Antisabotagem - A ligação do Desviador Antisabotagem MAXIASNC (opcional) permite detectar eventuais tentativas de
violação da tampa do Comunicador. O Desviador Antisabotagem está equipado com um cabo pré-soldado que pode ser
ligado das seguintes maneiras:
— À linha antisabotagem ou a uma zona adequada da central. Leia as instruções da central para obter mais informações.
— Entre o terminal [ T3 ] e [ M ] do BGSM-120, para que com a remoção da tampa do Comunicador seja enviada uma mensagem
SMS e/ou de voz a um ou mais números de telefone. Nesse caso é necessário, usando o software BGSM-120/BGSM-100
Console, programar o Comunicador (veja o parágrafo PROGRAMAÇÃO COM O PC->Programação opcional Antisabotagem).
Realizadas as ligações e a programação feche a tampa e ligue a alimentação do Comunicador. Terminada a fase de inicialização
do Comunicador GSM, abra a tampa e verifique se a mensagem SMS e/ou de voz é enviada aos números programados.



BGSM-100/120 53

PPPPP

Fig. 3 - Exemplo de ligação para a série BGSM-100 e BGSM-120
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Tabela 2 - Comunicações acerca do estado do
Comunicador para a série BGSM-120 mediante
intermitência dos LED Verdes (L1,L2,L3).

LEDS DE CONTROLO
Na placa encontram-se 5 LEDs (ver Figura 4); três LEDs verdes (L1, L2 e L3), um LED amarelo (L4), um LED vermelho (L5),
que sinalizam a conexão, a transmissão, as condições de mau funcionamento e, somente para a série BGSM-120 (consulte
a tabela 2), o estado do Comunicador.
 Durante a inicialização e durante a fase de programação, os LEDs piscam.
VERMELHO — LED normalmente apagado.

Sinaliza uma condição de funcionamento
anómalo, piscando no caso de avaria.
Este Comunicador controla a presença
de algumas avarias pela ordem ilustrada
na tabela ao lado. É indicado o estado de
funcionamento anómalo mais importante,
com o correspondente número de
intermitências do LED VERMELHO (L5),
como ilustrado na tabela ao lado.

AMARELO — Se aceso indica que a Interface
comutou para a Rede GSM devido a
anomalias na Linha Telefónica PSTN ou
não presença da mesma. Se piscar len-
tamente, indica uma chamada em curso
na rede GSM (tanto em entrada quanto em saída). Se estiver ligado fixo junto com o LED vermelho, indica carregamento
dados de fábrica em andamento.

VERDE — Os três LEDs verdes (L1, L2 e L3) sinalizam a intensidade de campo GSM e o estado (tabela 2), como ilustrado na Figura 4:
O primeiro LED (L1, perto do furo de fixação) se estiver apagado indica que a Rede GSM NÃO está disponível. Se
apenas este LED estiver aceso, o nível do sinal GSM é baixo mas suficiente para efectuar as chamadas vocais;
O segundo LED (L2), se aceso indica uma boa intensidade de campo GSM: este LED só se acende quando o primeiro
LED VERDE está aceso;
O terceiro LED (L3), se aceso indica uma óptima intensidade de campo GSM: só se acende quando o primeiro e o
segundo LED estão acesos.

MODALIDADE DE FUNCIONAMENTO
Este Comunicador tem a possibilidade de escolher o “Canal Predefinido” de comunicação. Fornece a tensão de linha e
de toque para as chamadas de entrada e descodifica a Marcação Multifrequência (DTMF). A Simulação da Linha Telefónica
PSTN fornece à central anti-furto ou a outro terminal de comunicação uma linha de reserva em caso de avaria na PSTN.
A comutação entre PSTN e GSM, ou vice-versa, NÃO ocorre durante os telefonemas de saída. A Prioridade de Funcionamento
(a ser seleccionada durante a fase de programação) determina a forma segundo a qual o Comunicador gere as comunicações
(SMS e vocais) e as chamadas dos dispositivos telefónicos conectados aos terminais LI (por exemplo, uma central anti-furto).
 NÃO é capaz de descodificar a Marcação por Impulsos (Decádica).
 Para prevenir um uso indesejado da linha simulada via GSM, o dispositivo durante as chamadas vocais gera um duplo

beep de sinalização. O primeiro duplo beep é gerado após 5 minutos os seguintes a intervalos de 30 segundos.

Símbolo de nível do sinal GSM
LEDs de controlo

LEDs Indicadores de campo GSM

Numeração dos LEDs
(referências não presentes

na Placa Electrónica).
Esta numeração é indicada

apenas para uma melhor
identificação do LED

neste documento.

1 2 3 4 5

Prioridade de
Sinalização Tipo de Anomalia Intermitências

LED vermelho

1 (ALTA)
Problema de Firmware (firmware

incorrecto) 1

2 Problema de alimentação 2

3
Problema no módulo GSM

Problema SIM durante a inicialização 3

4 Problema SIM durante o funcionamento 4
5 Problema de campo GSM 5
6 Problema GPRS 6
7 Receptor não disponível 7

8 (BAIXA)
Receptor de supervisão ausente

(receptor 1) 8

— Nenhuma avaria Apagado

LED Verdes
intermitentes Significado da sinalização

L1
Transmissão mensagem vocal em
andamento.

L3
Sessão Remota; pisca até sair da
sessão remota GPRS.

L1+L2
Modalidade de serviço; a intermitência
perdura até sair da modalidade.

L2+L3
Mensagem SMS recebida; piscam
durante 5 segundos.

L1+L2+L3
O Comunicador está em fase de
inicialização; e intermitência perdura
até a recepção dum sinal GSM.

Fig. 4 - LEDs de
controlo.
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Restabelecimento Programação de Fábrica
Para restabelecer a programação de fábrica do Comunicador, efectuar as operações descritas as seguir:
1. Tirar a alimentação ao Comunicador.
2. Mantendo em curto-circuito (com pinças) os pés 1 e 4 do conector [9] (fig. 5 na pág. 61), restabelecer a alimentação.
3. Os 5 LEDs (L1, L2, L3, L4 e L5) acendem-se por alguns instantes (menos de 1 segundo).
4. Assim que o curto-circuito for detectado, os e LEDs verdes (L1, L2, L3) desligam-se enquanto que os LEDs amarelo e vermelho

(L4 e L5) ficam acesos (alguns segundos) para sinalizar que está sendo actuado o restabelecimento das programações de fábrica.
5. Ao acendimento dos LEDs amarelo e vermelho (L4 e L5) remover o curto-circuito dos pés 1 e 4 do conector [9] (fig. 5 na pág. 61).
6. Após ter terminado o procedimento, os 3 LEDs verdes piscam para sinalizar que o Comunicador está em fase de inicialização.
 As mensagens vocais gravadas NÃO são apagadas ao restabelecer a programação original de fabrico.

Canal Predefinido PSTN
Se a tensão nos terminais da Linha Telefónica PSTN (LE) descer abaixo de 3 Vcc por um tempo compreendido entre 10 e 3600
segundos (valor programável) os dispositivos telefónicos ligados aos terminais LI são comutados para a Rede GSM. Quando
se restabelece a Linha Telefónica PSTN, esse comuta, novamente após um tempo programável, para a Linha Telefónica PSTN.
 É possível forçar a comunicação

no canal GSM/GPRS, mesmo
quando está presente a Linha
Telefónica PSTN digitando o in-
dicativo “9999” antes do número
de telefone marcado pela Central
(para esclarecimentos adicionais
consulte a tabela ao lado e o
parágrafo “GPRS->Números de
Telefone a descodificar”).

 Os números de telefone para a função
PTM (consulte “PTM->Números de
Telefone”) e os a descodificar (consulte
“GPRS->Números de Telefone a
descodificar”) têm de ser digitados
SEM o indicativo “9999”.

 No caso de, por qualquer motivo, o dispositivo se encontrar em linha simulada GSM do número marcado
será removido o indicativo “9999”, se presente.

Canal Predefinido GSM
Fornece aos dispositivos ligados aos terminais LI a linha simulada se estiver presente a cobertura GSM. No caso de falta
de campo GSM, comuta para a Linha Telefónica PSTN.

Sequência de Transmissão Contact ID por GPRS
O Comunicador, no caso de terem sido inseridos números de telefone na página GPRS->Telephone numbers to decode
através do software BGSM-120/BGSM-100 Console, endereça as chamadas a esses números através da linha GPRS.
 Quando se verifica um evento, a central anti-furto ocupa a linha telefónica.
 Este Comunicador simula o sinal de chamada.
 A central anti-furto marca o número da Central de Vigilância. Certifique-se de que a central anti-furto insere uma pausa

pelo menos de 1 segundo ou que verifica a presença do Sinal de Chamada, antes de marcar o número.
 Este Dispositivo envia o duplo sinal de handshake exigido para o Contact ID.
 Após ter recebido o handshake, a central anti-furto transmite os eventos de alarme em formato DTMF.
 O Comunicador descodifica e transforma os dígitos DTMF em pacotes e envia-os ao receptor da Central de vigilância

através da rede GPRS.
 O receptor reconhece o evento e envia o comando ao presente Comunicador, que gera o correspondente sinal de kiss-

off (a frequência do sinal de kiss-off é de 1400Hz) para a central.
 Depois deste Comunicador ter gerado o sinal de kiss-off, se não houverem outros eventos que têm de ser enviados, a

central anti-furto termina a chamada, senão essa pode enviar o evento seguinte.

Número marcado
pela Central

Linha
telefónica

Número na lista de
Números de telefone

a descodificar

Efeito

0123456789 PSTN Nenhum
Chamada de voz em PSTN
do número 0123456789.

99990123456789 PSTN 0123456789
Comunicação Contact ID
em GPRS.

99990123456789 PSTN Nenhum
Chamada de voz e/ou
Contact ID em GSM do
número 0123456789.

99990123456789
Simulada

GSM
0123456789

Comunicação Contact ID
em GPRS.

99990123456789
Simulada

GSM
Nenhum

Chamada de voz e/ou
Contact ID em GSM do
número 0123456789.
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Sinalizador SMS (somente para a série BGSM-120)
Na modalidade de funcionamento como Sinalizador SMS há uma chamada para um ou mais números telefónicos (os primeiros 8 números da lista
dos contactos) aos quais enviar as Mensagens SMS programadas e anteriormente associadas aos eventos a seguir (favor, ver tabela seguinte):

N Descrição Evento

Números telefónicos programados
(os primeiros 8 números da lista de

contactos)) Mensagem SMS

1 2 3 4 5 6 7 8
1  Activação Entrada 1         *Linha de Comando SMS
2 Restabelecimento Entrada 1         *Linha de Comando SMS
3 Activação Entrada 2         *Linha de Comando SMS
4 Restabelecimento Entrada 2         *Linha de Comando SMS
5 Activação Entrada 3         *Linha de Comando SMS
6 Restabelecimento Entrada 3         *Linha de Comando SMS
7 Problema Linha PSTN        

8 Restabelecimento Linha PSTN         *Linha de Comando SMS
9 Problema tensão de alimentação        

10 Restabelecimento tensão de
alimentação         *Linha de Comando SMS

11 SMS Periódico         *Linha de Comando SMS
  Evento Desabilitado no número telefónico
  Evento Habilitado no número telefónico
  *   A linha de comando do SMS pode ter um comprimento máximo de 100 caracteres

 Sinais de Alarme que podem se verificar em uma ou mais das 3 Linhas de Entrada Programáveis. Considerar que, para
cada uma das 3 Linhas de Entrada do dispositivo, podem ser programadas 2 Mensagens SMS: aquela de Activação e
aquela de Restabelecimento.

 Teste Linha PSTN. Podem ser programados 2 SMS: aquele de falta da Linha PSTN e aquele de Restabelecimento.
 Teste tensão de Alimentação. Podem ser programados 2 SMS: um para indicar problemas de tensão de Alimentação e

um para aquela de Restabelecimento.
 Envio SMS Periódico com um período programável de 1 hora até 1 ano.
 O envio de uma Mensagem SMS acontece ao verificar-se dum dos eventos acima descritos para o qual foi

programada uma mensagem SMS e pelo menos um número telefónico.

Sinalizador Vocal (somente para a série BGSM-120)
Na modalidade de funcionamento como Sinalizador vocal são chamados um ou mais números telefónicos (os primeiros 8 números
da lista de contactos) aos quais enviar uma mensagem vocal gravada anteriormente. Podem ser gravadas até 8 mensagens, cada
um com duração máxima de 16 segundos. Cada mensagem é gravada sobre suporte tipo disco rígido, o que elimina todos os
problemas ligados ao uso de fita cassete, como: deterioração da qualidade da mensagem com o passar do tempo; bloqueio da parte
mecânica após longos períodos de inactividade etc... As mensagens são associadas aos eventos a seguir (ver tabela seguinte):

N Descrição Evento

Números telefónicos programados
(os primeiros 8 números da lista de

contactos) Mens. #1 Mens. #2 Mens. #3

1 2 3 4 5 6 7 8
1 Activação Entrada 1        

2 Restabelecimento Entrada 1        
Mensagem

Vocal 1
Mensagem

Vocal 2
3 Activação Entrada 2        

4 Restabelecimento Entrada 2        
Mensagem

Vocal 2
5 Activação Entrada 3        

6 Restabelecimento Entrada 3        

7 Problema Linha PSTN        

8 Restabelecimento Linha PSTN        

9 Problema tensão de alimentação        

10 Restabelecimento tensão de alimentação        

11 Chamada Periódica        
  Evento Desabilitado no número telefónico
  Evento Habilitado no número telefónico
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 Sinais de Alarme que podem se verificar em uma ou mais das 3 Linhas de Entrada Programáveis. Considerar que, para cada uma
das 3 Linhas de Entrada do dispositivo, podem ser gravadas 2 Mensagens Vocais: aquela de Activação e aquela de Restabelecimento.

 Teste Linha PSTN. Podem ser gravadas 2 Mensagens Vocais: aquele de falta da Linha PSTN e aquele de Restabelecimento.
 Teste tensão de Alimentação. Podem ser programadas 2 Mensagens Vocais: uma para indicar problemas de tensão de

Alimentação e uma para aquela de Restabelecimento.
 Envio Mensagem Vocal Periódica com um período programável de 1 hora até 1 ano.
A chamada vocal acontece ao verificar-se de um evento sobre um canal pelo qual foi programada uma mensagem vocal
e pelo menos um número telefónico. Neste caso, o Comunicador executa as fases descritas a seguir:
1. O Comunicador selecciona o número telefónico e encaminha a chamada na linha telefónica GSM.
2. O Comunicador verifica que o número não esteja ocupado ou que não haja problemas na rede GSM para poder prosseguir

com a fase sucessiva, caso contrário a chamada é terminada e há uma nova tentativa da Fase 1 por, no máximo, 8 vezes
(a depender do valor programado), além das quais o ciclo de chamadas é considerado terminado. Se o Canal de Alarme
foi programado para chamar mais números telefónicos, estes serão chamados sequencialmente.  Desta forma, por exemplo,
evita-se a possibilidade de chamadas subsequentes em poucos segundos par um número ocupado.

3. O Comunicador aguarda a resposta do número chamado por até 60 segundos.  Em caso de êxito positivo, passa-se à
Fase 4, caso contrário a chamada é terminada e há uma nova tentativa desde a Fase 1 por um máximo de 8 vezes (a
depender do valor programado), além das quais o ciclo de chamadas é considerado terminado.

4. O Comunicador reproduz a mensagem relativa ao canal em alarme, a chamada é considerada terminada somente após
a recepção da mensagem ou a pressão da tecla  (se anteriormente tiver sido programada a opção Call Confirmation:
veja o parágrafo Voice Dialer->Call Confirmation) no telefone que recebeu a mensagem. Se, no momento da
selecção, tenham se verificado vários eventos que determinam o envio de diversas mensagens para o mesmo número
telefónico, estas mensagens são reproduzidas (cada uma sempre por um máximo de 8 vezes, a depender do valor
programado) em sequência, no decorrer da mesma chamada, o que evita repetidas chamadas para o mesmo número.
Se, no final do ciclo de chamadas, a Linha que provocou  a activação do Comunicador estiver ainda em alarme, o
procedimento acima descrito não será realizado novamente. É necessário, de facto, que a linha que provocou um ciclo
de chamada retorne em repouso antes de activar um novo.

Gestão das Prioridades (somente para a série BGSM-120)
O Comunicador pode transmitir os eventos de alarme e as mensagens (SMS ou vocais), algumas prioridades podem ser
programadas mediante o software BGSM-120/BGSM-100 Consola (ver a parte relativa à programação mediante o software
BGSM-120/BGSM-100 Consola), a seguir é representada a tabela de gestão das prioridades com as configurações de fábrica.

Tabela de gestão das prioridades
Prioridade

Evento Descrição Evento Configurações
de fábrica

Programável
com software

1 (ALTA)  Solicitação Linha LI (soltar)  Sim

2 Sinalizador Vocal (mensagens vocais)  Sim

*3 (BAIXA) Supervisão GPRS  Não

* O evento de Supervisão GPRS é o mais baixo e não pode ser programado com software

Prioridade para a Linha Telefónica Simulada
Quando o dispositivo conectado aos terminais LI solicita a linha, qualquer eventual chamada efectuada naquele momento
em modalidade Sinalizador Vocal é terminada. Assim, são realizadas as chamadas solicitadas pelo dispositivo ligado aos
terminais LI (por exemplo, uma central anti-furto). Quando o dispositivo conectado aos terminais LI liberar a linha, o
Sinalizador Vocal efectuará novamente as chamadas pendentes assim como enviará as mensagens vocais.

Prioridade Sinalizador SMS
No caso em que um aparelho ligado aos terminais LI esteja a efectuar uma chamada em GSM mediante este Comunicador
e seja necessário efectuar uma acção desde o Sinalizador SMS, a chamada desde a interface não será terminada e a
mensagem SMS será enviada em todo caso.

Prioridade dos Eventos do Sinalizador
As mensagens SMS têm prioridade inferior às mensagens de voz, mas não podem ser interrompidas enquanto estão a ser
transmitidas: neste caso, a mensagem de voz fica à espera e é enviada no final do envio de mensagem SMS.
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Controlo crédito resíduo (somente para a série BGSM-120)
Se programado mediante o software BGSM-120/BGSM-100 Consola (favor ver página Options->Pay As You Go), pode-
se controlar o crédito resíduo da carta SIM pré-paga. Ao habilitar o controlo do crédito resíduo, periodicamente é enviado, ao
primeiro número da lista de contactos um SMS que conterá as informações fornecidas pelo operador acerca do crédito
resíduo. Para todos os operadores que atendem a solicitação de crédito resíduo mediante comando de rede, pode-se inserir
a linha de interrogação mediante o software BGSM-120/BGSM-100 Consola.
 A critério de cada operador de rede GSM, o serviço de gestão crédito das SIM CARD pré-pagas pode ser suspenso.

(PTM) controlo das comunicações com a central
O controlo constante das comunicações com a Central (função PTM) permite ao Comunicador o envio de chamadas
mediante a rede GSM no caso em que a comunicação entre a central de alarme e a central de vigilância não tenha êxito na
linha telefónica PSTN. Se programada, (mediante o software BGSM-120/BGSM-100 Consola página PTM), esta característica
é activa somente quando a linha PSTN estiver conectada aos terminais LE presentes.
A função PTM está atrelada às seguintes modalidades de transmissão do alarme do Comunicador:
1. Alarme em GRPS (comunicações IP receptor).
2. Alarme em GSM (modalidade voz).
 O evento PSTN Fault ocorre quando a função PTM se activa.

ACTIVAÇÃO DAS SAÍDAS
A série BGSM-100 possui 3 Saídas do tipo Open Collector (os terminais T1, T2 e T3). A série BGSM-120 possui 3
terminais (T1, T2 e T3) que podem ser programados como Entradas e/ou Saídas: estes terminais são programados na
fábrica como Saídas. As Saídas Open Collector podem ser activadas de modo automático (no caso de determinados
eventos programados), ou em remoto, através de uma mensagem SMS (envio SMS apenas para a série BGSM-120) ou
o reconhecimento do emissor da chamada de um número programado anteriormente.

Activação e desactivação das Saídas em automático
As Saídas Open Collector T1, T2 e T3 deste Dispositivo podem ser activadas de modo automático pelos seguintes eventos:
 Falta de Linha Telefónica PSTN (T1, para a série BGSM-100).
 Falta de Rede GSM (T2, para a série BGSM-100).
 Falta da mensagem de supervisão (somente para a série BGSM-120).
 Falha na comunicação de um evento interno (FTC) (somente para a série BGSM-120).
 Uma Saída OC, activada em automático, volta ao estado de repouso quando forem resolvidas todas as

causas que provocaram a sua activação, excepto por falta de comunicação de um evento interno (FTC),
neste caso volta ao estado de repouso após um tempo programado (Monostable Time).

Activação e desactivação das Saídas com comando remoto
 A conexão GSM deve estar sempre presente antes que as saídas possam ser activadas/desactivadas desde remoto.
 Aconselha-se a programação do dispositivo com a Black List activada (Options->Dial Options) e White List

desactivada (Phonebook->White List) para os números que se quer utilizar para esta função.
 O número utilizado para a activação das saídas mediante o Reconhecimento do Emissor da Chamada deve estar visível

BGSM-100
As Saídas Open Collector T1 e T2 são Biestáveis e a Saída T3 é Monoestável (a Saída fica activa pelo tempo de ON,
terminado esse tempo volta ao repouso).

BGSM-120
As Saídas Open Collector podem ser configuradas como Biestáveis (a activação e a desactivação acontecem com dois
comandos distintos) ou como Monoestáveis (a Saída permanece activa durante o Tempo de ON, depois do qual retorna em
situação de repouso, ou até ser desativada com o SMS específico). Além disso, cada saída pode ser programada para dar um
sinal de confirmação (um SMS precedentemente programado se a activação/desactivação da saída for realizada mediante SMS,
ou um toque de confirmação se a activação/desactivação acontecer mediante o reconhecimento do emissor da chamada).
 Para maiores informações sobre os termos “Linha de Controlo” e “Código Utilizador” utilizados nos parágrafos

a seguir, referir-se ao parágrafo “I/O” e “Options->Codes” do capítulo “PROGRAMAÇÃO COM O PC”.
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Saídas Biestáveis (somente para a série BGSM-120)
As Saídas Open Collector configuradas como Biestáveis podem ser activadas de 2 formas:
1. Pode-se enviar um SMS formado pelo Código Utilizador entre os caracteres # , pela Linha de Controlo (no começo

da Linha de Controlo não deve haver espaços vazios) e pelos caracteres “=ON#” conforme a sintaxe a seguir:

#Código Utilizador#Linha=ON#   (exemplo: #9876#LUZCASA=ON#)

2. Mediante o reconhecimento do emissor da chamada: neste caso, a Saída é activada a “custo zero” já que o
dispositivo, após ter reconhecido o emissor da chamada, recusa a chamada e activa a saída.

 A desactivação de uma Saída OC do tipo Biestável pode ser realizada SOMENTE após o envio de uma
mensagem SMS formada pelo Código Utilizador entre os caracteres #, pela Linha de Controlo e pelos caracteres
“=OFF#” conforme a sintaxe a seguir:

#Código Utilizador#Linha=OFF#   (exemplo: #9876#LUZCASA=OFF#)

 O Código Utilizador configurado na fábrica é “0001”; para substitui-lo, consulte o parágrafo “Programação via
SMS->Modificar o Código Utilizador”.

Saídas Monoestáveis
As Saídas OC configuradas como Monoestáveis podem ser activadas de duas formas, mediante o Reconhecimento do
Emissor da Chamada e mediante SMS (somente para BGSM-120).

SMS (somente para a série BGSM-120)
Enviar um SMS no formato do Código Utilizador, entre os caracteres #, pela Linha de Controlo (no começo da Linha
de Controlo não deve haver espaços vazios) e pelos caracteres “=ON#”, “=ON#TonU#” ou como “=OFF#” conforme a
sintaxe a seguir:

#Código Utilizador#Linha=ON#
#Código Utilizador#Linha=ON#TonU#

#Código Utilizador#Linha=OFF#

O parâmetro “=ON#TonU#” permite configurar o Tempo de ON de 1 segundo a 86400 segundos com intervalos de 1
segundo.  O Tempo de ON pode ser configurado também através do software de programação do Comunicador. A sintaxe
“Ton” representa o valor e “U” a unidade indicada em H (horas) M (minutos) e S (segundos), veja os exemplos abaixo:

 Para activar a saída através de SMS respeitando a programação, eliminar o parâmetro “TonU” deixando os
caracteres “##”.

(exemplo: #9876#LUZCASA=ON##)

Reconhecimento do Emissor da Chamada
A Saída é activada a “custo zero” já que o dispositivo, após ter reconhecido o emissor da chamada, recusa a chamada e
activa a saída.
 As Saídas Open Collector do tipo Monoestáveis voltar ao repouso após o Tempo de ON programado.
 Somente a Saída T3 do BGSM-100 pode ser activada mediante o Reconhecimento do Emissor da Chamada.
O Tempo de ON pode ser definido de 1 segundo a 86400 segundos, com intervalos de 1 segundo.
 O Código Utilizador configurado na fábrica é “0001”; para substitui-lo, consulte o parágrafo “Programação via

SMS->Modificar o Código Utilizador”.

SMS Modalidade de funcionamento das
saídas

#9876#LUZCASA=ON# Activação Biestáveis
#9876#LUZCASA=ON#3600S# Activa por 3600 segundos
#9876#LUZCASA=ON#50M# Activa por 50 minutos

#9876#LUZCASA=ON#3600# Activa conforme programação software,
o Tempo de ON configurado é inválido
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PROGRAMAÇÃO VIA SMS (para a série BGSM-120)
Além daquelas descritas no parágrafo Activação e Desactivação das Saídas com comando remoto, podem-se efectuar
outras operações desde remoto através do envio de oportunas mensagens SMS.

Modificar o Código Utilizador
O Código Utilizador é configurado na fábrica como ‘0001’; para substitui-lo, envie uma mensagem SMS formada pelos caracteres
“#CUC” seguidos pelo velho Código Utilizador e pelo novo Código Utilizador entre os caracteres * conforme a seguinte sintaxe:

#CUC*Código Utilizador*Novo Código Utilizador*
Irá receber uma confirmação SMS se o Código Utilizador foi alterado.
 Para a composição do Código Utilizador podem ser utilizados apenas os números de 0 a 9 (no máximo 4 cifras).

Habilitar/Desabilitar a programação remota
A programação remota permite utilizar através da rede as funções oferecidas pela aplicação BGSM-120/BGSM-100 Console. Para
comandar de remoto os parâmetros do Comunicador, é necessário habilitar a programação remota, isto pode ser feito usando o software
BGSM-120/BGSM-100 Console (consulte o parágrafo Programação desde PC->GPRS->Web Service), ou enviando uma mensagem
SMS formada pelos caracteres “#UWS” seguidos pelo Código Utilizador e por “ON” entre os caracteres * conforme a seguinte sintaxe:

#UWS*Código Utilizador*ON*
Para desabilitar a programação remota, envie a seguinte mensagem SMS:

#UWS*Código Utilizador*OFF*
Um SMS confirma se o comando foi bem sucedido.

Modificar o Código Instalador
O Código Instalador (no máximo 4 caracteres numéricos) é utilizado, em caso de necessidade, para o acesso à interface
Remote Programming (consulte o parágrafo PROGRAMAÇÃO COM O PC->Codes->Installer code). O Código Instalador
é configurado na fábrica como “0002”; para substitui-lo, envie uma mensagem SMS formada pelos caracteres “#CIC”
seguidos pelo velho Código Instalador e pelo novo Código Instalador entre os caracteres * conforme a seguinte sintaxe:

#CIC*Código Instalador*Novo Código Instalador*
Irá receber uma confirmação SMS se o Código Instalador foi alterado.
 Para a composição do Código Utilizador podem ser utilizados apenas os números de 0 a 9 (no máximo 4 cifras).

Controlo do crédito resíduo
Para conhecer o crédito resíduo através de uma mensagem SMS, é possível atuar através do software BGSM-120/BGSM-
100 Console (consulte o parágrafo PROGRAMAÇÃO COM O PC->Otions->Pay As You Go), ou desde remoto, enviando
uma mensagem SMS formada pelos caracteres “#CCC” seguidos pelo caractere * conforme a seguinte sintaxe:

#CCC*
 O SMS com o crédito resíduo é enviado ao Número de Telefone #1 da agenda telefónica.

A critério de cada operador de rede GSM, o serviço de gestão crédito das SIM CARD pré-pagas pode ser suspenso.

PROGRAMAÇÃO COM O PC
 Para o correcto funcionamento deste Comunicador, use o cartão SIM de 32 K ou superior.
Para efectuar a Programação com o PC é necessário o cabo PC-Link (não fornecida), ligado entre o Conector [9] do Comunicador e
uma porta COM do PC (ver a Fig. 5) e a aplicação BGSM-120/BGSM-100 Console. Para a ligação, é possível utilizar o cabo PC-link
representado na figura 5a, ou o cavo PC-Link representado na figura 5b. Preste atenção ao sentido de introdução do conector do cabo
PC-link utilizado. Após ter efectuado a ligação, seleccione a porta COM usando a opção do Menu Options->Serial ports. Caso haja
um problema de comunicação, verificar a ligação e as configurações da porta serial ou utilizar um conversor USB-serial diferente.
 Para instalar e executar o aplicativo BGSM-120/BGSM-100 Consola, é necessário possuir os direitos de

Administrador do PC; aconselhamos ainda que verifique as opções do firewall, se ocorrerem problemas
durante a instalação do aplicativo.
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Abrir a Programação
Para abrir a programação do Comunicador e visualizá-la no PC, seleccione o ícone Upload from board .

Enviar a Programação
Após ter efectuado a Programação para um novo cliente (ou alterado as definições de um cliente carregado anteriormente),
envie a programação ao Comunicador, utilizando o ícone Download to board .

Operações preliminares
No momento da execução da aplicação abre-se a janela principal; na parte superior do lado esquerdo da mesma,
seleccionando com um clique do rato a opção do menu Untitled #1, aparecem duas secções.
 Na secção dos parâmetros gerais estão presentes as seguintes aplicações:

Customer informations: nesta secção é possível configurar a série do Comunicador (BGSM-100 ou BGSM-120),
além de solicitar e actualizar a configuração relativa a um cliente com o seguinte procedimento:
1. Clique com a tecla esquerda na aplicação.
2. Insira ou actualize os dados correspondentes ao cliente e à instalação. Confirme com a tecla .
Upload from board: seleccionando este ícone os dados programados na placa são carregados no PC.

Download to board: seleccionando este ícone os dados programados são enviados à placa. O envio ao dispositivo de toda
a programação ou das páginas GPRS, I/O (só para BGSM-120) e Options (só para BGSM-100) reiniciam o Comunicador.
Factory defaults: ao seleccionar este ícone, restabelece-se a programação original de fabrico. Evidenciamos que
o restabelecimento de tal programação não apaga as mensagens vocais gravadas.
Board reset: seleccionando este ícone provoca o reset do Comunicador.

 Na secção comum à série BGSM-100 e BGSM-120 encontram-se as seguintes aplicações.

Phonebook: página relativa à agenda telefónica.

Options: página das opções.

GPRS: página parâmetros GPRS.

Status: página para controlar o Comunicador.

PTM: página para configurar as características da função PTM.

Fig. 5 -  Esquema do cabo de ligação PC-Link.
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 As páginas sucessivas são disponíveis somente para o Comunicador da série BGSM-120.

I/O: nesta página são programados os parâmetros para as saídas/entradas do Comunicador.

Voice Dialer: página onde configurar todos os parâmetros relativos ao sinalizador vocal.

SMS Dialer: nesta página são programadas todas as opções do sinalizador SMS.

Voice Message: página para a gestão das mensagens vocais.
Se desejar iniciar a programação para um novo cliente, seleccione a opção do Menu File->New.
Para visualizar a Lista dos Clientes carregados no arquivo, seleccione a opção do menu File->Open. Nesta secção é
possível eliminar ou abrir a configuração relativa a um cliente realizando as seguintes operações:
1. Clique com a tecla direita do rato no nome desejado.

2. Seleccione Load  para carregar os dados do arquivo para o Hard-Disk ou Delete selected customer  para
eliminar definitivamente o cliente e todos os seus dados do arquivo.
Para carregar um Cliente também é possível efectuar um clique duplo no nome do mesmo.
Também é possível ordenar a lista alfabeticamente ou por código com um clique do rato no cabeçalho da respectiva coluna.

Todos os parâmetros a programar estão agrupados nas páginas seguintes. A página (Status) serve para o controlo e a
gestão do Comunicador. Neste capítulo são descritas detalhadamente as páginas presentes na aplicação.

Phonebook
Nesta página podem ser memorizados até 100 números de telefone.
 O crédito restante do cartão pré-pago é enviado, através de SMS, ao número de telefone #1.
 Description: digite um string alfanumérico de 16 caracteres no máximo
 Telephone number: digite um número de telefone precedido pelo indicativo internacional, com o formato "+xxx"

(exemplo: +351 para Portugal). São permitidos 16 dígitos no máximo (o caractere "+" conta como um dígito).
 Activates Output: seleccionar os números telefónicos que podem activar as Saídas T1 (OC1), T2 (OC2) e T3 (OC3)

quando o Comunicador receber uma chamada deles. Esta função não depende das opções de White List ou Black
List (página Options->Dial options). Para activar a saída, é necessário que esteja habilitado o serviço de identificação
do Emissor da Chamada (Calling Line Identifier).

 Para a série BGSM-100 é possível activar somente a Saída T3 (OC3).
 Para a activação da saída, na série BGSM-120, programar os terminais T1 (OC1), T2 (OC2) e T3 (OC3) como

“Output” e habilitar “Reserved Output” (veja as páginas I/O->Type e I/O->Reserved Output).
 Ouput Activation Confirmation: esta opção é disponível somente para a série BGSM-120, habilitar este campo para

receber um toque de confirmação da activação da saída.
 ATENÇÃO:

– O toque é recebido após 1 minuto da activação da saída.
– Se o Comunicador estiver ocupado com uma operação (por exemplo: o canal GSM está ocupado numa
comunicação vocal) o toque de confirmação não será efectuado.
– A opção “Ouput Activation Confirmation”  interrompe a chamada em entrada após aproximadamente 5
segundos, mesmo se a opção “Black List” não estiver habilitada.

  White List:  habilitar ou desabilitar   a janela White List consente ao Comunicador de aceitar ou recusar as
chamadas em entrada. O Comunicador aceita as chamadas em entrada encaminhando-as para os aparelhos telefónicos
ligados aos terminais LI (por exemplo uma central antifurto); isto só é possível se LI estiver a funcionar como linha
simulada via GSM. O modo de funcionamento da opção White List depende da selecção  ou não  da janela Black
List, presente na página Options->Dial options, como pode-se ver na tabela a seguir:

White List Black List Modo de funcionamento
  Aceita chamadas em entrada de qualquer número
  Recusa qualquer chamada em entrada

 
Aceita chamadas em entrada somente dos números com a
opção White List desabi li tada, recusa as chamadas
provenientes de todos os outros números.
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Options
Esta página serve para configurar as opções relativas à placa.

Dial options
Esta parte serve para definir algumas características relativas aos números de telefone.
 Prefix: o número definido nesta caixa é anteposto a qualquer número de telefone chamado pelo Comunicador na

modalidade Interface GSM. Digite o prefixo desejado (de 1 a 8 dígitos) ou deixe a caixa vazia se não utilizada.
 Digits to Remove:se este Comunicador estiver ligado após uma central telefónica, os números de telefone (programados na central)

têm de ser precedidos pelo número da central (normalmente um dígito). Visto que o número da central não é necessário quando as
chamadas são enviadas pela rede GSM, esse tem de ser removido dos dígitos que compõem o número de telefone. Digite o número
de dígitos que compõem o número da central telefónica (ex.: se o número da central for 01, digite 2 no campo “Digits to Remove”).

 O número de telefone tem de ter pelo menos mais dois dígitos em relação ao número digitado no campo
“Digits to Remove”, senão é originado o sinal de ocupado, exemplo:
— o número de telefone digitado é 0123, o número de dígitos a remover é 2 = correcto, o número marcado restante é 23.
— o número de telefone digitado é 123, o número de dígitos a remover é 2 = sinal de ocupado, o número
marcado restante é 3.

 Enable Black List: eleccionar esta célula para não receber chamadas desde os números telefónicos; somente os
números precedentemente seleccionados mediante a célula White List (página Phonebook->White List).

 A função “Black List” interrompe a chamada imediatamente.
 A função “Black List” COMBINADA com a função “Activates Output” com reconhecimento do chamante

produz o cancelamento da chamada atrasada de alguns segundos;
O toque de confirmação associado à função “Activates Output” com reconhecimento do chamante produz
o cancelamento da chamada atrasado de alguns segundos;
Se a chamada for cancelada imediatamente, a acção de activação da saída não terá êxito positivo.

Event priority (somente para a série BGSM-120)
Nesta página podem ser programadas algumas prioridades do Comunicador para a transmissão dos eventos de alarme
(ver o parágrafo Gestão das Prioridades).
 Off-Hook: esta opção possibilita a definição da prioridade dos dispositivos telefónicos ligados aos terminais LI (por

exemplo, uma central anti-furto). A opção tem habilitação de fábrica , para desabilitá-la desmarcar a célula .
   Voice Dialer: esta opção permite de definir a prioridade do Sinalizador vocal (mensagens vocais). A opção é

desabilitada de fábrica , para habilitá-la marcar a célula .

Codes (somente para a série BGSM-120)
 User Code: nesta célula deve ser digitado o código utilizador (no máximo 4 caracteres numéricos) para a activação

remota das Saídas. Para demais informações, favor consultar o parágrafo “Activação das Saídas->Activação e
Desactivação das Saídas com comando remoto”. A configuração de fábrica do código é ‘0001’.

 Installer Code: neste campo é possível digitar o código instalador (no máximo 4 caracteres numéricos). Este código permite,
em caso de necessidade, o acesso à interface Remote Programming. A configuração de fábrica do código é ‘0002’.

Generic
Nesta secção é possível definir os níveis áudio do altifalante e do microfone do Comunicador GSM.
 Speaker volume: deslocando o cursor é possível regular o volume do altifalante.
 Microphone volume: deslocando o cursor é possível regular o volume do microfone.
 Um volume elevado do microfone pode corromper os tons DTMF, provenientes dos aparelhos ligados aos

terminais LI, tornando-os irreconhecíveis.
 Tones...: seleccionar o nome do país de instalação do Comunicador; o país seleccionado estabelece uma série de

parâmetros para o correcto funcionamento da linha telefónica simulada.
 LE failure timeout: digite o tempo em segundos (de 10 a 3600 segundos), para a falha da linha nos terminais LE,

antes de ocorrer o evento PSTN Fault.
 Se houverem dispositivos telefónicos ligados aos terminais LI o tempo pode aumentar até um máximo de

cerca de 60 segundos.
 LE restore timeout: digite o tempo em segundos (de 30 e 3600 segundos) que a linha telefónica tem de estar presente

nos terminais LE, antes do evento PSTN Fault ser restaurado.
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System (somente para a série BGSM-120)
Esta parte refere-se à Sistema.
 SIM Phone Number: digitar o número telefónico relativo à SIM CARD do Comunicador (máx.16 algarismos).
 Auto Clock Adjusting: ao seleccionar este campo, o dispositivo actualizará a data e a hora do sistema, enviando-se

automaticamente um SMS.
 SMS Service Center Address: esta é uma opção só de leitura. Mostra o número do centro de serviços SMS na SIM CARD.

Pay As You Go (somente para a série BGSM-120)
 A critério de cada operador de rede GSM, o serviço de gestão crédito das SIM CARD pré-pagas pode ser suspenso.
Mediante esta secção pode-se enviar periodicamente, ao primeiro número da lista de contactos, um SMS que contém as
informações fornecidas pelo operador sobre o crédito resíduo. Programa as seguintes opções para um correcto pedido do
crédito resíduo conforme o tipo de operador em uso:
 Enquiry Type: escolha do tipo de pedido (SMS, Call, Service Command).
 Enquiry Number: número telefónico a chamar ou ao qual mandar um SMS para solicitar a informação do crédito resíduo.
 Balance Message: linha de comando utilizada para enviar o SMS e para solicitar através de comando de rede (Service Command).

Exemplo para os operadores Italianos
Opções Vodafone Wind TIM

Enquiry Type Call Service Command SMS
Enquiry Number 404 40916
Balance Message *123# PRE CRE SIN

 Interval: digitar nestas células o intervalo (HH-DD) dentro do qual enviar um SMS Periódico com as informações acerca
do crédito resíduo (se gerido pelo operador telefónico). O intervalo é composto pelos seguintes valores:
— (HH) hora envio sucessivo - Seleccionar o valor para o envio do SMS Periódico sucessivo. O intervalo dos valores
admissíveis vai de 0 a 23.
— (DD) dia envio sucessivo - Seleccionar o valor para o envio do SMS Periódico sucessivo. O intervalo dos valores
admissíveis vai de 0 a 365.

Outputs (somente para a série BGSM-100)
Nesta secção é possível definir as modalidades de funcionamento das saídas.
 Output 1, Output 2, Output 3: seleccione a caixa para o funcionamento da saída como “normalmente fechada” ou

“normalmente aberta”.
 Output 3 ON Time: neste campo é possível definir o Tempo de ON em segundos (de 0 a 86400 segundos).

Primary Path
O utilizador pode programar a linha primária de comunicação.
 Primary Path: seleccione nesta opção a linha primária GSM ou PSTN.

GPRS
Esta página serve para configurar os parâmetros relativos ao GPRS.
 Considerados os possíveis atrasos de transmissão via GPRS, dependentes das actividades do gestor da rede,

aconselha-se programar um número o número mais alto possível de tentativas de chamada na central anti-furto,
e prever eventualmente um número telefónico de backup que transmita os alarmes via GSM ao invés de GPRS.

Access Point Name 1 e Access Point Name 2
Este é um dado que geralmente tem de ser solicitado ao operador que fornece o serviço GPRS. Digite nestas caixas o
nome do serviço que fornece o endereço IP. Access Point Name 2 é considerado um parâmetro de backup.
 ATENÇÃO: digite o APN para serviços WAP/GPRS correto, caso contrário algumas funções podem ficar

limitadas (para obter mais informações contacte o operador do centro de serviços).

Main Receiver, Local Port 1 e Alarm Port 1 IP address
Nesta caixa tem de ser digitado o endereço IP do receptor e o número da porta. Para os receptores SYSTEM III e SYSTEM
II digite o Endereço IP e a porta presentes na secção Alarm Port.



BGSM-100/120 65

PPPPP

Backup Receiver, Local Port 2 e Alarm Port 2 IP address
Esta caixa prevê a definição do segundo endereço IP do receptor e do número da porta, com a diferença que estes
parâmetros são considerados como receptor de backup. O Comunicador reconhece esta opção somente no caso em
que tenham sido inseridos os parâmetros relativos a Main Receiver, Local Port 1 e Alarm Port 1. Além disso, as
opções Enable supervision e Supervision time referem-se somente ao receptor primário (Main Receiver).

APN1 Username e Password, APN2 Username e Password
Para alguns operadores é necessário inserir a autenticação da comunicação, por isso, se solicitado, digite nestas caixas o Nome do
utilizador e a Palavra-passe correspondente. O Password e a APN2 Username são considerados dados de backup.

Telephone numbers to decode
Este comunicador permite comunicar os eventos no formato Contact ID, através da rede GPRS, mesmo aos painéis de
controle que não suportam este método de comunicação.
Para isso, tem de configurar um número de telefone (os números de telefone podem ser "virtuais" ou "reais") no painel de
controlo, para a comunicação de eventos em formato Contact ID (por exemplo, pode configurar 0123), depois tem de digitar
o mesmo número de telefone numa destas caixas (pode configurar até quatro números de telefone para esta função).
Quando o Comunicador reconhece uma chamada de um destes números, comuta automaticamente o evento para formato digital
e transmite-o através da rede GPRS para o receptor configurado (consulte as opções “Main Receiver” e “Backup Receiver”).
 O número de telefone tem de ter pelo menos 2 algarismos.

As opções “Prefix” e “Digits to Remove” não têm qualquer efeito nos “Telephone numbers to decode”.
Os “Telephone numbers to decode” tem de coincidir exactamente com os números de telefone definidos no painel
de controlo.
Deixe estas caixas vazias se não usar esta função.
Para o funcionamento correcto desta função têm de ser definidas as opções do "Main Receiver" e
eventualmente do "Backup Receiver".

DNIS
Insira o código de identificação unívoco (se solicitado).

Account code
Nesta célula deve ser digitado o Código identificativo para a comunicação com os receptores SYSTEM III ou SYSTEM II.

Enable Supervision
Para habilitar a supervisão seleccione esta caixa. A opção supervisão está disponível APENAS para o receptor primário
(Main Receiver). As mensagens de supervisão não são enviadas durante as chamadas vocais (no GSM).

Supervision time (sec)
Defina o Tempo de supervisão. É possível definir um Tempo de Supervisão de um 5 segundos no mínimo até um máximo
de 65535 segundos, com intervalos de 1 segundo.

Programação remota (somente para a série BGSM-120)
Esta interface permite utilizar, através da rede, as funcionalidades oferecidas pela aplicação software BGSM-120/BGSM-100
Console. Através desta interface é possível a gestão desde remoto dos parâmetros do Comunicador. Para utilizar esta
função, é necessário conectar-se ao endereço http://www.bentelreachme.com.
 Enabled: para habilitar a programação remota, clique neste campo para inserir a selecção  (a opção tem habilitação de fábrica).
 Encryption key: é possível configurar a chave criptográfica para que a programação remota fique protegido contra

acessos não autorizados. A chave criptográfica pode ser constituída de 1 a 32 caracteres hexadecimais. O valor
configurado de fábrica é 0 (a chave criptográfica não é utilizada).

Status
Esta página permite o controlo em tempo real de todas as funções do Comunicador.
 ATENÇÃO - Esta página é actualizada a cada 5 segundos.

Status section
Nesta secção são indicados os dados mais importantes do Módulo GSM. No visor virtual, além do nome do gestor da Rede
GSM, é visualizado o nível do sinal GSM, este através de um indicador.



66 Comunicadores de Alarme GSM/GPRS

Os indicadores de Estado do Comunicador podem estar acesos ou apagados, quando são VERDE significa funcionamento correcto;
quando são VERMELHOS significa que está presente uma anomalia de funcionamento ou uma situação de avaria; se forem LARANJA
significa que há uma comunicação em curso. Os indicadores luminosos dos Receptores GPRS primário (Main) e de reserva (Backup)
são LARANJAS quando o dispositivo foi inicializado mas NÃO ligado, ou quando está ligado mas ainda NÃO inicializado.

PTM
Esta página refere-se à Função PTM, (Panel Transmission Monitoring - Controlo Transmissão Central) permite ao
Comunicador o envio de chamadas mediante a rede GSM no caso em que a comunicação entre a central de alarme e a
central de vigilância não tenha êxito na linha telefónica PSTN.
 O Comunicador volta ao modo normal depois de 5 minutos no canal GSM.
A função PTM considera uma comunicação falhada quando:
– Não detecta a composição do número, se estiver habilitada a opção “Check Dialling” (controla que seja efectuada de

facto a composição de um número telefónico).
– Não detecta o Kiss-off (o sinal que é enviado pelo receptor após a conclusão de uma comunicação eventos efectuada com sucesso).
 A frequência do sinal de Kiss-off é de 1400Hz.
O controlo é efectuado em todos os números, se a lista de “Telephone Numbers” estiver vazia, ou só nos números presentes na lista.
As chamadas são encaminhadas no canal GSM quando se alcança o “Maximum Failure Number” programado.
 Telephone Number: inserir os números telefónicos (até um máximo de 4) a serem chamados, mediante a função

PTM. Como configuração de fábrica, estes campos são vazios. Se estes campos estiverem vazios, todos os números
compostos pela central serão controlados pela função PTM (Kiss-off esperado no fim da comunicação).

 Check Dialling: de fábrica é desabilitado, se habilitado força a contar o número de erros devido à ligação e à desligação
(sem compor algum número de telefone) do aparelho telefónico ligado aos terminais LI como erro.

 Max Failures: inserir neste campo o número total dos erros detectados pelo Comunicador além do qual é activada a função PTM.
A função PTM foi desabilitada na fábrica (a configuração de fábrica é 0); configurar um valor de 1 a 4 para habilitar a função PTM.

I/O (somente para a série BGSM-120)
Nesta página são programadas as modalidades Entrada ou Saída, os eventos de activação para as Saídas, a sua Polaridade em
repouso (N.F. ou N.A.), as Saídas Reservadas, as linhas de comando SMS de Activação remota para as Saídas Reservadas.
 Type: nesta coluna é possível programar os terminais T1, T2 e T3 para as seguintes modalidades:

– Input: seleccionar esta modalidade para habilitar o terminal correspondente como Linha de Entrada. A selecção desta
modalidade activa a coluna Service (favor ver a seguir).
– Output: seleccionar esta modalidade para habilitar o terminal correspondente como Saída Open-Collector.

 Estas configurações actualizam automaticamente também os parâmetros nas páginas “SMS dialer”, “Voice dialer” e “Phonebook”.
 Polarity: Neste célula programa-se o estado da saída/entrada em repouso:

– Normalmente Fechado  com a Saída/Entrada em repouso, o terminal correspondente resulta aterrado (negativo).
– Normalmente Aberto  com a Saída/Entrada em repouso, o terminal correspondente resulta desconectado.
Fazer clique na célula correspondente à coluna “Polarity” para inverter o parâmetro visualizado naquele momento.

 Activation events: fazer clique na coluna relativa ao evento a ser programado em correspondência da relativa saída. A selecção  estará
a indicar que em presença de tal evento, será activada a relativa Saída. Fazer clique nas células para inserir/remover a selecção .

 A programação dos eventos associados a uma saída implica a desabilitação dalgumas células relativas à
mesma saída. Antes de poder programar, é preciso remover as selecções   inseridas nas várias células.
– PSTN Fault: se seleccionada, a saída será activada em caso de ausência da linha telefónica.
– GSM Fault: se seleccionada, a saída será activada se vier a faltar a rede GSM.
– HB Fail: se seleccionada, a saída será activada em caso de ausência do mensagem de supervisão.
– FTC Signal: se selecionada, a saída é ativada se a comunicação não for bem sucedida.

 A seleção do evento “FTC Signal” habilita a opção “Monostable” e permite definir o “Monostable Time”.
 Reserved Output: ao seleccionar esta opção, todos os outros eventos seleccionados para activar a Saída correspondente são

ignorados. Fazer um click no campo correspondente à Saída a ser activada através do reconhecimento do emissor da chamada
ou através do comando SMS. Para a activação da saída com reconhecimento do emissor da chamada, programar o número de
telefone na página “Phonebook” e habilitar a opção “Activates Output” (veja a página Phonebook->Activates Output).

  Service: um símbolo de selecção  nesta coluna indica que o Comunicador está em estado de SERVIÇO, isto é, em presença
dos eventos de desbalanceamento sobre Linhas de Entrada 1 e 2; ao invés de realizar uma chamada, o Comunicador realizará
autonomamente uma determinada acção. Para cada Linha é possível definir uma acção conforme a tabela a seguir. Em todo caso,
ao seleccionar estas acções, não são nunca enviadas mensagens SMS em correspondência das Entradas 1 e 2.
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Linha
Entrada n. Selecção Função de Serviço associada

1 A Comutação forçada para rede GSM
2 B Cancela Fila Telefónica

 Estas configurações actualizam automaticamente também os parâmetros nas páginas “SMS dialer”, “Voice dialer” e “Phonebook”.
 Control String: digitar nesta coluna a linha de comando (máximo 16 caracteres alfanuméricos) que deve ser enviada quando

se quer activar/desactivar a Saída correspondente desde remoto. Esta função também fica operativa se o reconhecimento de
quem chama não estiver habilitado.

 Activation Confirmation: nesta coluna deve ser
seleccionado o tipo de confirmação que se deseja obter
quando a Saída será activada. A escolha é possível
para 3 diversos valores: Nenhuma (None), Toque (Ring)
ou SMS (este último valor não está disponível se a
célula “Control string” for deixada vazia). Se a saída
for activada através do envio de um SMS a confirmação
da activação da saída será enviada via SMS.

 Monostable: normalmente as Saídas, quando activadas,
permanecem em estado de activação até o comando sucessivo
de desactivação, quando a mesma Saída retornará ao estado
de repouso. Se desejar que a Saída, uma vez activada, retorne
automaticamente ao estado de repouso após determinado tem-
po, seleccionar esta opção e configurar o tempo de activação
na célula “Monostable Time (sec)” adjacente.

  Monostable Time (sec): nesta célula deve ser digitado um valor em segundos (de 1 até 86400, somente inteiros) que indica o tempo
pelo qual a Saída, se configurada como Monoestável, permanece activa antes de retornar novamente ao estado de repouso (ON time).

Voice Dialer (somente para a série BGSM-120)
Nesta secção são programados todos os parâmetros relativos ao sinalizador vocal, ou seja: os números telefónicos a serem
chamados (os primeiros 8 da lista de contactos), o número de repetições para cada mensagem (mínimo 1 máximo 8), a
duração e o número das mensagens conforme quanto especificado a seguir:
 Description: nesta coluna são listados os eventos para os quais pode-se programar uma mensagem vocal.
 Para seleccionar as mensagens vocais para as 3 Linhas de Entrada programáveis, configurar o terminal

correspondente como Entrada (ver página I/O->Type).
 Telephone numbers: fazer clique nas colunas ‘12345678’ em correspondência do evento desejado. A marca de selecção  indicará

que aquele número telefónico será chamado ao verificar-se dum evento. Fazer clique nas células para inserir/remover a selecção .
 Os números telefónicos são os primeiros 8 programados na página “Agenda Telefónica”.
 Voice Message: fazer clique três vezes na coluna ‘Message’ em correspondência do evento desejado, em seguida clicar no botão para

visualizar o elenco das mensagens (pode-se seleccionar, se gravadas, até 8 mensagens de duração máxima de 16 segundos cada
uma) e seleccionar uma. Podem ser ligadas até 3 mensagens vocais para cada evento (Message #1, Message #2, Message #3).

 Repeat Call: neste campo pode-se inserir o número de tentativas a serem realizadas (até um máximo de 8 vezes) se
a chamada não for completada.

 Repeat Message: neste campo é possível inserir o número de repetições da mensagem vocal (até um máximo de 8
vezes) quando o número chamado responder.

 Call All Numbers: seleccionar esta opção  para chamar todos os números telefónicos programados para um único
evento e então reproduzir a mensagem vocal correspondente. Se esta opção não for seleccionada  , o sinalizador
terminará as chamadas vocais tão logo uma delas for completada.

 Call Confirmation: seleccionar esta opção para que o sinalizador aguarde a confirmação por parte do utilizador remoto do
efectivo recebimento da mensagem vocal, caso contrário o sinalizador tentará novamente o envio da mensagem vocal: o
utilizador remoto pode enviar a confirmação pressionando a tecla  do seu telefone (válido somente para os telefones a tons).

 Ao ouvir uma mensagem vocal, mediante a pressão da tecla  do próprio aparelho telefónico, é possível
bloquear o telefonema em andamento assim como todos os outros eventualmente em andamento.

 Em alguns casos o comunicador pode interpretar mal a resposta de secretarias automáticas, atendedores,
mensagens de cortesia do operador GSM, etc. por isso recomenda-se a habilitação da opção "Call Confirmation".

Tabela Efeitos Activação Saída
PROGRAMAÇÃO EFEITOS

Black
List

White
List

Activation
Confirmation

Chamada Enviada
(só se o Comunicador estiver

comutado na rede GSM)

Toque
Confirmação

  None SI NO
  Ring NO SI
  None SI NO
  Ring NO SI
  None NO NO
  Ring NO SI
  None SI NO
  Ring NO SI

Habilitado
Deshabilitado
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Periodic voice
Nesta secção são programadas as opções relativas ao envio da Mensagem Vocal Periódica.
 TEM de digitar o “SIM Phone Number” e habilitar “Auto Clock Adjusting” na página “Options” para

configurar as opções da Mensagem Vocal Periódica.
 Date of first send: seleccionar a data para o envio da primeiro Mensagem Vocal Periódica.
 Time of first send: seleccionar a hora para o envio da primeiro Mensagem Vocal Periódica.
 Interval: digitar nestas células o intervalo (HH-DD) entre o qual enviar as sucessivas Mensagens Vocais Periódicas.

O intervalo é composto pelos seguintes valores:
— (HH) hora envio sucessivo - Seleccionar o valor para o envio do sucessiva Mensagem Vocal Periódica. O intervalo
dos valores admissíveis vai de 0 a 23.
— (DD) dia envio sucessivo - Seleccionar o valor para o envio da Mensagem Vocal Periódica. O intervalo dos valores
admissíveis vai de 0 a 365

 Update time: ao seleccionar este ícone, é possível obter a data e a hora do PC.

Local Service Mode
Ao seleccionar o botão Local service mode, pode habilitar a reprodução/gravação das mensagens vocais através de um
telefone, ligado aos terminais [LI] do dispositivo (consulte “Gravação das Mensagens Vocais em modalidade Local” e
“Reprodução das Mensagens Vocais em modalidade Local”). Quando esta modalidade estiver habilitada, os LED Verdes
L1 e L2 piscam (ver Leds de controlo->tabela 2). A intermitência dos LED termina somente no fim do procedimento de
gravação ou reprodução ou após terem transcorrido 60 segundos sem apertar nenhuma tecla.
 Pode ligar APENAS UM telefone aos terminais [LI] para garantir o funcionamento correcto do Local Service

Mode.

SMS Dialer (somente para a série BGSM-120)
Esta página serve para configurar as opções do SMS dialer, como indicado abaixo.
 Event Type: na coluna ‘Event Type’ são descritos, para cada uma das 11 linhas, os eventos em presença dos quais

é previsto, se oportunamente programado, o envio de dois SMS: um de activação, o outro de Restabelecimento (para
o evento ‘Periodic SMS’ é previsto somente o envio da Mensagem SMS de activação).

 Para seleccionar as mensagens SMS para as 3 Linhas de Entrada programáveis, configurar o terminal
correspondente como Entrada (ver parágrafo I/O->Type).

 Telephone numbers: fazer clique nas colunas ‘12345678’ em correspondência da entrada desejada. A marca de
selecção   indicará que àquele número telefónico será enviada uma mensagem SMS ao verificar-se do evento
correspondente.

 Os números telefónicos são os primeiros 8 programados na página “Phonebook”.
 SMS String: na coluna ‘SMS String’ clicar na célula correspondente à mensagem a ser programada e digitar a

mensagem a ser enviada ao verificar-se do evento correspondente (máximo 100 caracteres).

Periodic SMS
Nesta secção são programadas as opções relativas ao envio do SMS Periódico.
 TEM de digitar o “SIM Phone Number” e habilitar “Auto Clock Adjusting” na página “Options” para

configurar as opções do SMS Periódico.
 Date of First Send: seleccionar a data para o envio do primeiro SMS Periódico.
 Time of First Send: seleccionar a hora para o envio do primeiro SMS Periódico.
 Interval: digitar nestas células o intervalo (HH-DD) entre o qual enviar os sucessivos SMS Periódicos. O intervalo é

composto pelos seguintes valores:
— (HH) hora envio sucessivo - Seleccionar o valor para o envio do SMS Periódico sucessivo. O intervalo dos valores
admissíveis vai de 0 a 23.
— (DD) dia envio sucessivo - Seleccionar o valor para o envio do SMS Periódico sucessivo. O intervalo dos valores
admissíveis vai de 0 a 365.

 Update time: ao seleccionar este ícone, é possível obter a data e a hora do PC.
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Voice Message (somente para a série BGSM-120)
Nesta secção é possível gerir a gravação e a reprodução das mensagens vocais: consulte a página Voice Dialer para
associar a mensagem aos eventos. Para abrir o arquivo da mensagens vocais, fazer clique no ícone à esquerda do botão
RECORD, à direita do campo “WAV File#”.
 O Comunicador suporta somente ficheiros áudio WAVE (.WAV) com no máximo 16 segundos de duração,

com as seguintes características: PCM, 8000 Hz, 8 bit, Mono, não comprimido. É possível utilizar ficheiros
pré-gravados que respeitem o formato indicado.

Botão PLAY - Pressionar este botão para ouvir novamente a mensagem vocal.

Botão RECORD - Pressionar este botão para iniciar a gravação duma nova mensagem vocal.

Botão STOP - Pressionar este botão para parar a reprodução ou a gravação em andamento da mensagem vocal.

Botão GET - Pressionar este botão para carregar a mensagem vocal gravada.

Botão SET - Pressionar este botão para enviar ao Comunicador a mensagem vocal gravada.

Botão ERASE - Pressionar este botão para cancelar diretamente a mensagem de voz presente no Comunicador.

Durante a gravação da mensagem, uma barra de progressão indica, em tempo real, o tempo transcorrido.

Gravação das Mensagens Vocais em modalidade Local
 Pode ligar APENAS UM telefone aos terminais [LI] para garantir o funcionamento correcto do Gravação das

Mensagens Vocais em modalidade Local.

Para gravar uma mensagem vocal desde um telefónico a tons ligado aos terminais [LI], habilite o Local Service Mode, na
secção Voice Dialer, e proceder da seguinte forma:
1. Pressionar a tecla ;
2. Pressionar em sequência as teclas  para entrar em modalidade gravação;
3. Digitar o número da mensagem que se quer gravar (de  a );
4. Após o sinal sonoro, gravar a mensagem vocal (duração máxima da mensagem vocal de 16 segundos).
5. Pressionar a tecla  para confirmar a gravação da mensagem (ou pressionar sempre a tecla  se desejar interromper

antecipadamente a gravação da mensagem), será gerado um sinal acústico descendente.
A partir daquele momento, qualquer gravação realizada anteriormente para aquela mensagem É APAGADA.

6. Se for necessário gravar outras mensagens, repetir o procedimento desde o ponto 1.

Reprodução das Mensagens Vocais em modalidade Local
 Pode ligar APENAS UM telefone aos terminais [LI] para garantir o funcionamento correcto do Reprodução

das Mensagens Vocais em modalidade Local.

Para reproduzir uma mensagem vocal desde um telefónico a tons ligado aos terminais [LI], habilite o Local Service Mode,
na secção Voice Dialer, e proceder da seguinte forma:
1. Pressionar a tecla ;
2. Pressionar em sequência as teclas  para entrar em modalidade reprodução;
3. Digitar o número da mensagem que se quer ouvir (de  a );
4. Após o sinal acústico ascendente, é reproduzida a mensagem, no final da qual ouve-se um sinal acústico descendente

como confirmação (premir a tecla  se deseja interromper antecipadamente a reprodução da mensagem);
5. Se for necessário ouvir outras mensagens, repetir o procedimento desde o ponto 1.
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Programação opcional Antisabotagem
Por meio da ligação (consulte o parágrafo Ligações->Ligações Auxiliares) do Desviador Antisabotagem MAXIASNC
(opcional) é possível detectar eventuais tentativas de violação da tampa do Comunicador. Para enviar uma mensagem
SMS e/ou de voz a um ou mais números de telefone programados para a remoção da tampa do Comunicador realize,
usando o software BGSM-120/BGSM-100 Console, a seguinte programação:
1) Na página Phonebook programe os números de telefone aos quais deseja que seja enviada a mensagem de alarme.
2) Na página I/O programe o terminal T3, na coluna Type, como Input e, na caixa Polarity, o estado da entrada em repouso como

NO (Normalmente Aberto): a configuração em repouso do Desviador Antisabotagem é do tipo Normalmente Fechado (NC).
3) Na página SMS Dialer e/ou Voice Dialer, programe para Input 3 Event, quer a mensagem SMS e/ou de voz, quer os

números de telefone aos quais enviar a mensagem.



BGSM-100/120 71

PPPPP



BENTEL SECURITY S.r.l. – Via Gabbiano, 22 – Z. I. S. Scolastica – 64013 CORROPOLI (TE) – ITALY
Tel.: +39 0861 839060 – Fax.: +39 0861 839065 – e-mail: info@bentelsecurity.com – http://www.bentelsecurity.com

NOTES
This product uses the FreeRTOS.org real time kernel.

The FreeRTOS.org source code can be obtained by visiting
http://www.FreeRTOS.org

FreeRTOS LICENSING:
“The FreeRTOS source code is licensed by the GNU General Public License (GPL) with an exception.

The full text of the GPL is available here:
http://www.freertos.org/license.txt.

The text of the exception is available on FreeRTOS official website:
http://www.FreeRTOS.org - License and Warranty Page

The exceptions permits the source code of applications that use FreeRTOS soley through the API published on this
WEB site to remain closed source, thus permitting the use of FreeRTOS in commercial applications without

necessitating that the whole application be open sourced. The exception should only be used if you wish to combine
FreeRTOS with a proprietary product and you comply with the terms stated in the exception itself.”
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